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Creating Recipes

Creating Recipes is intended for process control engineers responsible for designing and creating 
recipes. The manual assumes that you understand the industrial process, including device controllers 
and I/O equipment. You should also be familiar with the process database, how it works in an iFIX® sys-
tem, and terms such as blocks and chains. 

Reference Documents

For related information about iFIX, refer to the following manuals:

 l Setting up the Environment

 l Building a SCADA System

 l Configuring Security Features

 l Implementing Alarms and Messages

 l Writing Scripts

First Time Users

If you are unfamiliar with the Recipe Builder, read through the first two chapters before you create your 
first recipe. Take notes as you read along and try to determine how you can apply the software to your 
particular application.
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Learning About Recipes

When you are ready to create recipes, you can create and download them with the Recipe Package. The 
Recipe Package consists of the following programs:

 l Recipe Builder   

 l Recipe system tasks:   

 l Recipe Upload program     

 l Recipe Download program     

The Recipe Builder

The Recipe Builder is the heart of the Recipe Package. This program provides industry-standard fea-
tures for creating, modifying, deleting, uploading, and downloading recipes. But the Recipe Builder also 
provides other powerful features that enable you to: 

 l Add formulas to recipes.   

 l Recalculate formulas automatically.   

 l Override formulas within specified limits.   

 l Scale the batch size.   

 l Assign tag groups to recipes.   

 l Keep an audit trail of recipe activity.   

Using Formulas

These features provide you with flexibility when creating recipes. For example, adding formulas to 
recipes allows you to represent a block value as a mathematical expression or in relation to another 
block value. This feature enables you to create recipes in terms natural for your industry, thereby making 
the recipes understandable by any process engineer and enabling you to develop recipes faster.  

Recalculating Formulas

When you enter or change a formula, the Recipe Builder automatically recalculates its value. This fea-
ture enables you to experiment with possible recipe values by making "on-the-fly" changes.

Overriding Formulas

To help you respond to changing process conditions, you can override a formula by entering a process 
value. This value is used in place of the formula until the override value is cleared.

Scaling the Batch Size

In addition, the Recipe Builder enables you to dynamically and uniformly scale the batch size. When 
scaling the batch size, the Recipe Builder preserves the relative proportions among the process values 
being scaled. Scaling the batch size is useful when you want to continually vary production amounts.  
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Using Tag Groups

Using the Recipe Builder, you can also assign tag groups to a recipe. With this feature, you can create 
one recipe that can address many different areas of your process. If a different tag group is needed for a 
recipe, you can assign that tag group in place of the currently assigned one. By re-using the same recipe 
with multiple tag groups, you gain flexibility and save time and disk space that would be otherwise 
needed for multiple recipes.
Keeping an Audit Trail

The Recipe Builder also provides a flexible method for keeping an audit trail. Using this feature, you can 
track what activity has occurred, when the activity occurred, and who initiated the activity. You can also 
track activity of individual tagnames. The Recipe Builder sends this information to the available alarm 
destinations.
Cutting and Pasting Data

In addition, you can cut and paste data to and from a third-party spreadsheet, such as Microsoft® 
Excel™. This feature provides the convenience of enabling you to create recipes with a program you 
already know. When you are ready to download a recipe, this feature also allows you to quickly cut and 
paste the recipe into the Recipe Builder.  

Understanding Recipes

Before you begin using the Recipe Package, review the sections for more   information on some central 
concepts:

 l Understanding   Master and Control Recipes

 l Recipe   Items

 l Recipe   Variables 

 

Understanding Master and Control Recipes

The Recipe Builder creates two types of recipes: master recipes and control recipes. The following fig-
ure summarizes differences between master and control recipes. 
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Master and Control Recipes

As the previous figure suggests, any recipe you create or modify with the Recipe Builder can be saved 
as either a master or a control recipe. Saving recipe information as a master recipe enables you to 
modify it later without restriction. Saving recipe information as a control recipe restricts the operator to 
modifying process values within specific limits.

Unless otherwise stated, the term recipe applies to both master and control recipes.  

Recipe Items

Each recipe consists of one or more recipe items. A recipe item is a process value that is identified by a 
tagname. A tagname consists of a SCADA node name, database block name (also called a tag), and the 
block field name. 

Each recipe item contains nine fields. These fields define the item and include information such as the 
recipe item identifier, description, value, and the unit of measure (UOM).  

Up to 850 recipe items can be added to a recipe.

Recipe Variables

In addition to recipe items, you can include variables in a recipe. A variable is an internal string or 
numeric value that is never downloaded to the database. For example, you can represent the tem-
perature of your process using a numeric constant, say 50. You can assign this constant to a tagname 
or, if you prefer, you can assign this value to a variable and then assign the variable to the tagname as 
the following table shows:     

Identifier Formula
#Temp 50
SCADA1:T16F1.F_CV #Temp
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While using variables to represent process values is helpful, variables are more powerful when incor-
porated into a formula. A formula is like a programming assignment statement. It enables you to specify 
how to represent a value for a recipe item or variable. The chapter Working with Formulas provides more 
information on using formulas and variables.

Using Existing Recipes

You can use recipes created with FIX® 6.x in iFIX® by exporting them on your 6.x node as text recipes, 
importing them into iFIX, and then saving them. No other steps are required. For more information about 
creating text recipes, refer to the section Saving Text Recipes.

Creating New Recipes: Overview

If you have no existing recipes, refer to the following figure to get started:
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Creating New Recipes

The following table lists the chapters you can refer to for more information on each steps.    

To... Refer to the section...
Gather the necessary information and plan out your recipes. Developing an Application 

Strategy
Enter the information into the spreadsheet. Creating a Sample Recipe
Define the required formulas. Using Formulas
Save the data as a master or control recipe. Using the Save As Command
Create or modify the operator displays for recipe downloading 
and uploading.

Downloading and Uploading 
Recipes

Creating Recipes   

Developing a Recipe

When you are ready to start developing recipes, obtain the following information about your process:

 l The process unit and database block names used by the recipe.    

 l The value you want to download to each database block.   

 l The block names for any upload or download interlock.   

 l The recipe items you plan to verify.   

 l The process values you want operators to be able to change.   

Once collected, you can create a recipe by entering the necessary information into the Recipe Builder.

To help you develop your recipes, this chapter explains how to create a sample recipe for making beer. 
By developing this sample recipe yourself, and using the same steps for your own recipes, you can learn 
how to develop recipes for your needs.

Developing an Application Strategy

To better understand how the sample recipe was created, this section first explains how beer is pro-
duced. The following figure provides an overview of the beer-making process.
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Beer Production Overview 

As you can see, beer production begins by cooking malt and cereal in water separately and then these 
mixtures are combined into one and cooked again. The resulting liquid is strained and hops are added to 
create a wort. The wort is cooled and then yeast is added. By allowing the liquid to ferment, beer is pro-
duced.

Typically when making beer, recipes are used while doing the following tasks:

 l Cooking the malt and cereal.   

 l Adding hops and brewing the beer.   

 l Cooling the wort.   

 l Adding yeast and fermenting the beer.   

Assume now you want to create a recipe that is downloaded when the wort is ready to be fermented. 
Let's look more closely at this part of the process.
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Fermenting Beer

This example describes a beer fermentation process. When fermenting   beer, as described in the Devel-
oping   an Application Strategy section,  the   following steps occur:

 1. Verify that the value   of the fermenter interlock, ILK1, is inactive. 

 2. Transfer the wort   from the brew kettle to the fermenter by opening transfer valve XCV1F1.   

 3. For every barrel   of beer being made, add 1.5 pounds of yeast to the wort. Assuming the   standard 
batch size is 100 barrels of beer, this sets the process value   W16S1 to 150 pounds of yeast. 

 4. Set the Analog Output   block, T16F1, fermenter temperature set point, to 55 degrees Fahrenheit.   

 5. Set the target value   of a Timer block, K16F1, the fermenter timer, to 132 hours. 

After the beer is fermented, it is aged, bottled and ready for shipment.   

Creating a Sample Recipe

From the steps in the previous subsection, you can obtain most of the information you need to create the 
recipe. The following table summarizes this information.    

Step Tagname Pr-
oc-
es-
s 
Val-
ue

Verify the fermenter interlock is inactive. ILK1.F_CV 0
Open the transfer valve to move the wort from the brew kettle to the fer-
menter.

XCV1F1.F_
CV

0

Weigh out 150 pounds of yeast and add to wort. W16S1.F_CV 150
Set the fermenter temperature to 55 degrees Fahrenheit. T16F1.F_CV 55
Set the fermenter timer to 132 hours. K16F1.F_CV 132

Sample Recipe Information   

With this information, you can now create a recipe for fermenting beer by selecting the appropriate cell in 
the Recipe Builder spreadsheet and typing the information into it. Press Enter when you finish typing. 
The following figure shows the sample recipe.
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Sample Recipe

You can also enter the tagname of the download interlock into the Recipe Builder. Once defined, the 
Recipe Builder automatically examines the value of this tagname during a download and if the interlock 
is inactive, the program downloads the recipe. In the sample recipe, you would enter the tagname 
ILK1.F_CV for the download interlock. For more information about entering the download interlock, refer 
to the section Defining the Upload and Download Interlocks.  

Defining Tagnames and Variables

 

Preferred Recipe Block Types

Before you create your own recipes, consider the block types to reference. While a recipe item can ref-
erence any block in the database, typically recipes download to blocks with an output capability such as 
Analog Output, Digital Output, Text, Analog Register, and Digital Register blocks. For example, in the 
sample recipe, the fermenter set point needs to be set to 55 degrees. To send this value out to the pro-
cess, the recipe uses an Analog Output block.  

Preferred Block Types for Recipe Verification

The Recipe Builder can also verify the value of each recipe item by writing to and then reading from your 
process equipment. To accomplish this, the recipe items being verified must have an input and output 
capability. If you plan to verify a recipe item, make sure it references an Analog Register, Digital 
Register, or Text block. Verifying recipe items that reference any other type of block can produce unex-
pected results.

Preferred Fields

Also consider the field referenced by the recipe item. Typically, as in the sample recipe, the Current 
Value field is referenced (F_CV). However, any field that operators can read from or write to can also be 
uploaded from or downloaded to. For example, assume the alarm limits for the fermenter's set point vary 
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depending on the type of beer being produced. In this situation, the sample recipe could download the 
alarm limits (F_HI and F_LO) to an Analog Input block.

When specifying a field, use the F_ field for numerical values and the A_ field for text values.
Using Variables

In addition to tagnames, recipes may include variables. Variables represent internal string or numeric val-
ues that are never downloaded to the database. When you create a variable, you give it a name. All vari-
able names begin with a number sign (#) and can be up to 15 alphanumeric or underscore characters. 
Each name you assign to a variable must be unique.

Variables are most helpful when used in a formula to replace a numeric or string constant, particularly if 
the value is used throughout the recipe. Consider the following example:    

Identifier Formula Calc Value
#TEMP 100.3456 100.3456
T16F1.F_CV INT(#TEMP)+5 105
T16F2.F_CV INT(#TEMP)+10 110

In the above example, the variable #Temp is used in two recipe items. The benefit of using a variable 
this way is that it allows you to make global changes quickly. If the recipe requires a different value for 
#Temp, you can change it once instead of many times.

Other advantages of using variables instead of a numeric or string constant are:

 l The variable name can be more descriptive than a constant.   

 l The variable's value can be overridden using a command line parameter.     

For more information about overriding a variable with a command line parameter, refer to the section 
Overriding the Calculated Value.
Keywords

Certain variable names are reserved. These reserved names are called keywords. Keywords allow 
access to information about the recipe. For more information about variables and keywords, refer to the 
chapter Working with Formulas.
Using the Local Node Alias

When you specify a tagname for a recipe item, you have the option of specifying the node name place-
holder, THISNODE, for the node portion of the tag. This is ideal for developing recipes that can be 
shared among different SCADA servers because you shorten the development cycle and keep your 
maintenance time to a minimum.  

For example, let's assume you have the following setup:
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In this setup, the recipes Beer1 and Beer2 are used to make beer and download to the SCADA servers 
FERMENT1 and FERMENT2, respectively. The Beer1 recipe defines the following items:     

Identifier Formula
FERMENT1:ILK1.F_CV 0
FERMENT1:XCV1F1.F_CV 0
FERMENT1:W16S1.F_CV 150
FERMENT1:T16F1.F_CV 55
FERMENT1:K16F1.F_CV 132

The Beer2 recipe is identical except for the node name:    

Identifier Formula
FERMENT2:ILK1.F_CV 0
FERMENT2:XCV1F1.F_CV 0
FERMENT2:W16S1.F_CV 150
FERMENT2:T16F1.F_CV 55
FERMENT2:K16F1.F_CV 132

Notice that in this implementation, two recipes are required because each recipe has hard-coded node 
name references. With the local node alias feature, you eliminate the need for two recipes. Instead, you 
create one recipe for both SCADA servers, as the following example shows:    

Identifier Formula
THISNODE:ILK1.F_CV 0
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THISNODE:XCV1F1.F_CV 0
THISNODE:W16S1.F_CV 150
THISNODE:T16F1.F_CV 55
THISNODE:K16F1.F_CV 132

After creating this recipe, share the directory that it resides in and map the recipe paths of both SCADA 
servers to the shared directory. By making these changes, you shorten the development cycle and later, 
when the recipe needs changing, you keep your maintenance time to a minimum because you only have 
to make the changes once. For information on changing the recipe paths, refer to the section Under-
standing Recipe Paths.

To use the local node alias feature, login as an Administrator and select the Local Node Alias check box 
in the System Configuration Utility (SCU). Refer to the Setting up the Environment manual for more 
information. To learn about other uses for local node aliasing, refer to the Mastering iFIX manual.

Using Formulas

Formulas enable you to combine variables with numeric or string constants, functions (such as LOG, 
SIN, or SQRT), and keywords. By using variables and formulas together you can represent process val-
ues in terms that are natural for your industry.

IMPORTANT: In formulas, you must include a space following a variable name. The space separates the vari-
able name from whatever follows it. The following example shows the correct syntax. In this example, there is 
a space between #Lbs_Per_Barrel and the multiplication sign.  

For example, in the sample recipe you could create a variable called #Yeast to represent the amount of 
yeast needed during fermentation. You can represent this amount with the following formula:

#Lbs_Per_Barrel * #STD_BATCH

where #Lbs_Per_Barrel is the amount of yeast needed for every barrel of beer produced and #STD_
BATCH is a keyword for the standard batch size. From the information in the section Fermenting Beer, 
you can learn:

 l Every barrel of beer requires 1.5 pounds of yeast.   

 l The standard batch size is 100 barrels of beer.   

This yields the following formula:

1.5*100

While you could assign this mathematical expression to the variable #Yeast, you may want to create a 
variable for the yeast per barrel value so that you can adjust it as process conditions change. The res-
ulting recipe is shown in the following figure:
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Adding Formulas and Variables to the Sample Recipe

For more information about using formulas in your recipes, refer to the chapter Working with Formulas.

Using Master and Control Recipes

 

Using Master Recipes

When you finish creating a recipe, you are ready to save it. The Recipe Builder enables you to save a 
recipe as a master recipe or a control recipe. How you save it depends on your needs. For example, you 
might want to save a recipe as a master recipe if you plan to create other recipes that are minor vari-
ations of the original. Using the sample recipe, for instance, assume you want to create several other 
recipes from the sample recipe that vary the fermenting temperature and the fermenting time. One recipe 
might shorten the fermenting time. Another might increase the temperature.  

In this situation, you might save the sample recipe as a master recipe. By doing this, you can easily 
modify the recipe by changing the necessary process values. By saving each change to a separate con-
trol recipe, you can easily create hundreds of additional recipes. Each additional recipe you create in no 
way affects the original recipe. This feature protects recipes from accidental or unauthorized changes.  

Using Control Recipes

Alternatively, you could save the sample recipe as a control recipe. Typically, control recipes are pro-
duction versions of a recipe that are downloaded to the database and are intended for use by operators.  

Typically, control recipe access is provided to operators through a special window called the Recipe 
Operations window. Depending on how you set up this window, it can restrict operators from modifying 
control recipes or it can enable operators to modify control recipes within predefined limits. Information 
such as the tag group assignment or the batch size cannot be modified from the Recipe Operations win-
dow regardless of how you set up the window. However, you can set up the window to allow operators 
to override specific values prior to downloading.
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Keep in mind that you do not have to choose between saving a recipe as just a master recipe or a control 
recipe. You can save a recipe in both formats and provide yourself the benefits of using both types of 
recipes. 

If you decide to save recipes in both formats, you may want to establish specific naming conventions to 
help update your control recipes more easily. The following figure shows two possible naming con-
ventions.

Naming Conventions

Another aspect to consider is the format you want to save the recipe in, binary or text. While binary 
recipes are functionally the same as the equivalent text recipes, binary recipes are faster to upload and 
download. In addition, binary recipes are more secure because they can only be opened and modified 
using the Recipe Builder. Text recipes, on the other hand, can be opened and modified with any third-
party spreadsheet or text editor.  

To help clarify explanations in this manual, the term master recipe refers to master text and master bin-
ary recipes unless otherwise stated. Similarly, the term control recipes refers to both control text and 
control binary recipes.  

Other Considerations

In addition to the features already described, you may want to consider which recipe items you want to 
allow operators to change. With the Recipe Builder, you can make specific columns in the spreadsheet 
non-modifiable. For more information about doing this, refer to the section Modifying a Column.

The Recipe Builder also provides several advanced features that you may find helpful when creating 
recipes. These features enable you to assign tag groups, keep an audit trail, scale the batch size, over-
ride a value, and verify one or more recipe items. Using these features is optional.
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Assigning Tag Groups

If many of your recipes are identical except for the locations they reference, you can consolidate these 
recipes into one and create multiple tag groups. Each tag group defines a set of symbols. A symbol is a 
label and represents a tagname. For more information about tag groups and symbols, refer to the chapter 
Using the Tag Group Editor.
Keeping an Audit Trail

You can also set up the Recipe Builder to keep an audit trail of recipe activity. This information provides 
you with a record of the recipes that were downloaded or modified. The section Using an Audit Trail 
provides more information on keeping an audit trail.
Scaling the Batch Size

If you need to produce a non-standard amount of a product, you can scale the batch size using the 
Recipe Builder. When scaling the batch size, the Recipe Builder preserves the relative proportions 
among the recipe items and variables being scaled. Refer to the section Scaling the Batch Size to learn 
more about this topic.
Overriding a Value

As process conditions change, operators may need to adjust a recipe by overriding the calculated val-
ues. When overriding a value, you specify a value to use in place of the calculated value. For more 
information about overriding a value, refer to the section Overriding the Calculated Value.
Verifying Recipe Items

You may want to verify that certain process critical values are downloaded to your process. Using the 
Recipe Builder, you can do this by enabling recipe verification for individual recipe items. For more 
information about recipe verification, refer to the section Verifying a Recipe.

Recipe Builder Basics

This chapter provides the necessary background information to start   using the Recipe Builder.  Topics   
described in this chapter include:

 l Starting   the Recipe Builder

 l Exiting   from the Recipe Builder

 l Recipe   Operations and Development Windows

 l Working   With Recipe Buttons

 l Recipe   Header Fields

 l Creating   a Recipe Item or Variable

 

Starting the Recipe Builder

You can start the Recipe Builder from the iFIX WorkSpace's system   tree. By opening the FIX Recipes 
folder in the system tree and double-clicking   the New Recipe icon, you can launch the Recipe Builder. 
When the application   opens, the Recipe Development window, shown in the following figure, appears.
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Recipe Development Window   

Once the program starts, it displays, by default, a blank untitled recipe.   

If you attempt to start the Recipe Builder and you do not have rights   for the Recipe Development win-
dow, the Recipe Operations window appears.

To obtain the rights to display the Recipe Development window, consult   your system administrator.

Once the Recipe Builder starts, you can begin creating a new recipe   by entering data into each cell. You 
can also create a new recipe by selecting   the New command. When you select this command, the 
Recipe Builder closes   the open recipe, prompting you to save any unsaved changes, and then displays   
a blank recipe.

In addition to starting the Recipe Builder with a blank recipe, you   can automatically open a master or con-
trol recipe by double-clicking an   icon from the Master Recipe or Control Recipe subfolders, located in the   
WorkSpace system tree.

Exiting from the Recipe Builder

To exit from the program, select Exit from the File menu. If you have made changes to the recipe since 
your last save, a question message box appears displaying the following text:

Do you want to save this recipe?
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To save your changes, select the Yes button. To exit the program without saving them, select the No 
button. To resume using the Recipe Builder, select the Cancel button.

Recipe Operations and Development Windows

The Recipe Builder provides two display windows: the Recipe Operations   window and the Recipe Devel-
opment window. The following figure shows the   elements of the Recipe Development window. 

Recipe Development Window   Elements

The following table identifies each element: 

Name Description
Recipe But-
tons

A row of buttons that perform common recipe functions   such as clearing all override values 
and downloading recipes. For more   information on these buttons, refer to the section Work-
ing   With Recipe Buttons.

Recipe 
Header

A set of fields that display recipe information, such   as the standard batch size and the 
batch unit of measure. The section   Recipe Header provides more information about these 
fields.

Text Editing 
Box

An area where you can enter text into the spreadsheet.

Recipe Dis-
play Area

Two display fields that show the recipe's batch size   and the type of audit trail currently 
selected. The section Scaling   the Batch Size provides more information on this area.

Spreadsheet A display area that shows the recipe items and variables.   For information about the spread-
sheet columns, refer to the section Spreadsheet Columns.

Parts of a Recipe Window    

The Recipe Operations and Recipe Development windows represent the two   modes of the Recipe 
Builder. The Recipe Operations window provides limited   control recipe access and is intended for the 
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operator who must download   control recipes or override a formula. The Recipe Development window 
provides   full access to all recipes and is intended for the process engineer who   must create, modify, and 
maintain master and control recipes. 

The main differences between the two windows are summarized below 

Comparing... Recipe Operations Window
Available 
menus

Only the File, Window, and Help menus are available.

Recipe buttons All buttons are available.
Recipe header All header fields are displayed. These fields cannot   be edited.
Recipe items 
and variables

Cannot be rearranged in or deleted from the spreadsheet.

Spreadsheet Cannot change whether a column is modifiable or the   order that columns appear in the 
spreadsheet. 

Opening and 
saving recipes

Only control recipes can be opened and saved. Note   that the Save As command is not 
available, preventing operators from creating   new control recipes.

Comparing   Recipe Windows 

Unless otherwise stated, the descriptions in this manual apply to the   Recipe Development window only.

NOTE: The menus, fields,   buttons, and commands that appear in the Recipe Operations window function   in a 
similar manner to the descriptions provided in this manual. The main   difference is that you can only open con-
trol recipes in the Recipe Operations   window.

Working With Recipe Buttons

Across the top of the Recipe Operations and the Recipe Development windows, a row of button 
appears. The following table lists these buttons.     

Button Use to... Mne-
monic

Download Transfer recipe items from the open recipe to one or more process data-
bases.

<Alt>D

Upload Copy the process values from one or more databases to the open 
recipe.

<Alt>U

Go To Item Jump to a specific row in the spreadsheet. <Alt>G
Search Search and/or replace data in the selected spreadsheet column. <Alt>S
Clear Over-
rides

Remove all override values for the open recipe. <Alt>C

Recipe Buttons    

Recipe Header Fields

Underneath the row of recipe buttons is the recipe header. Each window displays the following fields:  

Units field — enables you to enter a description of the process unit the recipe affects. You can enter up 
to 40 alphanumeric characters into this field.
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Product field — allows you to specify a description of the product being made. You can enter up to 40 
alphanumeric characters into this field. 

Standard Batch Size field — allows you to enter the standard amount of the product that this recipe pro-
duces. You can enter any value from 0.0000001 to 9,999,999.0 into this field.  

Batch UOM field — enables you to enter the batch unit of measure. You can enter up to four alpha-
numeric characters into this field. 

In the Recipe Operations window, none of these fields are modifiable.

Spreadsheet Columns

The Recipe Builder spreadsheet displays a predefined set of columns.   When you first start the Recipe 
Builder, it displays the following columns:

Item   column —   contains the item number of the recipe item or variable. This number can   help you ref-
erence a specific row and is not downloaded to the database.

Identifier column   — enables   you to enter a recipe variable name or a recipe item tagname. A variable   
name is an alphanumeric string, up to 15 characters in length, beginning   with the # character. An 
example of a variable name is: #myNamedVar. Each   variable name you enter must be unique. 

A tagname is a node-tag-field combination or   a symbol. A symbol is a label defined in the Tag 
Group Editor. For more   information about defining variables and tagnames, refer to the section   
Defining Tagnames and   Variables. For more information about symbols, refer to the section   
Assigning Tag Groups.

Only recipe items are downloaded to the database.   Recipe variables are never downloaded. 

You can enter text into this field using the   text editing box or by double-clicking a cell in this 
column. When you   double-click a cell, the Field Select dialog box appears. This dialog   box allows 
you to select a node-tag-field combination. 

Formula   column —   displays the formula of the recipe item or variable. You can represent   a formula by 
combining one or more of the following: 

Formula Type Examples
Numeric or string constant 5 or "John"
Mathematical operators +, -, *, /, = =, >, <, <=
Function Log(234) or 

Lookup (#COLOR,1,2,3,4,5)
Variable #COLOR
Keyword #BATCH or #NAME

For more information on formulas, functions,   and keywords, refer to the chapter Working   with For-
mulas.

Calc   Val column —   displays the current value of the recipe item or variable. The Recipe   Builder auto-
matically recalculates the value of all recipe items and variables,   and updates this column when you 
enter or change a formula.
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Whenever the text ??????   appears in the Calc Val column, the recipe item or variable is 
undefined.   The Recipe Builder does not download recipes with undefined recipe items   or vari-
ables.

NOTE: When you download   a recipe, only a recipe item value is sent to the database. Recipe variables   are 
never downloaded.

Override   Val column —   allows you to enter an alphanumeric value in place of the recipe item's   or vari-
able's calculated value. Any formulas that reference an overridden   variable are recalculated using the 
override value. When the recipe is   downloaded, the override value is sent in place of the calculated 
value.   For more information about overriding the calculated value, refer to the   chapter Working with 
Formulas.

Description   column —   contains text describing the recipe item or variable. The following table   shows 
how the Recipe Builder completes this column when you initially   enter an identifier: 

When the identifier   
is a...

The Recipe Builder...

Tagname Reads the Description field of the specified block   and displays this text in the 
Description column. 

Variable Leaves the Description column blank.

You can enter up to 40 alphanumeric characters   into any cell of this column. If you complete the 
Description column before   specifying a tagname, the Recipe Builder does not overwrite the text 
you   entered. If you want to update the text for a tagname with the text from   the block's Descrip-
tion field, double-click a cell in the Description   column.

UOM   column —   contains the unit of measure for a recipe item or variable. The following   table shows 
how the Recipe Builder completes this column when you initially   enter an identifier:

You can enter up to four alphanumeric characters   into any cell of this column. If you complete the 
UOM column before specifying   a tagname, the Recipe Builder does not overwrite the text you 
entered.   If you want to update the text for a tagname with the text from the block's   EGU tag, 
double-click a cell in the UOM column. 

Override   Lo Lim and Override Hi Lim columns —   defines the highest and lowest possible override 
value an operator can   enter into the Override Value column. The Recipe Builder verifies the   override 
value is within the high and low limit range before it accepts   the override value.

The following two tables show the possible   override limits and examples of how you can combine 
the limits.

To learn how to define the high and low limits,   refer to the section Entering   Override Limits.

NOTE: When the calculated   value of a recipe item or a variable is a string constant, you must set   both over-
ride limits to either Unrestricted or Restricted.

When the 
Override 
Limit   is...

The operator can...

UnrestrictedEnter any value less than or equal to the high limit   and greater than or equal to the low 
limit. If both override limits are   unrestricted any value can be entered. The Recipe 
Builder sets both override   limits to unrestricted for any recipe item or variable you add.

An absolute Enter an override value less than or equal to the   high limit and greater than or equal to 

Override Limits  
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value the low limit. Any value outside   the limit range generates an error.
A relative 
percentage

Enter an override value based on the calculated value   plus or minus the percentage spe-
cified in the high and low limit columns.   For example, if the calculated value is 100 and 
the high and low limits   are 10%, the operator can enter a value from 90 to 110.

A relative dif-
ference

Enter an override value based on the calculated value   plus or minus the difference spe-
cified in the high and low limit columns.   Relative difference limits end with a minus sign 
(-). For example, if   the calculated value is 100 and the high and low limits are 20-, the 
operator   can enter a value from 80 to 120.

Restricted Enter an override value that is less than or equal   to the calculated value (when the high 
limit is restricted). If the low   limit is restricted, the operator can enter an override value 
that is   greater than or equal to the calculated value. If both override limits   are restricted 
no override value can be entered. 

Table Caption Outside Table: 

When the Calculated    Value is... The Override Low Limit   is... And the Override High   Limit is...
25 Unrestricted 50
50 10 Unrestricted
35 10 50
35 -5 3-
35 21- 50
50 1% 5-
50 Restricted 1%
100 5- 10%

Sample Override Limits    

Verify   column —   controls recipe verification. This feature enables the Recipe Package   to verify that spe-
cific recipe item values have been written to your process   equipment. The Recipe Package handles 
recipe verification by reading the   target block fields and comparing their values against the values in 
the   recipe. When the two values match, the recipe item is verified. For more   information about recipe 
verification, refer to the section Verifying   a Recipe.

You can enable and disable recipe verification   for each recipe item in the spreadsheet. To enable 
it, enter ON.   To disable it, enter OFF.   By default, recipe verification is disabled.

Creating a Recipe Item or Variable

The steps that follow explain how to create a recipe item or variable.

 To create a recipe item or variable: 

 1. Select a cell in the Identifier column and type a tagname, variable name, or a tag group symbol 
name.     

If you prefer, you can double-click a cell in the Identifier column to display the Field Select dialog 
box.  

 2. Select the corresponding cell in the Formula column and enter a formula for the recipe item. When 
you complete your entry, the text in the Calc Val column changes to reflect the formula's value.   
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 3. Modify the text in the Description and UOM columns as needed. Notice, that if you enter a tag-
name the text from the specified block's Description and EGU Tag fields are automatically inser-
ted for you.   

 4. Modify the override limits as needed. By default, the override limits are sent to Unrestricted. If 
you want to change them, refer to the section Entering Override Limits for instructions.   

 5. Modify the Verify column as needed. By default, recipe verification is disabled for each recipe 
item you add to the recipe. To enable it, select a cell in the Verify column and type ON in the text 
editing box. Keep in mind, it is recommended that you only verify Analog Register, Digital 
Register, and Text blocks. For more information about recipe verification, refer to the section Veri-
fying a Recipe.

Working with Recipes

Working with recipes requires you to open, close, delete, and save recipes.   It also requires you to add, 
copy, move, modify, and delete recipe items.   This chapter provides instructions for completing these 
tasks. It includes   the following sections:

 l Opening   a Recipe

 l Saving   a Recipe

 l Using   the Save As Command

 l Inserting   Recipe Items or Variables

 l Copying   Recipe Items or Variables

 l Moving   Recipe Items or Variables

 l Moving   All the Recipe Items and Variables

 l Deleting   Recipe Items or Variables

 l Deleting   Recipes

 l Creating   Recipe Reports

 l Working   with Recipe Notes

Other related, but optional tasks, include creating recipe reports and   storing recipe-related information to 
a file. These operations let you   save recipes and related data by creating text files with specific file   
extensions. Instructions for completing each task is described at the   end of this chapter. 

Opening a Recipe

Whenever you need to make changes to a recipe, you can use the Recipe   Builder to open one of the fol-
lowing types of recipes:

 l Master recipes 

 l Control recipes 

 l ASCII text versions   of master and control recipes 

 l Backup versions of   master, control, and text recipes 
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You can open master and control recipes by selecting them from the WorkSpace   system tree or by start-
ing the Recipe Builder and selecting the Open command   from the File menu. To open text and backup 
recipes, you must use the   Open command in the Recipe Builder.

When you select the Open command, a dialog box appears. The exact dialog   box and the type of recipe 
you can open depends on whether you select   the Open command from the Recipe Operations window or 
the Recipe Development   window.

Opening a Recipe from the Operations Window

You can only open control recipes located in the control recipe path from the Recipe Operations window 
by selecting the Open command and displaying the Open Control Recipe dialog box.

This dialog box displays the following controls:

Recipe list box — displays the control recipes you can open.

Recipe Name field — allows you to enter the name of the control recipe you want to open.

Open button — opens the control recipes you selected from the Recipe list box or that you entered in the 
Recipe Name field.

 To open a recipe from the Recipe Operations window: 

 1. On the File menu, click Open. The Open Control Recipe dialog box appears.   

 2. Select the recipe you want to open from the list box and select the Open button. The Recipe 
Builder opens the recipe and displays it on the screen.   

If you prefer, in the Recipe Name field, enter the name of the recipe and click Open, or double-
click a recipe name. Regardless of the method you choose, the Recipe Builder opens the recipe 
and displays it on the screen.

Opening a Recipe from the Development Window

When you select the Open command from the Recipe Development window, the Recipe Builder dis-
plays the standard Open dialog box. The following table lists the types of files you can open with this dia-
log box.     

Recipe Type File Exten-
sion

Master recipes .RCM
Control recipes .RCC
Master recipes in text format
(called a master text recipe)

.RCX

Control recipes in text format
(called a control text recipe)

.RCY

Backup of master recipes
(called a master backup recipe)

.^CM

Backup of control recipes .^CC

Recipe Types   
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(called a control backup recipe)
Backup of master text recipes
(called a master text backup recipe)

.^CX

Backup of control text recipes
(called a control text backup recipe)

.^CY

When the standard Open dialog box appears, select the recipe you want to open and click OK. 

Opening Multiple Recipes

Once the Recipe Builder opens a recipe, it cannot open another until you close the current recipe. To 
close a recipe, select Open again. The Recipe Builder closes the current recipe and opens the recipe 
you select.

If you have made changes to the old recipe and have not saved them, the Recipe Builder prompts you to 
save your changes. If you do not want to save your changes, click No. To continue working with the 
recipe, click Cancel.

Click Yes to save your changes to disk. If you attempt to save a recipe when you have no privileges to 
do so, a message box with following text appears:

The logged-in user does not have the RECIPE SAVE application feature

Consult your system administrator to acquire the necessary rights to save the recipe.

Saving a Recipe

When you finish making changes to a recipe, you need to save the recipe to disk. By saving the recipe, 
you make your changes permanent.  

The Recipe Builder only saves master and control recipes in either binary or text format. Each time you 
save a recipe, the Recipe Builder automatically creates a backup of the original file called recipe.^xx. 
The exact extension depends on the type of recipe you are saving. The Recipe Types table lists the pos-
sible extensions for backup recipes.

If you are working with recipes from a previous version of FIX software, you must use the Save As com-
mand to save your data as text recipes if you plan to use them with iFIX. For more information on com-
pleting this task, refer to the section Using the Save As Command.

To save an existing master or control recipe, select Save from the File menu. If the audit trail is enabled 
when you select this command, the Recipe Mod Log dialog box appears. This dialog box displays the 
Mod Log field and the Save button.

Mod Log field

The Mod Log field allows you to enter up to 30 characters of text explaining any changes made to the 
recipe. While completing this field is optional, the text you enter is incorporated into a recipe message 
and added to the audit trail. If you leave the Mod Log field blank, a portion of the recipe message is left 
blank. For more information on the recipe audit trail and recipe messages, refer to the section Using an 
Audit Trail.
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Save button

The Save button enables you to store the recipe to disk. Master recipes are stored to the master recipe 
path and control recipes are stored to the control recipe path.  
 To save an existing master or control recipe: 

 1. On the File menu, click Save. The Recipe Mod Log dialog box appears.   

 2. In the Mod Log field, enter the text you want.   

 3. Click Save. The Recipe Builder saves the recipe to disk.   
Saving a New Recipe

If you are saving a new recipe, the Recipe Builder prompts you to enter a name for the recipe by dis-
playing the standard Save As dialog box. 

Using the Save As Command

The Save As command allows you to save the current recipe under a new name. The Save As com-
mand also allows you to save the recipe in one of the following recipe types:

 l Master recipe   

 l Control recipe   

 l Master text recipe   

 l Control text recipe   

If you do not change the name or recipe type, the Save As command makes a backup copy of the ori-
ginal and overwrites the original recipe.

;However, when you change the recipe's name or type, the Save As command does not overwrite the 
original recipe — it creates a new one. This feature lets you create control recipes from master recipes 
and master recipes from control recipes. It also lets you create multiple versions of a master or control 
recipe by repeatedly saving it with different names.  

The Save As command is also useful when saving a new recipe. When saving this type of recipe, the 
command allows you to create a recipe by specifying a name and a recipe type.

When you select Save As, the Recipe Mod Log dialog box appears, if the audit trail is enabled. For more 
information about this dialog box, refer to the section Saving a Recipe. 

After you enter the text you want in the Mod Log field, select the Save As button. The standard Save As 
dialog box appears. To save the recipe, type its name in the File Name field and click OK. 

Saving Text Recipes

By using the Save As command and selecting either the master text or control text file type, you can 
save the current recipe as a text file. You may find saving a text recipe helpful when you want to do one 
of the following tasks:
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 l Complete large editing tasks by using a third-party text editor or spreadsheet.   

 l Convert existing recipes for use with iFIX.   

 l Convert a binary master or control recipe to a text file prior to downloading it.   

For information on the file format of a recipe text file and how to edit it, refer to the chapter Text Recipe 
Format.

Inserting Recipe Items or Variables

If you forget to enter a recipe item or variable when you initially   create a recipe, you can insert a recipe 
item or variable between two   existing items by selecting the Insert Item command. When you select this   
command, the Recipe Builder inserts a blank row above the currently selected   row and then renumbers 
the recipe items and variables in the spreadsheet   beginning with the newly added row. 

The following figure illustrates how the Recipe Builder renumbers the   spreadsheet.

 

Renumbering the Recipe   Spreadsheet

 To insert a recipe item or variable   to a recipe: 

 1. Select a cell in   a row of the spreadsheet. 

 2. On the edit menu,   click Insert Item. The Recipe Builder inserts a blank row above the row   you 
selected and renumbers the spreadsheet. 

Copying Recipe Items or Variables

If many of the recipe items or variables you want to create are similar,   you may find it easier to create 
one recipe item or variable and copy   the remaining items you need. You save time by copying an exist-
ing recipe   item or variable because you only need to change the information that   differs between the ori-
ginal item and the new copy.
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The Recipe Builder allows you to copy a recipe item or variable by selecting   Copy from the Edit menu. 
When you select this command, the Recipe Builder   copies the entire row of the selected item to the clip-
board. 

After copying the recipe item or variable, you can insert it into the   recipe as many times as you need 
using the Paste command. Each time you   paste a copied item, the Recipe Builder inserts it above the 
currently   selected row and renumbers the spreadsheet as shown in the Renumbering   the Recipe Spread-
sheet figure.

 To copy a recipe   item or variable: 

 1. Select a cell in   the row you want to copy. 

 2. On the Edit menu,   click Copy. The Recipe Builder copies the entire row. 

 3. On the Edit menu,   click Paste. If the recipe item or variable is not unique, an error dialog   box 
appears. 

Select the Keep Item button to retain the valid   parts of the recipe item being pasted or select the 
Discard Item button   to prevent the item from being pasted into the recipe. To cancel the entire   
operation, select the Undo Paste button.

If you prefer, you can copy data from a third-party application (such   as Excel) and paste it into the 
Recipe Builder. When you do this, the   Recipe Builder reads the data from the standard system clipboard 
and pastes   the data into the recipe. The Recipe Builder pastes the data in the order   of the spreadsheet 
column format starting with the first column in the   recipe. Before pasting data into a specific column, the 
Recipe Builder   evaluates its syntax for that column. If the syntax is invalid or if the   Recipe Builder has 
difficulty pasting the data into a column, the error   dialog box described previously in step 3 appears.

To avoid this situation, set up the columns in your third-party application   to match the display format of 
the recipe. Make sure that the data in   the columns that correspond to the Identifier and Formula columns 
conforms   to the syntax for each column. Also make sure the column that corresponds   to the Verify 
column contains the text ON   or OFF.   For more information about identifier and formula syntax refer to 
the   section Spreadsheet Columns.   

The number of columns you paste into the recipe can be greater or less   than the number of columns in 
use by the display format. If the number   of columns you are pasting is greater than the number of 
columns in use,   the extra columns are not used. If the number of columns is less than   the number of 
columns in use, the Recipe Builder either leaves the corresponding   cell blank or uses the default value 
for the cell if it has one.

You can leave any cell in the third-party spreadsheet blank. When you   paste a row with blank cells into 
the Recipe Builder, the program either   leaves the corresponding cell blank or uses the default value for 
the   cell if it has one. 

Moving Recipe Items or Variables

Other ways you can insert recipe items and variables to a recipe are by moving them from one recipe 
and into another or by moving them from one part of a recipe to another. This is helpful when the items 
you are moving are exactly the same in both locations.

The Recipe Builder allows you to move a recipe item or variable by selecting the Cut and Paste com-
mands from the Edit menu. When you select Cut, the Recipe Builder copies the entire row of the selec-
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ted item and removes it from the recipe. Once removed, you can move the recipe item or variable by 
opening a recipe and selecting Paste.
 To move a recipe item or variable from one row of the spreadsheet to  another: 

 1. Select a cell in the row you want to move.     

 2. On the Edit menu, click Cut. The Recipe Builder copies the selected item and removes it from the 
recipe.   

 3. Select a cell in the target row.   

 4. On the Edit menu, click Paste. The recipe item or variable is inserted above the selected row.   

If you prefer, you can move data from a third-party application (such as Excel) and paste it into the 
Recipe Builder. Moving data from a third-party application is similar to copying it. If you cut the data to 
the standard system clipboard, the Recipe Builder can paste the data into the recipe. For more inform-
ation about pasting data from a third-party application, refer to the section Copying Recipe Items or Vari-
ables. 

Moving All the Recipe Items and Variables

In addition to copying and moving one recipe item or variable at a time, the Recipe Builder enables you to 
copy and move every recipe item and variable from one recipe to another. When you do this, the Recipe 
Builder copies the entire row of each item in the spreadsheet. This feature can be useful when you want 
to copy and paste the entire recipe into a third-party application, such as Excel. 

To copy and move every recipe item and variable in a recipe, use the Copy All command. After copying 
the entire recipe, you can insert them into the target application using the Paste command.

 To copy and move an entire recipe from the Recipe Builder to another  application: 

 1. On the Edit menu, click Copy All. The Recipe Builder copies every row in the recipe.   

 2. Start your target application. For instructions on how to do this, refer to that application's user's 
manual.   

 3. Once the application starts, open the spreadsheet you want to paste the recipe into.     

 4. On the Edit menu from your spreadsheet program, click Paste.   

If you prefer, you can copy and move data from a third-party application (such as Excel) and paste it into 
the Recipe Builder. For information about moving data from a third-party application to the Recipe 
Builder, refer to the section Copying Recipe Items or Variables.

Deleting Recipe Items or Variables

While creating or modifying a recipe, you may find it necessary to delete one or more recipe items or vari-
ables.  

You can delete a recipe item or variable from a recipe by selecting the Delete Item command. You can 
also delete an item by selecting Cut from the Edit menu instead of Delete Item. The main difference 
between these commands is that when you delete a recipe item or variable with Cut, you can paste back 
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into the recipe if you accidentally remove the wrong item or if you change your mind. When you select 
Delete Item, the recipe item or variable is irretrievable.
 To delete a recipe item or variable: 

 1. Select a cell in the row you want to delete.   

 2. On the Edit menu, click Delete Item. The Recipe Builder removes the selected item from the 
recipe and renumbers each row in the spreadsheet.   

Using <Delete>

Alternatively, you can delete any row in the spreadsheet by selecting the identifier and deleting it by 
pressing <Delete>. When you do this, a message box appears displaying the following text:

This change will destroy this recipe item. Continue?

Select the Yes button to delete the row or the No button to abort the procedure. If you select the Yes but-
ton, the Recipe Builder deletes the selected item and does not renumber the rows in the spreadsheet. 

Deleting Recipes

As your needs change, you may find you no longer need certain recipes. When you decide that a spe-
cific recipe is not necessary, you can delete it using the Delete command. This command also deletes 
all files associated with this recipe.

When you select the Delete command, the Delete Recipe dialog box appears. This dialog box has the 
following controls:

Recipe Name field — enables you to enter the name of the recipe you want to delete. 

Recipe list box — displays the available recipes in the current path that you can delete.  

Delete button — deletes the specified master and control recipes and their associated files. 

 To delete a recipe: 

 1. On the File menu, click Delete. The Delete Recipe dialog box appears.   

 2. Type the name of the recipe you want to delete.     

If you prefer, you can select the recipe to delete by selecting it from the list box. The file you 
select appears in the Recipe Name field.

 3. Click Delete. A message box appears displaying the following text:   
Are you sure want to delete recipe recipe?

NOTE: Do not attempt to delete files from a file server while they are in use. If you do, the Recipe Builder dis-
plays an error message box informing you that the files could not be deleted.

Creating Recipe Reports

You may want to create a recipe report to document the changes you have made or for subsequent print-
ing. A recipe report is a text file that lists each column present in the recipe and the data in each column. 
By default, the columns appear in the text file in the same order as they appear on the screen.
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When the Recipe Builder creates a report, it starts with the data from the current recipe and stores the 
report in a file named recipe.RCR, where recipe is the name of the open recipe. The path that the report 
is stored in depends on the type of recipe opened.    

When the open recipe is a... The Recipe Builder stores the report in...
Master recipe or master text recipe The master recipe path
Control recipe or control text recipe The control recipe path

To create a report, select the Report command. This command enables you to select and arrange the 
columns for the report using the Report Format dialog box. When you select the Report command, this 
dialog box appears and displays the following controls:

Available Columns list box — lists the columns you can add to the report. If the list box is empty, all the 
available columns are in use.

Column Layout list box — controls which columns appear in the report and the order that these columns 
appear. By default, all the columns currently displayed in the recipe appear in the same order that 
they appear in the recipe.  

Using this dialog box, you can customize the report by selecting only those columns you want to 
include, changing a column heading, or changing a column width. When you change a column heading 
for a report, the corresponding heading in the recipe does not change. This means if you close and re-
open the Report Format dialog box, the Recipe Builder re-reads the recipe column headings and any 
changes you made are lost.

Similarly the width of each column in the report is independent of the display format column width. This 
means changing either column width does not affect the other.  

NOTE: When the report is created, the Recipe Builder uses the last character of each column to separate the 
individual columns. It does this by placing a space in this position. This means that if you specify a column 
width of 15 only 14 characters appear in the report. To display the 15th character specify a width of 16.
 To create a report from the current recipe: 

 1. On the File menu, click Report. The Report Format dialog box appears.   

 2. If necessary, add or delete the columns to include for the report. Use the following table as a 
guide.     

 3. If necessary modify the column widths and heading, and arrange the columns for the report. Use 
the following table as a guide.     

 4. Click OK. The Recipe Builder creates a report from the current recipe and stores it in the appro-
priate recipe path.    

To... Then...
Add a 
column to 
the report.

1. From the Available Columns list box, select the column you want to add.

2. Select the Add button. The selected column appears in the Column Lay-
out list box and disappears from the Available Columns list box.

If you prefer, you can add a column to the report by double-clicking a 
column in the Available Columns list box.

Remove a 1. From the Column Layout list box, select the column you want to remove.

Report Format Procedures    
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column from 
the report.

2. Select the Delete button. The selected column disappears from the 
Column Layout list box and appears in the Available Column list box.

Arrange a 
column in 
the report.

1. In the Column Layout list box, select the column you want to move.

2. To move the column up in the list box and to left in the report, select the 
up arrow button. To move the column down and to the right, select the 
down arrow button.

Change a 
column 
heading in 
the report.

1. In the Column Layout list box, select the column you want to modify.

2. Select the Modify button. The Report Column Details dialog box 
appears.

3. In the Column Heading field, type up to 39 characters for a column head-
ing and select the OK button. The Report Column Details dialog box dis-
appears and the Recipe Builder changes the heading in the Column 
Layout list box.

Change a 
column 
width in the 
report.

1. In the Column Layout list box, select the column you want to modify.

2. Select the Modify button. The Report Column Details dialog box 
appears.

3. In the Column Width field, type the column width you want and select the 
OK button. The Report Column Details dialog box disappears and the 
Recipe Builder changes the column width in the Column Layout list box.

NOTE: A width of less than two does not show any characters.

Working with Recipe Notes

In addition to creating a recipe report, the Recipe Builder allows you to save recipe-related information to 
a file. This information could provide instructions to operators, version information, comments about the 
recipe, tips on uploading or downloading the recipe or anything else you want.  

When you save this information, the Recipe Builder stores it in a recipe note file in the recipe control 
path. Recipe note files are ASCII text files and by convention are named recipe.RCN. Master and con-
trol recipes share the same recipe note file.  

 To create or modify a recipe notes file: 

Select the Notes command from the File menu. This command starts the Windows Notepad application. 
If a note file does not already exist for the recipe, a message box with the following text appears:

Notes file [path\recipe.RCN] not found.
Create it?

Click Yes to create a note file with the name recipe.RCN. To abort the procedure, click No.  

Once the program starts, you can enter the information you want to save. For information on how to add 
and modify text with Notepad, refer to your Microsoft Windows documentation.

When you are ready to save the note file, select Save from the File menu. If you are working with a new, 
untitled recipe, make sure you save the file with a .RCN extension and that the name of the note file and 
the recipe match; otherwise, the Recipe Builder will not be able to locate the note file subsequently. 
Also, make sure you save the note file in the control recipe path.

For example, if you plan to name the current recipe BEER, save the note file with the name BEER.RCN.  
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 To disable recipe notes: 

 1. In a text editor, open the rcp.ini file. If you installed iFIX to the default location, this file is located 
in the C:\Program Files (x86)\GE\iFIX\Local folder.   

 2. In the [startup] section, change notes.disable to 1. (0 is the default.)   

 3. Save the changes and close the rcp.ini file. The Notes command in the File Menu will be grayed 
out.   

Locating and Displaying Data

Many times while creating or modifying a recipe, it may be necessary   to verify a specific recipe item or 
variable value. For example, you may   want to examine the calculated value of a specific tagname prior 
to downloading   it. Alternatively, you may want to verify the high and low override limits   of a variable.

Using the Recipe Builder, you can do these tasks by locating the information   you need and displaying it. 
This chapter explains how to locate and display   information by searching and replacing data or jumping 
to a specific location   within a spreadsheet. The chapter also includes instructions for customizing   a 
spreadsheet to display only the columns you want, and saving and loading   these custom display 
formats, setting the default startup window, and   switching between Recipe Operations and Recipe 
Development windows.

This chapter includes the following sections:

 l Searching   for and Replacing Data

 l Using   the Go To Item Button

 l Understanding   Recipe Paths

 l Setting   the Startup Window

 l Switching   Between Windows

 l Applying   Fonts

 l Displaying   Tag Group Tagnames

 l Adding   and Removing Columns

 l Modifying   a Column

 l Saving   Format Files

 l Loading   Format Files

 l Overriding   the Default Format Settings

 

Searching for and Replacing Data

You can locate recipe items and variables by scrolling through the recipe using the scroll bars or arrow 
keys. However, as the recipe becomes larger you may find it time-consuming to scroll through it. For 
this reason, the Recipe Builder allows you to locate recipe items and variables by searching the recipe 
for a piece of text and optionally replacing it.  
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Locating Substrings

When searching and replacing data, the Recipe Builder can locate each occurrence of the string you are 
searching for. The string you enter can be the entire contents of a cell or can be a part of a longer string. 
By entering a piece of a longer string (called a substring), you can quickly modify an existing recipe for a 
different node or a different set of blocks. For example, you could search the Identifier column and 
change all the node names in a recipe from FERMENT1 to FERMENT2.  

If you enter a substring and the Recipe Builder finds multiple occurrences of this string, a message box 
appears displaying text similar to the following:

Search string was found x times.
Replace each one?

CAUTION: Select the No button to abort the search, select the Yes button to replace the current cell or select 
the All button to replace every occurrence in the column.

The following table provides additional examples of searching and replacing substrings.    

When the search 
string is...

And the replacement 
data is...

And the column con-
tains...

The resulting data 
is...

T16F1 T16F2
FERMENT1:T16F1.F_
CV

FERMENT1:T16F2.F_
CV

CV LO
FERMENT1:T16F1.F_
CV

FERMENT1:T16F1.F_
LO

50 75 15050 17575
1 55 111 555555
11 55 111 551

Replacing Substrings

NOTE: When searching and replacing data in a recipe with more than 400 recipe items, the node may lose 
sessions. The sessions are re-established when the search is complete.

Before the Recipe Builder can search for a specific piece of text, you must select the column you want it 
to search and the data to search for (called the search string). Before you search and replace data, you 
must select the column to search, a search string, and the new data that replaces the search string. This 
data is called the replacement string.  

You can select the column to search by selecting a cell. When you select a cell, the Recipe Builder 
assumes you want to search the column the cell belongs to, starting with the row that follows the selec-
ted cell.  

You can specify the search string and the replacement string by selecting the Search button. When you 
select this button, the Search and Replace dialog box appears.

Unlike other dialog boxes that prohibit you from selecting a cell in the spreadsheet, you can switch 
between the spreadsheet and the Search and Replace dialog box once the dialog box appears. This fea-
ture enables you to search a part of one column and then select a cell in a different column and continue 
searching and replacing data. 

The Search and Replace dialog box has the following controls:

Search for field — enables you to enter a search string of up to 100 characters. Wildcard characters 
(such as * or ?) are treated as text.  
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The characters you enter into this field remain until you enter a different search string. This fea-
ture allows you to search for multiple occurrences of the search string by selecting the Search 
Next or Search Previous buttons. 

If the Recipe Builder cannot find a match for the search string in the selected column, a message 
box appears displaying the following text:
Text not found

Replace with field — allows you to enter up to 100 characters as the replacement data. Wildcard char-
acters (such as * or ?) are treated as text.  

The characters you enter into this field remain until you change them. This feature allows you to 
search and replace for multiple occurrences of the search string by selecting either the Replace 
Next or the Replace Previous buttons. Completing this field is optional.  

NOTE: The Recipe Builder only uses the text in this field when you select the Replace Next or Replace Pre-
vious buttons. If you do not select either button, the program does not replace any data.

Case Sensitive check box — controls whether the search string is case-sensitive. When you select the 
check box, the search string is case-sensitive. When you clear the check box, the search is not 
case-sensitive. The following table shows how case sensitivity affects Recipe Builder searches.     

When Case Sensitivity Is...And the Seach String is...The Recipe Builder Searches for...

Selected A1 A1

Deselected AI1 AI1, Ai1, aI1, ai1 

Case Sensitivity    

Wrap Around check box — enables you to search an entire column by selecting any cell. When you 
select this check box, the Recipe Builder automatically wraps and continues searching the selected 
column when it reaches the spreadsheet's beginning or end. The following figure shows how this 
works when searching forward.

Searching the Spreadsheet
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When the Wrap Around check box is cleared, the Recipe Builder searches the selected column until it 
reaches end (when searching forward) or beginning (when searching backward) of the spreadsheet.

Search Next button — instructs the Recipe Builder to search forward for the next occurrence of the 
search string in the selected column starting at the selected row.

Search Previous button — instructs the Recipe Builder to search backward for the next occurrence of 
the search string in the selected column starting at the selected row.

Replace Next button — instructs the Recipe Builder to search forward for the next occurrence of the 
search string and replace it.  

Replace Previous button — instructs the Recipe Builder to search backward for the next occurrence of 
the search string and replace it.

 To search for data in a column (or search and replace data): 

 1. Select the column you want searched.   

 2. Click the Search button. The Search and Replace dialog box appears.     

 3. In the Search for field, enter the text you want to locate.   

 4. If you want to search and replace data, in the Replace with field, enter the replacement data.     

 5. Use the following table for instructions on searching forward and backward, replacing data, and 
doing a case sensitive search.   

 6. When you finish searching the selected column, you can return to the spreadsheet by selecting a 
cell. The Search and Replace dialog box remains on the screen. Alternatively, you can close the 
dialog box by selecting the Exit button.    

To... Then...
Search forward for an occurrence of the search string. Select the Search Next 

button.
Search backward for an occurrence of the search string. Select the Search Pre-

vious button.
Search forward for an occurrence of the search string and 
replace it.

Select the Replace 
Next button.

Search backward for an occurrence of the search string and 
replace it.

Select the Replace Pre-
vious button.

Do a case sensitive search. Select the Case Sens-
itive check box.

Do a non-case sensitive search. Clear the Case Sens-
itive check box.

Continue searching a column when the Recipe Builder 
reaches the spreadsheet's beginning or end.

Select the Wrap Around 
check box.

Search and Replace Procedures    

Using the Go To Item Button
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Another method to help you display information faster is to use the Go To Item button. This button allows 
you to jump to a specific row. The feature is very useful when you want to move the length of the spread-
sheet quickly.

When you select the Go To Item button, the Go To dialog box appears. You can switch between the 
spreadsheet and the Go To dialog box, allowing you to jump to different locations in the recipe. You may 
find this feature most helpful when you need to modify many different recipe items throughout the spread-
sheet.

The Go To dialog box contains the Item Number field and the Go button. The Item Number field allows 
you to enter the number of the row you want to jump to. When you select the Go button, the Recipe 
Builder jumps to the specified row.
The Item Number Field

You can enter any row number up to 32,000 into the Item Number field. If the spreadsheet has less than 
32,000 rows, the Recipe Builder allows you to enter a row number equal or less than the last row in the 
spreadsheet. If you enter a larger number, the Recipe Builder jumps to the last row of the spreadsheet 
after displaying the following text in a message box:  

Row is beyond end of recipe

If you enter a negative number or if you enter non-numeric characters, the Recipe Builder displays an 
error message box, indicating that your entry was invalid.  
 To jump to a specific row: 

 1. Click the Go To Item button. The Go To dialog box appears.   

 2. In the Item Number field, enter the number of the row you want to jump to.   

 3. Select the Go button.   

 4. To jump to a different row repeat steps 2 and 3. When you finish jumping to specific rows, you 
can return to the spreadsheet by selecting a cell. The Go To dialog box remains on the screen. 
Alternatively, you can close the dialog box by selecting the Exit button.   

Understanding Recipe Paths

One important aspect of locating and displaying recipe files is knowing which paths the Recipe Builder 
uses to store master and control recipes. The following table describes the paths that the Recipe Builder 
uses, the contents of each path, and its default value.     

Path Stores... Default Value
Master 
recipe 
path 

Master recipes, master text recipes, master recipe error files, 
and report files produced from master recipes. 

C:\Program Files 
(x86)\GE\iFIX\Rcm

Control 
recipe 
path 

Control recipes, control text recipes, control recipe error files, 
recipe note files, and report files produced from control recipes. 

C:\Program Files 
(x86)\GE\iFIX\Rcc

Recipe Paths   

36 © 2020 General Electric Company. All rights reserved.



Defining Paths Without a File Server

Both paths are defined in the Path Configuration dialog box of the SCU. Refer to the Setting up the Envir-
onment manual for more information.

How you define the master and control recipe paths depends on your process and your needs. It is 
recommended that you accept the defaults unless you plan to have a file server with iFIX or unless the 
paths conflict with another path already in use. If you must redefine the recipe paths, make sure that 
each path is unique. Doing this keeps master recipe files separate from control recipe files.
Defining Paths With a File  Server

If you plan to use a file server with iFIX, it is recommended that you define a file server directory as the 
master recipe path and define a local directory as the control recipe path, as the following figure shows.  

Storing Recipes on a File Server

This configuration has the following benefits:

 l Provides one location for storing master recipes, making updates to them quick and easy.   

 l Enables operators to use the control recipes they need without relying on the file server. Should 
the file server become unavailable, operators can continue working.   

Setting the Startup Window

The Recipe Builder provides two windows for displaying information: the Recipe Operations window and 
the Recipe Development window. The Recipe Operations window provides limited control recipe 
access and is intended for the operator who must download control recipes or override a calculated 
value. The Recipe Development window provides full access to all recipes and is intended for the pro-
cess engineer who must create, modify, and maintain master and control recipes. For more information 
about each window refer to the section Recipe Operations and Development Windows.

If you plan on working in one window more than another, you can set the Recipe Builder to automatically 
display either the Recipe Development or Recipe Operations window on startup. Select the Start in Dev 
Window command to automatically display the Recipe Development window on startup. To auto-
matically display the Recipe Operations window, select the Start in Op Window command.  

Switching Between Windows
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In addition to setting the startup window, you can switch between the two windows using the Switch to 
command. Select the Switch to OP command to switch to the Recipe Operations window. To switch to 
the Recipe Development window, select the Switch to DEV command. 

If you attempt to switch to a window, but your system administrator has not assigned you rights to use 
it, a message box appears indicating you do not have the necessary rights. To proceed, contact your 
system administrator.

Applying Fonts

The Recipe Builder enables you to control how the text in the spreadsheet appears by applying a font to 
it, changing the font style, or adjusting the point size. You can do any of these operations by selecting 
the Font command. When you select this command, the standard Font dialog box appears.  

The exact font, style, and point size you select depends on your needs and the fonts installed on your 
node. However the following guidelines provide helpful tips for applying fonts effectively:

 l Select an easy to read font, such as Times or Courier.   

 l Avoid hard to read font styles, such as underline and italics.   

 l When you display a large recipe, adjust the point size to eight or nine. This allows you to display 
more rows in the spreadsheet.   

NOTE: Make sure the font you select for the recipe is available on all nodes. If the font you select is not avail-
able on another node, the operating system substitutes the System font for it when you open the recipe, ignor-
ing the font, point size, and style you selected.

Displaying Tag Group Tagnames

The Recipe Builder enables you to display the tagnames or symbols from a tag group. 

 To display tagnames or symbols from a tag group: 

 1. Assign a tag group to the open recipe. For more information on how to do this, refer to the section 
Assigning Tag Groups. To learn how to create a tag group, refer to the section Creating a New 
Tag Group File.    

 2. Enter a symbol name in the Identifier column that is defined in the assigned tag group file.   

 3. Select one of the commands listed in the following table.    

When 
you 
select 
the...

The Recipe Builder...

Show Tag-
names 
command

Enables you to substitute tag group tagnames for symbol names.

Show Disables tagname substitution and displays only the symbol names you 

Displaying Tag Group Tagnames and Symbols   
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Symbols 
command

entered. If you save the recipe with this command selected, the Recipe 
Builder automatically displays the symbol names in the recipe.

If the symbol specified in the recipe is undefined in the tag group or if the symbol is associated with a 
nonexistent tagname, and you select the Show Tagnames command, the Recipe Builder has no tag-
name to display. In this situation, no tagname substitution occurs.

Adding and Removing Columns

Another way you control what information appears on the screen is by customizing the spreadsheet to 
display only the columns you want. This feature is particularly useful when you want to display only spe-
cific columns for the operator, such as the recipe identifier, the calculated value and the override value.  

You can customize the spreadsheet displayed in both windows by adding and removing only the specific 
columns you want. By selecting the Edit Display Formats command, you can add a column to or remove 
a column from the spreadsheet. This command also allows you to edit the text of each column heading 
and control whether the column is modifiable.

When you select Edit Display Formats from the Window menu, the Window Display Format dialog box 
appears. This dialog box has the following controls:

Available Columns list box — lists the columns you can add to the spreadsheet. If the list box is empty, 
all the available columns are in use.

Column Layout list box — lists the columns currently displayed in either the Recipe Operations window 
or the Recipe Development window. By default, the columns in the Recipe Development window 
appear. The list box displays the columns in the same order as they appear in the recipe and indic-
ates which columns are modifiable.

The following table provides instructions for using the Window Display Format dialog box.     

To... Then...
Add a column to the 
spreadsheet. 

1. From the Available Columns list box, select the column you want 
to add.

2. Select the Add button. The selected column appears in the 
Column Layout list box and disappears from the Available 
Columns list box. 

If you prefer, you can add a column to the spreadsheet by double-
clicking a column in the Available Columns list box.

Remove a column from 
the spreadsheet. 

1. From the Column Format list box, select the column you want to 
remove.

2. Select the Delete button. The selected column disappears from 
the Column Layout list box and appears in the Available Columns 
list box. 

Arrange a column in the 
spreadsheet.

1. In the Column Layout list box, select the column you want to 
move.

2. To move the column up in the list box and to the left in the recipe, 
select the up arrow button. To move the column down and to the 

Window Display Format Procedures    
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right, select the down arrow button.
To display the columns 
from the Recipe Oper-
ations window.

Select the Switch to OP button. The columns from the Recipe Oper-
ations window appear in the Column Layout list box.

To display the columns 
from the Recipe Devel-
opment window.

Select the Switch to DEV button. The columns from the Recipe 
Development window appear in the Column Layout list box.

Modifying a Column

Besides adding and removing columns, the Recipe Builder lets you customize   the spreadsheet by 
restricting input into specific columns and by changing   a column heading. For example, if you want oper-
ators to change only override   values, make the other columns in the Recipe Operations window non-
modifiable.

You can modify columns attributes using the Column Details dialog box.   This dialog box displays the 
Column Heading field and the Modifiable check   box.

Column Heading Field

The Column Heading field enables you to enter the heading you want for   the selected column. The field 
contains the current heading of the selected   column. You can enter up to 39 characters into field.

Modifiable Check Box

The Modifiable check box controls whether values in the selected column   are modifiable. When the box 
is selected, the column is modifiable. When   the box is cleared, the column is not modifiable.

Follow the instructions in the following table to use the Column Details   dialog box.

 To display the Column Details dialog   box: 

 1. On the Window menu,   click Edit Display Format The Window Display Format dialog box 
appears.   

 2. From the Column Layout   list box, select the column you want to modify. 

 3. Select the Modify button, or in the Column Layout   list box, double-click the column. The Column 
Details dialog box appears.   

To... Then...
Modify the column head-
ing.

Enter the heading you want for the selected column   in the 
Column Heading field. 

Make a column modi-
fiable. 

Select the Modifiable check box. 

Make a column non-
modifiable.

Clear the Modifiable check box

Column Details Procedures   

When you finish using the Column Details dialog box you can apply the   changes you have made.
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 To apply column changes: 

 1. From the Column Details   dialog box, click OK. The Recipe Builder updates the Column Layout 
list   box to reflect the changes you made. 

 2. From the Window Display   Format dialog box, click OK. The Recipe Builder updates the spread-
sheet   for the selected column. 

Saving Format Files

After you customize the spreadsheet the way you want it, you can save it to a format file. A format file is 
a binary file with an .RFT extension. The file is stored in the Local path and defines the following spread-
sheet attributes for the Recipe Operations and Recipe Development windows:  

 l The column layout (including the specific columns in the spreadsheet, the column headings, 
column width, and which columns are modifiable).   

 l The font, style, and point size of the text in the spreadsheet.   

 l The type of tag group substitution that is enabled (whether the recipe shows symbol names or tag 
group tagnames).   

The Recipe Builder also uses the data in the format file to determine the order to display each column.

By saving the current spreadsheet format, you make it permanent. After saving a display format, you 
can load it as needed. 

You can save the current format using the Save Display Formats command. When you select this com-
mand, the standard Save As dialog appears. To save the display format, type its name in the File Name 
field and click the OK button. 

Loading Format Files

After you create some format files, you may find it helpful to load a specific format or switch between 
two or more format files when displaying recipes. The Recipe Builder allows you to load a format file with 
the Load Display Format command. Once loaded, the Recipe Builder replaces the existing display 
format of the spreadsheet with the display format you selected.  

After you select the Load Display Formats command, the standard Open dialog appears. To load the dis-
play format, type its name in the File Name field and click the OK button. 

Overriding the Default Format Settings

Each time you start the Recipe Builder, it loads its default format file, DEFAULT.RFT. You can change 
the display format by loading a format file, as described in the section Loading Format Files. However, 
you may find that loading a format file each time you start the Recipe Builder inconvenient, particularly if 
you primarily use only one format file more than any other.  

You can remedy this situation by overriding the preset defaults.
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 To override the preset defaults: 

 1. Rename DEFAULT.RFT, the original file, to something else, such as ORIGINAL.RFT.   

CAUTION: If you do not rename the original format file, you will be unable to display the recipe using 
the preset defaults.

 2. Customize the spreadsheet as described in the sections Adding and Removing Columns and 
Modifying a Column.   

 3. Save your customized format to the file, DEFAULT.RFT. The Recipe Builder overwrites the pre-
set defaults. The next time you start the Recipe Builder, it automatically loads the new set of 
defaults you saved to the format file.   

If, for any reason, you need to display a recipe using the preset defaults, load the original format file as 
described in the section Loading Format Files.

Downloading and Uploading Recipes

One of the most common tasks that the Recipe Package does is uploading   or downloading a recipe. The 
Recipe Package enables you to upload and   download master and control recipes using:

 l The Recipe Builder   

 l An operator display   

 l A Program block 

 l The Scheduler 

This chapter provide detailed explanations of each method. It includes   the following sections:

 l Downloading   from the Recipe Builder

 l Uploading   from the Recipe Builder

 l Uploading   and Downloading From an Operator Display

 l Scheduling   a Recipe for Automatic Upload or Download

 

Downloading from the Recipe Builder

Downloading a recipe from the Recipe Builder lets you preview the calculated values of each recipe item 
prior to sending these values to the process database. 

The window being displayed determines the type of recipe you can open and subsequently download, as 
the following table shows:    

You can download 
a...

From...

Master recipe Recipe Development window
Control recipe Recipe Development or Recipe Operations window

Downloading Master and Control Recipes
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Regardless of the window you download a recipe from, the process is the same and is summarized in 
the following steps.  
 To download a recipe: 

 1. Select the Download button from the recipe header.    

 2. Complete the Download dialog box if it appears.     

The Recipe Builder does error-checking. If the Recipe Builder detects an error, the download 
aborts. If the Recipe Builder detects no errors, the download begins. The Recipe Builder com-
pletes the download and displays the results in a message or dialog box.   

 3. Acknowledge the message box or dialog box that appears.     

The sections Starting the Download, Checking for Errors Before Downloading, and Displaying Down-
load Results describe each step of the download process. Refer to these sections for more information 
about the download process.

IMPORTANT: Make sure no recipes are downloading when you reload a process database. Unexpected res-
ults can occur if the Recipe Builder attempts to download during a database reload.

Starting the Download

The first step in downloading a recipe from the Recipe Builder is to select the Download button. If the 
audit trail is disabled, the Recipe Builder examines the recipe for errors. Refer to the section Checking 
for Errors Before Downloading for more information.

If the audit trail is enabled, the Download dialog box appears. The following figure provides a flowchart of 
the first part of the download process. 
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Starting the Download Process
 To complete the Download dialog box: 

 1. Click the Download button. If the audit trail is enabled, the Download dialog box appears.   

 2. In the Batch ID field, enter an identifier for the download of a recipe. This identifier can be up to 10 
characters. The text you enter into the Batch ID field appears in all recipe messages, uniquely 
identifies the download, and is assigned to the keyword #BATCH_ID for the current download. If 
you do not want to specify a batch ID, you can leave this field blank.   

 3. In the Remarks field, enter up to 20 characters explaining why the recipe is being downloaded. 
The text you enter is included in all recipe messages when the audit trail is enabled and is 
assigned to the keyword #REMARKS for the current download. If you do not want to enter any 
text, you can leave this field blank.   

Checking for Errors Before Downloading

After you complete the Download dialog box, the Recipe Builder examines the recipe for errors. The fol-
lowing figure provides a flowchart of the steps the Recipe Builder performs before downloading the 
recipe.

44 © 2020 General Electric Company. All rights reserved.



Examining a Recipe for Errors During a Download

Notice that the program examines all recipe items and variables for an identifier and a value. Variables 
are not downloaded, however. If the formula of a recipe item references a variable, that variable must 
exist in the recipe and must have a value, otherwise the download aborts.

Also notice that the Completion Status field is updated prior to downloading. Refer to the section Defin-
ing the Completion Status Indicator for more information about possible Completion Status field values.
Handling Errors

Should the Recipe Builder find errors prior to downloading the recipe, it displays an error message box 
with the following text:

Precheck of recipe recipe 
completed with x database errors

You can display these errors by selecting the View button on the message box. When you select this 
button, the Precheck Error List dialog box appears and displays a list of errors.

Common download precheck errors include an active download interlock, downloading to a node that is 
not running SAC, attempting to download a recipe item without a formula or override value, and 

© 2020 General Electric Company. All rights reserved. 45



attempting to download to a tagname that does not exist. To correct these, or any other errors, you must 
cancel the download first. For additional information about handling precheck errors, refer to the section 
Understanding Audit Trail and Error File Messages.

NOTE: If the Recipe Builder encounters precheck errors for the upload or download interlock, the Item No. 
field in the Precheck Error List dialog box is left blank for that block. To correct the error for either interlock, 
open the database and make the necessary changes or change the interlock with the Advanced Options dia-
log box.

Displaying Download Results

After the recipe has been downloaded, the Recipe Builder displays its results. The exact results depend 
on whether recipe verification has been enabled.  

If none of the recipe items have verification enabled, the Recipe Builder displays the following text when 
it successfully downloads the recipe:

Download of recipe recipe completed with 
NO ERRORS

Click OK to acknowledge the message.  

NOTE: If you notice alarm entries missing from an alarm file after a recipe is downloaded, the alarm file 
queue may not be large enough. To correct this problem, increase the size of the Alarm File Queue so that it 
is larger than the recipe. For example, if the recipe has 100 recipe items, the queue size should be at least 
101. For information on how to increase the size of an alarm queue, refer to the section Modifying the Alarm 
Queues in the Implementing Alarms and Messages manual.

If the Recipe Builder was unable to download one or more of the recipe values to the database, the 
Download Error List dialog box appears.  

NOTE: The information listed in this dialog box reflects the state of the recipe at the time of the download. If 
you modify the recipe after the Download Error List dialog box appears, the information displayed in the dia-
log box will not reflect the current state of the open recipe.  

Common causes for write errors are if the target block is in Automatic mode instead of Manual mode, if 
the block is off scan, or if the block is assigned to a security area that is not defined in the recipe user 
account on the target node. For additional information about handling download write errors, refer to the 
section Understanding Upload and Download Messages. For information about using the recipe user 
account, refer to the chapter Recipe Security.

The following figure shows what happens when recipe verification is enabled.
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Displaying Verification Results

Notice that when a write error occurs, the Download Error List dialog box appears.  

Verifying a Recipe

If no write errors occur, the Recipe Builder begins verifying each recipe item that has verification 
enabled. Using the Verify column in the spreadsheet, you can select the recipe items you want to verify. 

The Recipe Builder handles recipe verification by reading the target block field and comparing its current 
value in the database against the value in the recipe. When the two values match, the recipe item is veri-
fied.  

IMPORTANT:  Because the Recipe Package reads and writes from the same set of blocks, you can only 
verify recipe items that specify blocks with an input and output capability. These blocks include the Analog 
Input, the Analog Alarm, the Analog Register, the Digital Input, the Digital Alarm, the Digital Register, and the 
Text block. Attempting to verify a recipe that contains any other type of block can produce unexpected results.

When verifying Digital Register blocks, make sure the type of formula agrees with the type of field spe-
cified in the identifier. Only use strings with the A_CV field and only use numeric values with the F_CV 
field. If you do not, the Recipe Builder cannot verify the block's value. For example, if you specify the 
field A_CV, enter a string formula that matches the label for the appropriate state of the block, such as 
"OPEN".  

If one or more recipe items reference an Analog Register or Digital Register block, you may experience 
difficulty verifying these items. To resolve this problem, create an Analog Input block for each poll record 
referenced by the recipe. Make sure the scan time of the Analog Input block is shorter than the access 
time of the poll record it is assigned to. This setup ensures that the I/O driver does not time out and stop 
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polling the poll record. By continuously polling each address, you ensure that data is available for veri-
fication.

As it verifies a recipe, the Recipe Package continually reads the values of the target blocks until each 
recipe item that you selected is verified or the time-out interval expires. All recipe items must verify at 
the same time in order to verify a recipe successfully. For example, consider the following.    

First Pass Second Pass Third Pass
Recipe Item 1 Verified Not verified Verified
Recipe Item 2 Not verified Verified Verified
Recipe Item 3 Verified Verified Verified

In this example, the recipe is verified only on the third pass through it, because only on the third pass are 
all recipe items verified. When one or more recipe items are not verified, as shown above, the Recipe 
Builder starts from the beginning of the recipe and attempts to verify each recipe item you have selected 
again.

The time-out interval specifies the amount of time the Recipe Builder spends verifying the recipe. If this 
interval expires without verifying the recipe, a time-out error occurs and the verification process ends.  

NOTE: The time-out interval you specify applies to the local node. All recipes downloaded from the local 
node will use this time-out interval. 

If the time-out interval expires, the Recipe Builder displays the Verification Error List dialog box.

NOTE: The information listed in the Verification Error List dialog box reflects the state of the recipe at the time 
of the download. If you modify the recipe after the Verification Error List dialog box appears, the information 
displayed in the dialog box will not reflect the current state of the open recipe.  

Common verification errors include attempting to verify a block that is off scan or attempting to verify 
blocks on a node that does not have SAC running. For additional information about handling verification 
errors, refer to the section Understanding Upload and Download Messages.  

Changing the Verification Time-out Interval

By default, the verification time-out interval is 30 seconds. However, if you find that the verification pro-
cess is timing out you may need to give your system more time to read process values and update the 
database.

 To modify the time-out interval: 

 1. From the Recipe Builder, on the File menu, click Exit. If necessary, save any changes you have 
made to the current recipe.   

 2. In a text editor, open the RCP.INI file. This file resides in the Local path. You should see the fol-
lowing text:   
[startup]
startup.mode=2
verification.timeout=30

 3. Modify the time-out interval by changing the value from 30 to some other value. Possible values 
for the time-out interval are from 1 to 65,535 seconds.   
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 4. After modifying the time-out interval, save the RCP.INI file and restart the Recipe Builder.   

 5. With the new time-out interval, try downloading the recipe again.     

For information about verification errors, refer to the section Verifying a Recipe.

Uploading from the Recipe Builder

Uploading a recipe is the process of reading process values from the database and storing them in the 
open recipe. While uploading values from your process may not be done very often, it can be useful 
when you want to quickly create a recipe by capturing the current process values being used.  

When the Recipe Builder uploads a recipe, it replaces recipe item formulas that contain numeric or string 
constants. Formulas containing variables, mathematical expressions, keywords, or recipe functions are 
not replaced.

CAUTION: If the Recipe Builder cannot read a process value from the database, it clears the existing formula 
for that recipe item without inserting a new value to indicate that the associated tagname could not be read or 
could not be found in the database. Before saving the uploaded recipe, make sure you examine your recipe 
for completeness. If any formulas are blank, do not save the recipe or you will overwrite the formulas saved in 
the file.

Aside from these differences, uploading a recipe is similar to downloading a recipe except that recipe 
verification is not available. The recipe upload process is summarized below.  

 To upload a recipe: 

 1. Select the Upload button from the recipe header.     

The Recipe Builder does error-checking. If the Recipe Builder detects an error, the upload aborts. 
If the Recipe Builder detects no errors, the upload begins. The Recipe Builder completes the 
upload and displays the results in a message or dialog box.   

 2. Acknowledge the message box or dialog box.    

The sections Starting the Upload Process, Checking for Errors Before Uploading, Displaying Upload 
Results describe each portion of the upload process. Refer to these sections for more information about 
the upload process.

Starting the Upload Process

You can start the upload process from the Recipe Builder by selecting the Upload button. The following 
figure provides a flowchart of what happens when you select this button.
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 Selecting the Upload Button

Checking for Errors Before Uploading

As the previous figure shows, if iFIX security has not been enabled or if the user account has the neces-
sary application feature, the Recipe Builder examines the recipe for errors. The following figure provides 
a flowchart of the steps the Recipe Builder performs before uploading a recipe.

Examining a Recipe for Errors During an Upload
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As you can see, this process is similar to the steps taken when downloading a recipe. For example, just 
as with downloading, the Recipe Builder examines the database to ensure the specific blocks exist.  

Similarly, the Completion Status field is updated when the upload process begins. The Completion 
Status Values table describes the possible values and their meaning.

Should the Recipe Builder detect an error, it displays an error message box with the following text:

Precheck of recipe recipe
completed with x database errors

You can display these errors by selecting the View button on the message box. When you select this 
button, the Precheck Error dialog box appears and displays a list of errors.

Common upload precheck errors include an active upload interlock or an attempt to upload from a tag-
name that does not exist. To correct these, or any other errors, you must cancel the upload first. For addi-
tional information about handling precheck errors, refer to the section Understanding Audit Trail and Error 
File Messages.  

NOTE: If the Recipe Builder encounters precheck errors for the upload or download interlock, the Item No. 
field in the Precheck Error List dialog box is left blank for that block. To correct the error for either interlock, 
open the database and make the necessary changes or change the interlock with the Advanced Options dia-
log box.

Displaying Upload Results

After the recipe has been uploaded, the Recipe Builder displays its results. The following figure sum-
marizes the possible results.

Displaying Recipe Upload Results

Notice that when a read error occurs, the Upload Error List dialog box appears.

NOTE: The information listed in this dialog box reflects the state of the recipe at the time of the upload. If you 
modify the recipe after the Upload Error List dialog box appears, the information displayed in the dialog box 
will not reflect the current state of the open recipe.  

Common upload read errors include an active upload interlock or uploading from a block that is off scan. 
For additional information about handling upload read errors, refer to the section Understanding Upload 
and Download Messages.
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Uploading and Downloading From an Operator Display

While it is possible to upload or download a recipe from the Recipe   Builder, you may want to create or 
modify operator displays that upload   or download recipes. 

When an operator uploads or downloads a recipe from an operator display,   the Recipe Package uploads 
or downloads each recipe item. No dialog or   message boxes appear to inform you about the status of the 
recipe during   the upload or download. Any errors that occur are not saved unless you   enable the audit 
trail or use the Error File command line parameter. 

When uploading a recipe, the Recipe Package automatically saves the   recipe. If the Recipe Upload sys-
tem task cannot read a process value from   the database, it clears the existing formula for that recipe 
item. 

If the recipe being downloaded has recipe items with verification enabled,   these recipe items are verified 
as part of the download process. Refer   to the sections Displaying   Download Results, Verifying a   
Recipe, and Changing   the Verification Time-out Interval for more information about recipe   verification.

In addition, if security has been enabled, iFIX compares the security   areas of the target blocks to the 
security areas assigned to the Recipe   user account. If the security system finds a match, it downloads 
the recipe   value. Otherwise, the value is not written to the database. 

Similarly, iFIX compares the security area of the operator display against   the security areas assigned to 
the currently logged in user. If a match   is found, iFIX opens the display. Neither the security rights to 
recipe   application features nor the security area of the recipe is examined.

To upload or download a recipe from an operator display, create a picture   with the necessary objects. 
For each object you want to use for uploading   or downloading include a script with the Shell function. 
This function,   when executed, starts the recipe system task you specify.

For example, you may want to add push button objects to upload and download   recipes. The following 
sample script shows how you can download a recipe:

Private Sub Button1_Click()
Dim download As String
Dim return_value As Double
 
download = System.ProjectPath + "\RCPDOWN" + " /cRCPFILE /e"
return_value = Shell (download, 0)
End Sub

To create an upload script, define a variable called upload in place   of the download variable and sub-
stitute the reference to RCPDOWN with   RCPUP as follows:

upload = System.ProjectPath + "\RCPUP" + "/cRCPFILE /e"

Including Command Line Parameters

As these examples show, you can include command line parameters in the   script. To help troubleshoot 
the upload and download process, you should   include the Error File parameter so that any errors are 
saved in an error   file called recipe.RCE.   This file resides in either the Master Recipe path or the Control 
Recipe   path, depending on the type of recipe that was uploaded or downloaded.   You can display the con-
tents of this file using a text editor.
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If you have enabled the audit trail for the recipe, you may also want   to include the Batch ID and Down-
load Remarks parameters. To learn more   about the command line parameters for the Recipe Upload and 
Recipe Download   programs, refer to the appendix Command   Line Parameters. For more information 
about the Shell function, refer   to the Microsoft Visual Basic Reference Help system.

Scheduling a Recipe for Automatic Upload or Download

Depending on your needs, you may want to automatically upload or download   a recipe. You can auto-
matically upload or download a recipe, using a Program   block or the Scheduler. For more information 
about the Scheduler, refer   to the Mastering iFIX manual.

When you upload or download from a Program block, no dialog or message   boxes appear to inform you 
about the status of the recipe during the upload   or download. Any errors that occur are not saved unless 
you enable the   audit trail or use the Error File command line parameter. 

When uploading a recipe, the Recipe Package automatically saves the   recipe. If the Recipe Upload sys-
tem task cannot read a process value from   the database, it clears the existing formula for that recipe 
item. 

If the recipe being downloaded has recipe items with verification enabled,   these recipe items are verified 
as part of the download process. Refer   to the sections Displaying   Download Results, Verifying a   
Recipe, and Changing   the Verification Time-out Interval for more information about recipe   verification.

In addition, if security has been enabled, iFIX compares the security   areas of the target blocks to the 
security areas assigned to the Recipe   user account. If the security system finds a match, it allows the 
block's   process value to change. Otherwise, no value is written to the database.   Neither the security 
rights to recipe application features nor the security   area of the recipe is examined.

Configuring a Program Block

You can schedule a recipe for automatic uploading or downloading by   configuring a Program block with 
the RUNTASK command. This command allows   you to run the recipe system tasks automatically at 
specific times or   when a specific event occurs. The following table provides examples of   the RUNTASK 
syntax you need to execute the Recipe Download and Recipe   Upload programs for a control recipe. 

To run the... Use the command...
Recipe Download program RUNTASK RCPDOWN /ccontrol_recipe   /e
Recipe Upload program RUNTASK RCPUP /ccontrol_recipe   /e

Automatic Upload/Downloads   with a Program Block 

To help troubleshoot the use of the RUNTASK command, you should include   the Error File parameter 
with the Recipe Upload and Recipe Download programs.   Using this parameter enables the Recipe Pack-
age to record errors in an   error file called recipe.RCE.   The file resides in the Control Recipe path (when 
working with control   recipes) or the Master Recipe path (when working with master recipes).   You can 
display the contents of this file using a text editor.

Scheduling an Upload or Download

By using other Program block commands with the RUNTASK command, you   can schedule when to 
upload and download a recipe. For example, to schedule   a control recipe to be downloaded once a day, 
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use the following commands:   

Command Action
WAITFOR TIME = 12:00:00 Wait until noon.
RUNTASK RCPDOWN /ccontrol_recipe   /eDownload the recipe.

To download the recipe at a different time, change the time in the WAITFOR   command. 

Alternatively, you can configure a Program block to upload or download   a recipe when a specific event 
occurs. For example, assume you want to   download a recipe when the download interlock becomes 
inactive. To do   this, use commands similar to the following: 

Command Action
WAITFOR ILK1=0 Wait until interlock becomes inactive.
RUNTASK RCPDOWN /ccontrol_recipe   /eDownload the recipe.

To learn about the command line parameters for the Recipe Upload and   Recipe Download programs, 
refer to the chapter Command   Line Parameters. 

Accelerating the Upload or Download

To accelerate the upload or download time, you can change the display   time of the dialog box that auto-
matically displays. Add the dialogdisplaytime   setting to the rcp.ini in the iFIX Local path. For example: 

dialogdisplaytime=1000

where 1000 is equal to a 1 second (1000 milliseconds) display time.   
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Working with Formulas

One of the most flexible features of the Recipe Builder is its ability   to include formulas in recipes. A for-
mula is like a programming assignment   statement. It enables you to specify how the Recipe Builder 
should calculate   a value for a recipe item or variable. 

You can construct a formula by entering one or more of the formula items   listed in the following table into 
the Formula column of the spreadsheet.   

Formula Examples
String constant "John"
Numeric constant 5 or 0.5
Mathematical operators +, -, *, /,^, = =, <=
Function Log(234) or Lookup (#BATCH;1;2;3;4;5)
Variable name #COLOR
Keyword #BATCH

Formula   Items

By combining the items listed above, you can represent a value as best   fits your needs. For example, 
the sample recipe, you may remember, requires   150 pounds of yeast to be added during fermentation. 
You can represent   this amount as a numeric constant by entering 150 in the Formula column   for the 
appropriate tagname. If you prefer, you can also assign this value   to a variable and then use the variable 
as the formula for the block as   shown below: 

Identifier Formula
#Yeast 150
FERMENT1:Q16F1.F_CV #Yeast

You could also represent the quantity as a mathematical expression such   as 100*1.5. Assuming 100 is 
the standard batch size and 1.5 is the amount   of yeast required for every barrel of beer produced, you 
can also represent   the quantity with the following keyword and variable as follows:

#STD_BATCH*#Lbs_Per_Barrel
 

Understanding Formula Syntax

Before you begin using formulas in your recipes, refer to the following   sections to learn about the syntax 
of recipe keywords, functions, and   operators:

 l Working   with Functions

 l Understanding   Formula Operators

 l Understanding   Recipe Keywords

In addition to the syntax of these items, all strings in a formula must   be enclosed in quotation marks (" ") 
and you must precede a   number less than one with a leading zero (for example, 0.5). 

Working with Functions
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The Recipe Builder provides a set of functions common to most spreadsheet programs. The following 
table summarizes the available recipe functions and their syntax. All trigonometric functions require val-
ues entered in radians.      

When you 
select the 
function...

The Recipe Builder calculates the... Syntax

ABS Absolute value of number. ABS (number)
ACOS Arccosine of number. ACOS (number)
ASIN Arcsine of number. ASIN (number)
ATAN Arctangent of number. ATAN (number)
COS Cosine of number. COS (number)
EXP Anti-log of number. EXP (number)
INT Integer value of number. INT (number)
LOG Natural log of number. LOG (number)
LOG10 Base 10 log of number. LOG10 (number)
SIN Sine of number. SIN (number)
SQRT Square root of the number. SQRT (number)
TAN Tangent of number. TAN (number)

Functions   

In addition to the functions listed in the previous table, the Recipe Builder also provides the Lookup and 
Index functions. These functions help you locate a value within a list.
The Lookup Function

The Lookup function locates and uses the nth value in a list, where n is a zero-based integer. You can 
use the following syntax for this function:

LOOKUP (number; numeric list)
or
LOOKUP (number; string list)

The Lookup function also allows you to substitute a variable name or keyword anywhere you can use a 
number or string value.

When the Recipe Builder evaluates the Lookup function, it uses the value of number to select the appro-
priate value from the list. For example, consider the following:    

Identifier Formula Calc Val
#Yeast 3 3
#Result LOOKUP (#Yeast;0;150;300;450;600) 450

When the Recipe Builder evaluates this function, it uses the value of the variable #Yeast to determine 
the value of the function. The following table lists the possible values of the function.      

If the value of #Yeast is... Then the function evaluates to...
0 0
1 150
2 300
3 450
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4 600
None of the above ??????

The Index Function

The Index function is similar to the Lookup function. The Index function locates the position of a number 
or string within a list. The position of each item is zero-based. As a result, the first item evaluates to 
zero, the second item to one, the third item to two, and so on. You can use the following syntax for this 
function:

INDEX (number; numeric list)
or
INDEX (string; string list)

The Index function also allows you to substitute a variable name or keyword anywhere you can use a 
number or string value.

When the Recipe Builder evaluates this function, it searches for a match between number or string and 
the accompanying list. If it does not find a match, the value of function equals the number of items in the 
list. If it finds a match, the function equals the position of the located item in the list.  

For example, consider the following:    

Identifier Formula Calc Val
#Beer_Type "Ale" "Ale"
#Result INDEX (#Beer_Type; "Dark Beer"; "Ale"; "Mead"; "Stout") 1

When the Recipe Builder evaluates these recipe items, it searches the list for the value of #Beer_Type. 
Since the value of #Beer_Type is "Ale", the Index function yields a value of one. The following table lists 
all possible values of the function.    

If the value of #Beer_Type is... The value of the formula is...
"Dark Beer" 0
"Ale" 1
"Mead" 2
"Stout" 3
None of the above 4

NOTE:  The Index function does non-case sensitive string matching when string values are specified.

iFIX supports the international formats supported in Windows. The recommended list separator for the Index 
and Lookup functions is a semicolon (;). 

Understanding Formula Operators

 

Operator Precedence

The Recipe Builder provides a set of operators common to many spreadsheet programs. The following 
table lists the available formula operators from high to low precedence. The Recipe Builder uses the pre-
cedence of an operator to determine which operator to evaluate first. An operator with a higher 

© 2020 General Electric Company. All rights reserved. 57



precedence is evaluated first. Operators with the same precedence are evaluated in the order they occur 
in the formula from the left to right.    

Operator Syntax P-
re-
c-
e-
d-
e-
n-
c-
e

( ) (parentheses) (expression) 1
- (unary minus) - number 2
All functions See the Functions table. 2
^ (exponentiation symbol) number ̂  number 3
* (multiplication) number * number 4
/ (division) number / number 4
+ (addition) number + number 5
- (subtraction) number - number 5
< (less than) number < number 6
<= (less than or equal to) number <= number 6
> (greater than) number > number 6
>= (greater than or equal to) number >= number 6
!= (not equal to) number != number 6
== (equal to) number = =number 6

Formula Operators    

Changing the Order of Precedence

You can change the order in which the Recipe Builder evaluates a formula by enclosing a portion of it in 
parentheses. Expressions enclosed in parentheses have the highest precedence of any part of the for-
mula.

For example, consider the formulas listed below:    

Formula Value
5*3^2 45
(5*3)^2 225

Understanding Recipe Keywords

Recipe keywords are variables reserved for use by the Recipe Builder. The following table summarizes 
the available recipe keywords. The keywords #STD_BATCH, #BATCH, and #SCALE contain numeric 
values. All other keywords contain string values.      
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The 
keyword...

Contains 
the...

To set the value of the keyword...

#BATCH Current batch 
size

Select the Set Batch Size from the Options menu. The Batch 
Size dialog box appears.

Complete the Batch Size field in the dialog box.
#BATCH_ID Batch ID With the audit trail enabled, select the Download button from the 

Recipe Builder. The Download dialog box appears.

Complete the Batch ID field in the dialog box.
#REMARKS Download 

remarks
With the audit trail enabled, select the Download button from the 
Recipe Builder. The Download dialog box appears.

Complete the Download Remarks field in the dialog box.
#BATCH_
UOM

Batch unit of 
measure

Complete the Batch UOM field in the recipe header.

#NAME Recipe name Open a recipe or save an untitled recipe.
#PRODUCT Name of the 

end product
Complete the Product field in the recipe header.

#SCALE Batch scaling 
factor

1. Complete the Standard Batch Size field in the recipe header.

2. Select the Set Batch Size from the Options menu. The Batch 
Size dialog box appears.

3. Complete the Batch Size field in the dialog box. The Recipe 
Builder automatically calculates the scaling factor dividing the 
#STD_BATCH by #BATCH.

#STD_
BATCH

Standard 
batch size

Complete the Standard Batch Size field in the recipe header.

#TAG_
GROUP

Assigned tag 
group file 
name

1. Select the Assign Tag Group from the Option menu. The Assign 
Tag Group dialog box appears.

2. Complete the Tag Group File name field in the dialog box.
#UNITS Process unit 

used by the 
recipe 

Complete the Units field in the recipe header.

Recipe Keywords    

NOTE: The keyword #BATCH_ID and #REMARKS always appear blank in the recipe, but the text you enter 
for each keyword is downloaded to the database when you assign either keyword to a tagname.

The Recipe Builder allows you to use a keyword containing a string value in place of a string constant. 
For example, consider the following formula:

INDEX ("BEER"; "ALE"; #PRODUCT; "MEAD")

In this example the value of the keyword #PRODUCT is used in place a string constant.

You can also substitute a keyword with a numeric value for an actual number. For example:

INT(#BATCH)

This formula calculates the integer value of the current batch size.

Working with Variables and Formulas
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Including Variables in Formulas

Just as you can use keywords in place of string and numeric constants, you can use variables in place 
of string and numeric values. For example, in place of the #BATCH in the previous example, you can 
use the variable #YEAST.
Deleting Variables

Be careful about deleting a variable. If you delete a variable that another variable or recipe item ref-
erences, the Recipe Builder displays the text ?????? in the Calc Val column of the item that referenced 
the deleted variable. While the Recipe Builder displays this text, the recipe cannot be downloaded. To fix 
this situation, do one of the following actions:

 l Edit the formula of the recipe item or variable that references the deleted variable.   

 l Create a variable with the same name as the variable you deleted.   

 l Override the recipe item or variable that references the deleted variable.   

To avoid deleting variables that are referenced by another item in the spreadsheet, search the Formula 
column for the variable name before you delete it from the recipe. 

Creating Formulas

Once you know the keywords, operators, and functions you want to use, you can define a formula by 
selecting a cell in the Formula column of the spreadsheet and entering the formula into the text editing 
box.  

If your recipe has a value that is repeatedly reused, you may find it helpful to represent the value with a 
variable at the top of the spreadsheet. While you do not have to keep variables at the beginning of the 
spreadsheet, doing so makes maintaining and customizing a recipe easier. 

Modifying and Recalculating Formulas

As your needs change, you may find it necessary to modify a formula. You can do this by selecting the 
formula you want to edit and modifying it as needed. 

When you finish editing the formula, press <Enter>. The Recipe Builder automatically recalculates all 
recipe formulas in the order they occur.  

If the Recipe Builder cannot recalculate a formula (for example, when one or more variables referenced 
by the formula are undefined) an error message box appears displaying the following text:

Recalculation failed at item #x. Error xxxxerror_text

The Recipe Builder also stops recalculating all formulas that come after the incalculable formula. The fol-
lowing figure shows an example of this and how to correct the error.
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Recalculating Formulas

You cannot change a recipe item with a field type of A_ and a string formula to an F_ field. If you attempt 
to do this, the following error message appears:

Checking this item. Only F_ and A_ fields are allowed.

Overriding the Calculated Value

Formulas enable you to represent a value in a generic way. For example, you can represent the batch 
size of a product with the following formula:

#STD_BATCH*0.5

By representing the batch size with this formula, you can adjust its value by changing the value in the 
Standard Batch Size field or the scaling factor represented by the numeric constant 0.5.

However, you may find circumstances when using a formula is inappropriate. For example, suppose you 
are making beer for an upcoming holiday. Assume for this product that you need to lower the tem-
perature that the beer ferments at and increase the fermentation time.  

Using the Recipe Builder, you can adjust the formulas for the temperature set point and fermentation 
time. Alternatively, you can override the calculated value for these items. When you override a value, 
you specify a process value to use in place of the recipe item's or variable's calculated value.  

Entering an Override Value

You can enter an override value by selecting the appropriate cell in the Override Val column and typing 
the new value in the text editing box. The range of values you can enter into the Override Val column 
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depends on the high and low override limits defined for a specific recipe item or variable. To set the over-
ride limits for a recipe item or variable, refer to the section Entering Override Limits.

After you enter an override value, the Recipe Builder continues recalculating the formula of the over-
ridden item. All recipe items that reference the overridden recipe item or variable are recalculated using 
the override value.  
Batch Resizing Overridden Values

The Recipe Builder also warns you when attempting to scale overridden recipe items and variables by 
displaying a message box with the following text:

There are recipe items with OVERRIDE VALUES

Select the Clear All button to clear all override values or select the Continue button to keep the overrides 
in effect and set the batch size. To quit without making any changes, select the Cancel button. For more 
information on scaling batches, refer to the section Scaling the Batch Size.

Entering Override Limits

When you add or insert a recipe item or variable, the Recipe Builder automatically sets the high and low 
override limits to UNRESTRICTED. This allows anyone to enter any override value needed. If you want 
to restrict the possible value of the override value, change the override limits.

To enter an override limit into the Override Lo Lim column or the Override Hi Lim column, select a cell in 
either column and type the limit you want in the text editing box.    

The following table provides guidelines for entering values in each column. If you are entering values 
from the text editing box, follow the guidelines below.      

To set an over-
ride limit to...

Type...

Unrestricted U
An absolute 
value

The value you want to use. For example, to set the low limit to 50, type 
50<Enter> in the Override Lo Lim column.

A relative per-
centage of the 
calculated value

The percentage of the calculated value you want to use. Be sure to include a 
percent sign (%) after the percentage. For example, to set the high limit to 
10%, type 10%<Enter> in the Override Hi Lim column.

A relative dif-
ference from the 
calculated value

The difference from the calculated value you want to use followed by a 
minus sign (-). For example, to set the high limit to 10 over the calculated 
value type 10-<Enter> in the Override Hi Lim column.  

Restricted R

Override Limits   

For more information about override limits, refer to the section Spreadsheet Columns.

If you prefer, you can enter the override limits using the Override Limit dialog box. To display this dialog 
box, double-click a cell in either override limit column.

When the Override Limit dialog box appears, select the appropriate radio button and, if there is a field to 
the right of the button, use the guidelines in the table Override Limits to enter a value into that field.
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Deleting Overrides

When you want to remove an override value, select it and press <Delete>. To delete all the override val-
ues in use, select the Clear Overrides button. When you select this button, a message box with the fol-
lowing text appears: 

Are you sure you want to clear all overrides?

Select the Yes button to delete every override value. To retain the override values select the No button.

Advanced Features

The Recipe Builder provides some advanced features that you may find helpful when using recipes. The 
following table lists each feature, the command associated with it, and the section to refer to for more 
information.    

Feature Command Section
Scaling the batch size of a recipe Set Batch Size Scaling the Batch Size
Assigning a tag group to a recipe Assign Tag 

Groups
Assigning Tag Groups

Defining the upload and download interlocks for a 
recipe Advanced 

Options
Using an Advanced 
OptionAssigning a recipe to a security area

Defining the completion status indicator
Keeping an audit trail of recipe activity

Recipe Builder Advanced Features

Scaling the Batch Size

Whenever you want to produce a varied amount of the product you are making, the Recipe Builder 
enables you to scale the batch size of a recipe. When scaling the batch size, the Recipe Builder pre-
serves the relative proportions among the recipe items and variables being scaled.

The Recipe Builder allows you to scale a recipe's batch size in the Recipe Development window. The 
first step in scaling a batch is to complete the Standard Batch Size field in the recipe header. The Recipe 
Builder assigns the batch size value you enter to the #STD_BATCH keyword. The program then uses 
the specified value to calculate the scaling factor. For more information on the Standard Batch Size field, 
refer to the section Recipe Header.

After you define the standard batch size, you must define the current batch size of the recipe. You can 
define this quantity with the Set Batch Size command.

When you select this command the Batch Size dialog box appears. This dialog box contains the Batch 
Size field. This field allows you to specify a value for the current batch size from 0.000001 to 
9,999,999.0.  
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 To set the batch size: 

 1. On the Options menu, click Set Batch Size. The Set Batch Size dialog box appears.   

 2. In the Batch Size field, enter the amount of the product you want to make.   

When you select the OK button on the Set Batch Size dialog box, the Recipe Builder assigns the value 
you entered to the #BATCH keyword and displays it in the Batch Size field of the recipe display area, as 
the following figure shows. The Recipe Builder also divides #BATCH by #STD_BATCH to compute the 
scaling factor. The result of this calculation is stored in the #SCALE keyword.

The Recipe Display Area

The next step is to multiply the formula of each recipe item you want to scale by #SCALE. Once this is 
done, you can scale a batch by changing the current batch size. The following figure shows how to use 
#SCALE in a recipe.  

Scaling a Batch

If you attempt to change the batch size of a recipe item or variable with an overridden formula, the 
Recipe Builder warns you by displaying a message box with the following text:

There are recipe items with OVERRIDE VALUES

Select the Clear All button to clear all override values or select the Continue button to keep the overrides 
in effect and set the batch size. To quit without making any changes, select the Cancel button.  
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Assigning Tag Groups

With the Recipe Builder, you can create one recipe for each production   line you have. When the product 
being made on each line is different,   this is the most straightforward way to use recipes. However, if you 
have   similar production lines that produce similar products, you may want to   assign a tag group to a 
recipe. The tag group defines a set of tagnames.

Tag groups enable you to put generic symbols in the Identifier column   of a recipe. A symbol is a label 
defined in the Tag Group Editor. In a   recipe, a symbol represents a tagname. During a download or 
upload, the   Recipe Builder reads the tag group file assigned to the recipe and substitutes   the tagnames 
for the symbols in the recipe. By having different tag group   files for each product you want to make, you 
can create one, multi-purpose   recipe that functions with many different locations and different equip-
ment.

For example, suppose you want the option of switching among three fermenters.   One way you could do 
this is to duplicate the sample recipe for the second   and third fermenters. These recipes would be 
identical to the sample recipe   except for the tagnames that control the fermenting time, the temperature   
set point, and the scale set point.

However, by creating three tag groups you can save yourself the need   of creating the two additional 
recipes. And since the production lines   share the same recipe, when you update a recipe for one line, 
you update   it for every line using that recipe.

Each tag group you plan to use lists the tagnames required for the fermenter   used by the recipe as 
shown below: 

Fermenter 1 Tagnames Fermenter 2 Tagnames Fermenter 3 Tagnames
T16F1.F_CV T16F2.F_CV T16F3.F_CV
K16F1.F_CV K16F2.F_CV K16F3.F_CV
W16F1.F_CV W16F2.F_CV W16F3.F_CV

The sample recipe would then be modified replacing the specific tagnames   with tag group symbols. 
Symbols can have a length of 32 characters and   must have the following format:

?string

where string   is a 31-character string. The string must begin with a single alphabetic   character and can be 
followed by one or more alphanumeric characters.   Each symbol must be unique. For more information 
about tag groups and   symbols, refer to the chapter Using   the Tag Group Editor.

One way you might use symbols in the sample recipe is to replace T16F1.F_CV,   K16F1.F_CV, and 
W16F1.F_CV with the symbols ?BeerTemp, ?BeerTime, and   ?YeastWeight respectively. The following 
figure shows the resulting sample   recipe and the tag groups. Notice that each tag group uses the same 
symbol   but associates a different tagname with it. For example, in the Fermenter   1 tag group the symbol 
?BeerTemp is associated with the tagname T16F1.F_CV   but in the Fermenter 3 tag group the same 
symbol is associated with the   tagname T16F3.F_CV.
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Using Tag Groups

 To use a tag group in a recipe, do   one of the following: 

 l Create a list of   the symbols defined for the tag groups you want to use. Make sure the   tag group 
symbols are identical across each tag group. After you create   this list, enter the tag group sym-
bols in the Identifier column of the   recipe. 

 l Define the symbols   in the recipe first and create the tag group with the Tag Group Editor.   

After you enter the symbols into the recipe and create the tag group   file, you can assign the tag group to 
the recipe using the Assign Tag   Group command. This command is only available from the Recipe 
Development   window. When you select the command the Assign Tag Group dialog box appears.   This 
dialog box contains the Tag Group Filename field. This field allows   you to enter the name of the tag 
group file you want to use for this recipe.   Tag group files are stored in the Picture path and have the 
extension   .TGE.
 To assign a tag group to a recipe:   

 1. On the Options menu,   click Assign Tag Group. The Assign Tag Group dialog box appears. 

 2. In the Tag Group   Filename field, enter the tag group file you want to assign to the recipe,   or select 
the browse (...) button to the right of the field and double-click the   tag group file you want to 
assign to the recipe from the list that appears.   
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After you assign a tag group to a recipe, you can display the tagnames   by selecting the Show Tagnames 
command. To display the symbol names again,   select the Show Symbols command. For more inform-
ation about these commands,   refer to the section Displaying   Tag Group Tagnames.

NOTE: If you download   or upload a recipe with a symbol name defined, the Recipe Builder substitutes   the 
tagname for the corresponding symbol prior to reading or writing a   value.
Using the Tag Group Parameter

If you plan to download recipes from the Scheduler, a Program block,   or operator displays, you may find 
using the Tag Group command line parameter   helpful. This parameter overrides the tag group assigned 
to the recipe   and uses the tag group specified in the command line. For more information   about this para-
meter, refer to the section Tag   Group Parameter.

Using an Advanced Option

The Recipe Builder includes a set of advanced options that enable you   to do the following:

 l Define   the upload and download interlocks for the recipe.

 l Define   the tagname of an upload/download status indicator.

 l Assign   the recipe to a security area.

 l Keep   an audit trail of recipe activity.

You can complete each of these tasks using the Advanced Options command.   When you select this 
command, the Advanced Options dialog box appears.   

The following sections describe the dialog box controls and how to complete   the dialog box.

Defining the Upload and Download Interlocks

Below is a summary of the fields you need to complete to define the   upload and download interlocks.

Download   field —   defines the tagname or tag group symbol that acts as a download interlock   for the 
recipe. When you download a recipe, the Recipe Builder verifies   that the value of the block is zero. 
This means that the interlock is   inactive. If the value of the block is non-zero, the interlock is active   
and the Recipe Builder aborts the download process. 

Upload   field —   defines the tagname or tag group symbol that acts as an upload interlock   for the recipe. 
When you upload a recipe, the Recipe Builder verifies   that the value of the block is zero. This means 
the interlock is inactive.   If the value of the block is non-zero, the interlock is active and the   Recipe 
Builder aborts the upload process.

By default, the F_CV field is assigned to the interlock tagname when   no field name is specified. 
However, you can enter any F_ field for the   tagname (such as F_04 for a Digital Register block).

 To define the upload and download   interlocks for the current recipe: 

 1. On the Options menu,   click Advanced Options. The Advanced Options dialog box appears. 

 2. In the Download field,   enter the tagname or tag group symbol of the block that acts as a download   
interlock for the recipe. In the Upload field, enter the tagname or symbol   of the block that acts as 
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an upload interlock. If you prefer, you can   select the browse (...) button to the right of either field 
and select the tagname   from the dialog box that appears. 

Defining the Completion Status Indicator

When you download or upload a recipe, the Recipe Package can monitor   the recipe's progress and store 
this information in any analog block you   specify. This block acts as a completion status indicator. The 
analog   block you select must have an EGU range from zero to at least four and   must be in Manual mode. 
To ensure future compatibility, it is recommended   that you set the high EGU value to 100. Do not spe-
cify a negative number   for the high or low EGU value. Negative numbers will cause the completion   
status indicator to display inaccurate information. 

To define the completion status indicator, enter the tagname or tag   group symbol of an analog block in 
the Completion Status group box. The   Recipe Builder monitors the recipe's progress when you specify 
the block   to use as the completion status indicator in the Completion Status group   box. 

By default, the F_CV field of the block is assigned to the tagname if   you do not specify a field name. 
However, you can specify any F_ field   for the tagname (such as F_02 for an Analog Register block).

Completing the group box is optional. When you leave it blank, the Recipe   Package does not monitor the 
completion status of an upload or download.   

 To specify the completion status   indicator: 

 1. On the Options menu,   click Advanced Options. The Advanced Options dialog box appears. 

 2. In the Completion   Status group box, enter the tagname of the block that acts as the completion   
status indicator for the recipe, or select the browse (...) button and select the   tagname from the 
dialog box that appears. 

The tagname referenced is written to during   an upload or download. The following table lists the 
possible values for   the completion status indicator. 

When 
the 
value 
is...

The download or   
upload...

And the Recipe Builder   has...

0 Is in progress. Started downloading or uploading the recipe and   has not encountered 
any errors.

1 Aborted. Been unable to read or write the recipe values   to the database. An 
active interlock may have caused this error. 

2 Completed with 
errors.

Attempted to read or write the recipe values to   the database. 
However, a read or write error occurred.

3 Completed with no 
errors. 

Successfully read or written all recipe values   to the database. If any 
recipe items have verification enabled, then the   Recipe Builder has 
also verified these items.

4 Completed with 
verification errors. 
(download   only)

Successfully written all recipe values to the   database and completed 
the verification process. However, one or more   blocks could not be 
verified because the time-out interval expired.

Completion Status Values   
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Using the Completion Status Indicator

Once you define this indicator, you can use it to post messages on an   operator display using Visual 
Basic for Applications. For example, when   downloading a recipe from an operator display you could cre-
ate a button   labeled "Recipe Status." By selecting this button, operators   could monitor the progress of a 
downloaded recipe by examining the value   of the completion status indicator. The script for this button 
would include   the following:

DIM Status As Double
Status = Fix32.FERMENT1.RCPSTAT.F_CV
Select Case Status
Case 0
    MsgBox "In progress"
Case 1
    MsgBox "Aborted. Verify interlock is inactive"
Case 2
MsgBox "Read/write errors occurred. Restart node."
Case 3
    MsgBox "Download/Upload Successful"
Case 4
    MsgBox "Verification errors occurred."
End Select

Selecting a Security Area

For security reasons, you may want to restrict access to the recipes   you create. Once you assign a 
security area to a recipe, it can only be   opened with the Recipe Builder if the logged in user has rights to 
that   security area. For example, if you assign security area A to the sample   recipe, an operator who 
wants to open it must have rights to that security   area.

To select a security area for a recipe, complete the Security Area group   box. This group box defines the 
security area for the recipe. By default,   the security area is set to NONE. 

 To select a security area for the   current recipe: 

 1. On the Options menu,   click Advanced Options. The Advanced Options dialog box appears. 

 2. In the Security Area   group box, enter the appropriate text as indicated below. You can enter   up to 
20 alphanumeric characters into the group box. 

 l To assign the   recipe to every security area, type ALL.   

 l To assign the   recipe to no security area, type NONE.   

 l To assign the   recipe to a specific security area, type the security area name in the   group 
box. 

If you prefer, click the browse (...) button and select   a security area from the dialog box 
that appears. Use the scroll bar or   arrow keys to locate the security area you want. Press 
the OK button to   complete the selection. 

Using an Audit Trail

The Recipe Package can track recipe activity in an audit trail whenever a recipe is uploaded, down-
loaded, or saved. The Recipe Package provides two types of audit trails: a summary audit trail and a 
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detailed audit trail. The summary audit trail tracks recipe activity of the entire recipe, for example, when 
a recipe was saved and why. The detailed audit trail tracks recipe activity on individual recipe items, for 
example, which recipe items were downloaded.

Using the Audit Trail group box, you can select the type of audit you want. By selecting the audit trail 
type, you instruct the Recipe Package to send the recipe information you want tracked as a message to 
any alarm destination configured to receive it. Recipe messages are recorded along with any other mes-
sage the alarm destination is configured to receive. The alarm files that store recipe messages reside in 
the Alarms path and are named yymmdd.ALM.  

To set up an alarm destination to receive recipe messages, select the recipe message alarm areas you 
need from the Application Message Routing dialog box of the SCU. For more information about con-
figuring alarm destinations, assigning alarm areas, or routing alarms, refer to the Implementing Alarms 
and Messages manual.

Below is a summary of the Audit Trail group box. By making a selection from this group box you control 
the type of audit trail the Recipe Builder keeps. Both types of audit trails enable the Recipe Package to 
track the information described below to the available alarm destinations.

Summary Audit Trail option button — tracks the following information:

 l When changes to master or control recipes are saved and the name of the logged in user that 
saved the recipe.   

 l The text entered into the Recipe Mod Log dialog box.   

 l When a recipe is uploaded or downloaded and the name of the logged in user that uploaded or 
downloaded the recipe.   

 l When an upload or download fails and why.   

 l The Recipe Package records this information whenever a recipe is saved, uploaded, or down-
loaded. By default, the Summary Audit Trail radio button is selected.   

Detail Audit Trail option button — tracks all the summary information listed above. In addition, the 
Recipe Package also tracks the following download information:

 l The recipe item values that were downloaded.   

 l The variables that were present in the recipe.   

 l The recipe items that failed to download, if any, and why.   

No Audit Trail option button — disables the audit trail for the open recipe.

Using the Recipe Builder, you can enable or disable the audit trail for the open recipe.
 To enable or disable the audit trail for the open recipe: 

 1. On the Options menu, click Advanced Options. The Advanced Options dialog box appears.   

 2. Select either the Summary Audit Trail radio button or the Detail Audit Trail radio button to select 
the type of audit trail you want. To disable the audit trail, select the No Audit Trail radio button.   

The format of a summary message appears below.  

date time activity recipe_filename tag_group_name batch_id description by node::user remarks

The following table describes each field in the message.    
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The 
field...

Contains ...

date The date when a recipe was uploaded, downloaded, or saved. This field is 
included if the SCU is set up to include the date in recipe messages. Refer to the 
section Setting up the Alarm and Message Format in the Implementing Alarms 
and Messages manual for information on setting the format of these messages.

time The time when a recipe was uploaded, downloaded, or saved. This field is 
included if the SCU is set up to include the time in recipe messages. Refer to the 
section Setting up the Alarm and Message Format in the Implementing Alarms 
and Messages manual for information on setting the format of these messages.

activity One of the following descriptions:

 l SAV (when saving a recipe)

 l DWN (when downloading a recipe)

 l UPL (when uploading a recipe)
recipe_file-
name

The name of the recipe file that was uploaded, downloaded, or saved.

tag_
group_
name

The file name of the tag group assigned to the recipe. This field is blank if no tag 
group is assigned to the recipe.

batch_id One of the following:

 l FILE SAVED OK (if the recipe has been saved successfully) or FILE NOT 
SAVED (if the save failed).

 l The batch id the operator specifies when downloading a recipe. The batch 
id is included only when downloading a recipe and is used to identify the 
download.  

 l A blank field, when uploading a recipe.
descriptionOne of the following descriptions:

 l The text specified in the Mod Log field (when saving a recipe).

 l COMP (x ERR) (when a recipe uploads or downloads with x errors).

 l ABRT (reason) (when an upload or download fails. The text reason 
describes why the upload or download failed).

node The name of the node the operator is using.
user The name of the logged in user. If security is disabled, this field is left blank.
remarks One of the following descriptions:

 l The reason the save failed. (The text reason describes why the save 
failed).

 l The text specified by the operator when downloading a recipe. The text is 
included only when downloading a recipe. If you try to re-verify a recipe, 
the following text appears in this field:

Verification retried

 l A blank field, when uploading a recipe.

Summary Message Format    
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Examples: Using a Summary Audit Trail

Examples of summary messages appear below:

1/1/98 11:05:12.2 SAV BEER.RCM FERMENT1.TGE FILE SAVED OK CHANGED TEMP FORMULA FERMENT1::JOHN
1/1/98 11:06:23.4 DWN BEER.RCC FERMENT2.TGE LOT033093     COMP(NO ERRORS)        FERMENT2::MARY 3rd download
1/1/98 11:08:45.3 UPL BEER.RCC FERMENT3.TGE               ABRT(INTERLOCK ACTIVE) FERMENT3::JOE

The format of a detailed message follows.  

date time batch_id item_number identifier description value uom result

The following table describes each field. Detailed messages are sent while downloading a recipe.    

The 
field...

Contains...

date The date when a recipe downloaded. This field is included if the SCU is set up to 
include the date in recipe messages. Refer to the section Setting up the Alarm 
and Message Format  in the Implementing Alarms and Messages manual for 
information on setting the format of these messages.

time The time when a recipe downloaded. This field is included if the SCU is set up to 
include the time in recipe messages. Refer to the section Setting up the Alarm 
and Message Format  in the Implementing Alarms and Messages manual for 
information on setting the format of these messages.

batch_id The batch id the operator specifies when downloading a recipe. The batch id is 
included only when downloading a recipe and is used to identify the download of 
the recipe.  

item_num-
ber

The item number of the recipe item.

identifier The tagname or variable name of the item.
descriptionA description of the recipe item or variable. This description matches the text that 

appears in the Description cell for the downloaded item.
value The downloaded value of the recipe item or variable.
uom The unit of measure of the recipe item or variable.  
result One of the following:

 l OK (when the recipe item successfully downloads)

 l BAD reason (when the recipe item cannot be downloaded)

 l NOT DOWNLOADED (when variable is included in the recipe)

Detailed Message Format    
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Recipe Security

If you plan on using recipes with iFIX, you may find it useful to restrict   access to one or more aspects of 
the Recipe Package. iFIX security enables   you to restrict access to the following items:

 l Recipe Builder application   features. 

 l Individual recipes.   

 l Database blocks you   can download to. 

For more information about securing Recipe Builder application features,   refer to the Configuring Secur-
ity Features   manual.

You can protect a recipe by assigning a security area to it. For more   information about assigning a secur-
ity area to a recipe, refer to section   Selecting a Security Area.   Also make sure that each operator has 
rights to the security areas he   or she needs. Without these rights, an operator cannot open a recipe once   
you assign a security area to it. 

iFIX protects against writing to individual blocks by comparing the   security areas assigned to a block 
with those assigned to the logged in   user. Since recipes can be scheduled to download when no one is 
logged   in, a special user account called RECIPE is used. When the Recipe Package   attempts to write a 
value, the security system examines the rights assigned   to the Recipe user account instead of those 
assigned to the currently   logged in user. If the security area of the target block matches one security   
area defined in the Recipe user account, the recipe value downloads. Otherwise,   the value is not written 
to the database.

NOTE: An unsigned write   occurs when a database tag is configured for electronic signature, but   you write a 
value directly to that tag during a recipe download without   capturing a signature. If you are working in a 
secure environment with   the Electronic Signature option enabled, you must be aware of the impact   of 
unsigned writes to the process database. Unsigned writes can originate   from recipe downloads. Refer to the 
Implications  of Database Writes With Electronic Signature section of the Using   Electronic Signatures manual 
for detailed information.

The security system also allows recipes to be uploaded regardless of   who, if anyone, is logged in cur-
rently. Be aware that using "RECIPE" as a domain user account is not supported in the iFIX product. If 
you do attempt to use RECIPE as a domain user name, you will be able to download a recipe on a 
SCADA node, but not on a View node.

For more information on creating a Recipe user account, refer to the   section Creating  a Recipe User 
Account in the Configuring Security Features manual.

IMPORTANT: iFIX security    loads the Recipe user account into memory the first time a recipe is downloaded 
from a node. If you   modify this account, the node continues to use the account in memory.   To force the node 
to re-read the new version of the Recipe user account,   log out the current user, log in with the Recipe user 
account, and then   log out again. Once you log out of the Recipe user account, the current   user can log in 
again. Alternatively, you can force the node to re-read   the Recipe user account by shutting down and restart-
ing iFIX.
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Command Line Parameters 

The Recipe Package consists of the following programs:

 l The Recipe Builder   

 l The Recipe Download   system task 

 l The Recipe Upload   system task 

Each of these programs allows you to specify command line parameters   that allow you to start each pro-
gram with preset values. 

You can specify command line parameters in the Task Configuration dialog   box of the SCU. This dialog 
box enables you to configure which programs   iFIX automatically starts. Refer to the Setting up the Envir-
onment manual for more information on this dialog box. 

You can also specify command line parameters using the Program block's   RUNTASK command in the 
iFIX Database Manager, using the Shell   function in a Visual Basic for Applications (VBA) script. 

When using command line parameters with the Program block or in the   Command Language Editor, use 
the following general syntax:

RUNTASK app_nameparameter

For example, to download a control recipe, use this command:

RUNTASK RCPDOWN /ccontrol_recipe

When using VBA, use scripts similar to the following:

Private Sub FixEvent1_OnTrue()
Dim download As String
Dim return_value As Double
 
download = System.ProjectPath + "\RCPDOWN" + " /cRCPFILE /e"
return_value = Shell (download, 0)
End Sub

To create an upload script, define a variable called upload in place   of the download variable and sub-
stitute the reference to RCPDOWN with   RCPUP as follows:

upload = System.ProjectPath + "\RCPUP" + "/cRCPFILE /e"

Using Multiple Parameters in VBA

When using multiple command line parameters in VBA, separate each parameter   with a space. For 
example, to specify the Error File parameters to the   Recipe Download system task for a control recipe, 
use the following command   line:

download = System.ProjectPath + "\RCPDOWN" + " /cBeer /e"

Under Windows, you can also specify a command line parameter using the   operating system's Run 
command. To learn how to use this command, refer   to your Windows documentation.

If you mistype the command line for the Recipe Download and Recipe Upload   system tasks, the pro-
grams abort. On the other hand, if the command line   for the Recipe Builder contains errors, a blank, 
untitled recipe opens.
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The remainder of the chapter describes each command line parameter.   Refer to these sections for more 
information.

Batch Size Parameter

 

Syntax

/bbatch_size

Recognized by

The Recipe Download program.

Description

The Batch Size parameter allows you to specify the batch size for a master recipe. The Recipe Down-
load program uses the value specified with the parameter to calculate the values that it downloads in 
place of the batch size stored in the recipe.  

This parameter can only be used with master and master text recipes and cannot be used in a recipe that 
contains override values.

Control Recipe Parameter

 

Syntax

/ccontrol_recipe

Recognized by

All recipe programs.

Description

The Control Recipe parameter allows you to specify the name of the control recipe you want to use with 
a recipe program. The exact function of the parameter depends on the recipe program.      

When specified to 
the...

The program...

Recipe Builder Automatically opens the specified control recipe and displays it in the 
spreadsheet.  

Recipe Download pro-
gram

Downloads the specified control recipe to the database.

Recipe Upload pro-
gram

Uploads the specified control recipe from the database.
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Error File Parameter

 

Syntax

/e 

Recognized by

The Recipe Download and Recipe Upload programs.

Description

The Error File parameter enables the Recipe Download or Recipe Upload programs to record in an error 
file the tagname of any recipe item that does not upload or download. The error file is a text file and by 
convention is named recipe.RCE. The error file for master recipes resides in the Master Recipe path. 
The error file for control recipes resides in the Control Recipe path.  

It is strongly recommended to use this parameter whenever you upload or download a recipe.

NOTE: Each upload or download of a recipe overwrites the error file when the Error File parameter is used.

Command Line File Parameter

 

Syntax

/ffilename 

Recognized by

All recipe programs.

Description

The Command Line File parameter enables you to specify a list of command line parameters in a text file 
called a command line parameter file. The parameters included in the file are treated as if you entered 
them on the command line. This allows you to enter very long command lines.

You can create parameter files using a text editor. The name of the parameter file can be any valid 8.3 
file name; however, the Recipe Package assumes the parameter file you specify resides in the Local 
path. If the file resides in a different path, you must include the complete path along with the file name. 
The following examples illustrate this.
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Examples: Command Line File Parameter
RCPDOWN /fBEER.TXT

RCPUP /fC:\BEER.TXT

Notice in the first example, the Recipe Download system task reads the file BEER.TXT from the Local 
path for its command line parameters. In the second example, the Recipe Upload task reads the same 
file from the root directory.

The Command Line File parameter cannot be used with any other parameters. Similarly, you cannot 
include the Command Line File parameter in the file specified. 

Consider the following examples:

RCP.EXE /fBEER.TXT /cBeer
RCP.EXE /cBeer /fBEER.TXT

Both of these examples cause an error message box to appear. If the Recipe Upload or Recipe Down-
load system tasks had been used instead, the error would appear in the audit trail as an aborted upload 
or download.

Tag Group Parameter

 

Syntax

/gtag_group_filename 

Recognized by

The Recipe Download and Recipe Upload programs.

Description

The Tag Group parameter enables you to temporarily change the tag group assignment of a master 
recipe. When specified, the Recipe Download or Recipe Upload programs use the set of tags from the 
specified file instead of the tag group assigned to the recipe.

This parameter can only be used with master and master text recipes.

Batch ID Parameter

 

Syntax

/ibatch_id

Recognized by

The Recipe Download program.
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Description

The Batch ID parameter allows you to specify the batch ID to include in a recipe message when the 
audit trail is enabled. A batch ID can be up to 10 alphanumeric characters and is recorded in the recipe 
message when you download a recipe.

Master Recipe Parameter

 

Syntax

/mmaster_recipe 

Recognized by

All recipe programs.

Description

The Master Recipe parameter allows you to specify the master recipe you want to use with a recipe pro-
gram. The exact function of the parameter depends on the recipe program.      

When 
specified 
to the...

The program...

Recipe 
Builder

Automatically opens the specified master recipe. If the Recipe Builder auto-
matically starts up with the Recipe Operations window, the parameter is ignored. 
Instead, the Recipe Builder opens a blank, untitled recipe.

NOTE: If the Recipe Builder is already running, this parameter is ignored.
Recipe 
Download 
program

Downloads the specified master recipe to the database.

Recipe 
Upload 
program

Uploads the specified master recipe from the database.

Download Remarks Parameter

 

Syntax

/rremarks

Recognized by

The Recipe Download program.
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Description

The Download Remarks parameter enables you to include download remarks in a recipe message when 
the audit trail is enabled. The remarks you include can be up to 30 alphanumeric characters and are 
included in a recipe message when the recipe downloads.  

Master Text Recipe Parameter

 

Syntax

/xmaster_text_filename 

Recognized by

The Recipe Builder and Recipe Download program.

Description

The Master Text Recipe parameter allows you to specify the master text recipe you want to use with a 
recipe program. The exact function of the parameter depends on the recipe program.    

When 
specified 
to the...

The program...

Recipe 
Builder

Automatically opens the specified master text recipe and displays it in the spread-
sheet. If the program automatically starts up in the Recipe Operations window, this 
parameter is ignored. Instead, the Recipe Builder opens a blank, untitled recipe.

Recipe 
Download 
program

Downloads the specified master text recipe to the database.

Control Text Recipe Parameter

 

Syntax

/ycontrol_text_filename 

Recognized by

The Recipe Builder and Recipe Download program.
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Description

The Control Text Recipe parameter allows you to specify the control text recipe you want to use with a 
recipe program. The exact function of the parameter depends on the recipe program.    

When specified to 
the...

The program...

Recipe Builder Automatically opens the specified control text recipe and displays it in 
the spreadsheet.  

Recipe Download pro-
gram

Downloads the specified control text recipe to the database.

Override Parameters

 

Syntax

variable = value

Recognized by

The Recipe Download program.

Description

An override parameter enables you to temporarily override a variable's formula. While the Recipe Down-
load program does not limit you to the number of override parameters you can include, the command line 
can only be 128 characters. To use a command line longer than 128 characters, specify the override 
parameters in a text file and download these values with the Command Line File parameter.

Example: Override Parameters

To override the value of the variable #TEMP from 50 to 65 use the following text in the command line:

#TEMP=65

Command Line Parameter Summary

To help you keep track of which parameter can be used with which recipe   programs, use the following 
table: 

Command Line Parameter Recipe Builder Recipe Download Recipe Upload
Batch Size   Parameter  x  
Control   Recipe Parameter x x x
Error File   Parameter  x x

Recipe Command Line Parameters    
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Command   Line File Parameter x x x
Tag Group Parameter  x x
Batch ID Parameter  x  
Master Recipe   Parameter x x x
Download   Remarks Parameter  x  
Master   Text Recipe Parameter x x  
Control   Text Recipe Parameter x x  
Override Parameter  x  
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Text Recipe Format 

Using the Save As command, you can save master and control recipes as   master text and control text 
recipes. The difference between these file   formats is that master and control recipes are binary files. 
Master text   and control text recipes are text files that can be edited with a text   editor. To use the Save 
As command, refer to the section Using   the Save As Command.

File Format

Master text and control text recipes share the same format and have   the following general format:

 l File   header

 l Recipe   header template

 l Recipe   header

 l Recipe   item template

 l List   of recipe items

The following sections describe each portion of the recipe.

File Header

The first line of each master text or control text recipe is a file header. This header includes the date and 
time the recipe was created, node and logged in user that created the recipe, and the binary recipe that 
the text recipe was created from.

The general format of this line is shown below:

;CREATED FROM: recipe VERSION: xxxx DATE mm/dd/yy TIME: hh:mm:ss BY node::user

Recipe Header Template

Immediately following the file header is a template of the recipe header.   This template is provided as a 
guide in case you plan on editing the recipe.

The format of the header template is shown below:

;HEADER TEMPLATE:
;Recipe Type
;Units
;Product
;Standard Batch Size
;Batch UOM
;Security Area
;Completion Status
;Download Interlock
;Upload Interlock
;Audit Trail Support
;Tag Group
;Batch Size
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Recipe Header

Following the recipe header template is the recipe header section. This section begins with the following 
line:

[header]

Information from the Recipe header fields and certain dialog boxes immediately follows this line. These 
fields appear in the same order as the recipe header template shown above. Each field is on its own line 
and ends with a comma. If the field is blank, the line in the recipe contains only the comma.  

Example: Reader Header
MASTER,
FERMENTER1,
BEER,
100,
BLS,
NONE,
,
FERMENT1:ILK1.F_CV
,
Summary Audit Trail,
BEER1.TGE,
50

If you edit a text recipe, you can omit any information you want but the commas must be included, as 
shown in the above example.  

Recipe Item Template

Immediately following the recipe header section is a recipe item template. Like the recipe header tem-
plate, the recipe item template is provided as a guide in case you plan on editing the recipe.

The format of the header template is shown below:

;ITEM TEMPLATE:
;Identifier
;Formula
;Calculated Value
;Override Value
;Description
;UOM
;Override Low Limit
;Override High Limit
;Verify

List of Recipe Items
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Following the recipe item template is the list of recipe items. This list consists of one section for each 
recipe item and variable in the recipe. Each recipe item section starts with the following line:

[item #]

where # is row number of the item in the spreadsheet. Immediately following this line is the recipe item or 
recipe variable information. The order of this information matches the recipe item template shown above. 
Each field is on its own line and ends with a comma. If the field is blank, the line in the recipe contains 
only the comma.  
Example: Recipe Item List

[ITEM 1]
FERMENT1:T16F1.F_CV,
55,
55.0,
,
Fermenter set point,
degF,
RESTRICTED,
RESTRICTED,
OFF

[ITEM 2]
#Yeast,
#Lbs_Per_Barrel*#STD_BATCH
150.0
,
,
,
RESTRICTED,
RESTRICTED,
OFF

If you edit the text recipe, you can omit any information you want but the commas must be included.

Editing a Text Recipe

If you plan to edit a master text or control text recipe, you can open it with a third-party text editor. The 
file must conform to the format described in the previous sections of this chapter, otherwise the Recipe 
Builder cannot open it after you finish editing the file.

To modify a master or control text recipe, use the following guidelines:

 l Each line in the file can be up to 256 characters. The Recipe Builder ignores any extra characters 
beyond that limit.   

 l Specific characters have a special meaning when used in a master text or control text recipe. The 
following table lists these characters.    

The char-
acter ...

Allows you to...

, (comma) Delimit a field.
; (semi- Start a comment. The Recipe Builder ignores all characters following the 

Guidelines for Editing a Text Recipe

84 © 2020 General Electric Company. All rights reserved.



colon) semicolon to the end of the line. Comments can appear anywhere in the 
text file.

\ (back 
slash)

Cancel the meaning of a special character. For example, the Recipe 
Builder treats the following text as a comma:

\,

For example, to have the value 9,999 appear in the Standard Batch Size 
field, enter the following in the text file:

9\,999
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Recipe Files  

The following table lists the types of files available in the Recipe Package, the extension for each file 
type and the path each file resides in.    

File Type Extension Path
Control 
recipe

RCC Control Recipe path

Control text 
recipe

RCY Control Recipe path

Display 
format files

RFT Local path

Error file RCE Master Recipe path (when working with a master recipe) or Control 
Recipe path (when working with a control recipe)

Master 
recipe

RCM Master Recipe path

Master text 
recipe

RCX Master Recipe path

Note file RCN Control Recipe path
Recipe 
report

RCR Master Recipe path (when working with a master recipe) or Control 
Recipe path (when working with a control recipe)
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Troubleshooting 

The following table lists the messages that the Recipe Builder displays.   Along with the message, the 
response to the error or the message's meaning   is included. When user action is required, be sure to 
select the OK button   on the message box to acknowledge you have read the message before taking   the 
recommended action. 

Message Meaning and Action

Are you sure you 
want to clear all 
overrides?

The Recipe Builder is about to delete all the values   in the Override Value column of 
the recipe. Select the Yes button to delete   these values or the No button to abort the 
procedure.

Are you sure you 
want to delete 
recipe recipe_
name?

The Recipe Builder is about to delete the recipe recipe_name   and all the files asso-
ciated with it. Select the Delete button to delete   these files or select the Cancel but-
ton to abort the procedure.

Bad arccosine 
expression (oper-
and < -1 or >   1?)

The Recipe Builder is attempting to calculate the   arccosine of a number that is 
greater than one and less than negative   one. Retype the formula using a value that 
is between 1 and -1.

Bad arcsine 
expression (oper-
and < -1 or > 1?)

The Recipe Builder is attempting to calculate the   arcsine of a number that is greater 
than one and less than negative one.   Retype the formula using a value that is 
between 1 and -1.

Bad audit trail 
support option

You opened a text recipe with an invalid entry in   the audit trail field. Valid entries are: 
No   Audit Trail, Summary   Audit Trail, and Detailed   Audit Trail. Modify the text recipe 
using the guidelines in the   section Editing a Text Recipe.

Bad base-10 log 
expression (oper-
and <=0?)

The Recipe Builder is attempting to calculate the   base 10 log of a number that is 
less than one. Retype the formula using   a value that is greater than or equal to one.

Bad division 
expression 
(divide by zero?)

The Recipe Builder is attempting to divide two numbers.   However, the divisor is 
invalid and may equal zero. Retype the formula   using a value for the divisor that is 
non-zero. 

Bad natural log 
expression (oper-
and <= 0?)

The Recipe Builder is attempting to calculate the   natural log of a number that is less 
than or equal to zero. Retype the   formula using a value that is greater than zero.

Bad square root 
express (operand 
< 0?)

The Recipe Builder is attempting to calculate the   square root of a negative number. 
Retype the formula using a value greater   than or equal to zero.

Can't delete 
Recipe file file-
name.   Do you 
want to continue 
deleting the files 
for this recipe?

The Recipe Builder cannot delete the recipe file,   filename.   The file may have one or 
more attributes set to prevent deletion or may   be in use (for example, from a file 
server). Select the Yes button to   continue deleting recipe files or select the No but-
ton to stop deleting   files.

Can't open dis-
play format file

While starting, the Recipe Builder could not locate   its display format file, 
DEFAULT.RFT. The file may not exist or may have   been renamed. To create the 
file, customize the display format as needed   and save it in the Local path.

Recipe   Builder Messages 
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Cannot display 
the Security 
Areas list

The Recipe Builder is unable to display the list of   available security areas. Consult 
your system administrator before proceeding,   or contact GE Support.

Cannot fetch data 
due to bad 
node:tag.field

The Recipe Builder cannot upload from the database   because it cannot read from 
the requested tagname. The block in memory   may be corrupt or there may be a com-
munications problem. Try reloading   the database and, if the block resides on a 
remote node, make sure network   communications are functioning properly.

Cannot open a 
non-recipe file

The Recipe Builder cannot open the specified file   because it is not a recipe or does 
not have a recognizable extension.   For a list of recipe extensions, refer to the 
chapter Recipe   Files.

Cannot open clip-
board

The Recipe Builder is unable to locate or use the   system clipboard file. The file may 
have been renamed or is corrupt. 

Cannot read data 
from database

The Recipe Builder cannot upload data from the database.   There may be a com-
munications problem or the database in memory may be   corrupt. Try reloading the 
database and, if the block resides on a remote   node, make sure network com-
munications are functioning properly.

Cannot read from 
clipboard

The Recipe Builder is unable to paste data from the   system clipboard. Try copying a 
single row to the clipboard and pasting   it back into the recipe. 

Cannot save a 
backup recipe file

You attempted to save a master backup or a control   backup recipe. Select a dif-
ferent recipe type and try saving the recipe   again.

Cannot save a 
non-recipe file

The extension you specified does not have a recognizable   extension. For a list of 
recipe extensions, refer to the chapter Recipe   Files.

Cannot save an 
untitled recipe file

You attempted to save a new recipe from the Recipe   Operations window. Switch to 
the Recipe Development window and try saving   the recipe again.

Cannot set batch 
size (reason)

You entered a batch size in the Set Batch Size dialog   box that:

 l Is greater than   9,999,999.0,

 l Is less than   0.0000001,

 l Contains a negative   number, or

 l Contains non-numeric   data.

 l Retype the batch   size you want and try again.

Cannot set tag 
group (Cannot 
delete tag group 
assignment   while 
substitutions are 
on)

You attempted to delete or re-assign a tag group while   the Recipe Builder is sub-
stituting tagnames for symbol names. Click the   Cancel button on the Assign Tag 
Group dialog box and then select Show   Symbols from the Window menu. Once this 
command is selected, you can delete   or re-assign the tag group assignment.

Cannot set the 
interlock   (Only F_ 
fields are 
allowed)

You entered a field type for the upload or download   interlock that the Recipe Builder 
does not allow. Use only F_ fields for   interlock tagnames.

Cannot write to 
clipboard.

The Recipe Builder is unable to copy or cut any data   to the system clipboard. Try 
copying a single row to the clipboard and   pasting it back into the recipe.

Changing the for-
mula or override 

You are changing an override limit while an override   value is in effect for the current 
recipe item or variable. Select the   Yes button to clear the override value and change 
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limit will clear   the 
override value. 
Continue?

the override limit or   select the No button to abort the operation.

Circular reference 
detected.

You have a set of formulas that reference each other.   Modify one of these formulas 
so that is contains a numeric or string constant   or references a different variable.

Column is not 
modifiable.

The Recipe Builder was unable to replace any data   in the selected column because 
it is not modifiable. Select a different   column or modify the display format and make 
the selected column modifiable.

Do you want to 
save this recipe?

You selected the Exit command before saving any changes   to the recipe. To save 
your changes and quit the Recipe Builder, select   the Yes button. To quit without sav-
ing any changes, select the No button.   To return to the Recipe Builder without quit-
ting, select the Cancel button.

Editor spawn 
failed

The Recipe Builder was unable to start the text editor   it uses to create and modify 
recipe note files. Close one or more applications   and try again. If the problem per-
sists, restart the computer. 

Error number   
checking this 
item: Field cannot 
be modified

You attempted to enter data into the Calc Val column.   This column displays the 
value of a recipe item's or variable's formula   and cannot be modified directly. 

Error number   
checking this 
item: Only F_ and 
A_ fields are 
allowed

You entered a field type that the Recipe Builder does   not allow. Use only A_ and F_ 
fields for tagnames you add to the recipe.

Error number   
checking this 
item: Recipe is in 
TAGNAME 
MODE

You attempted to add or delete a recipe item or variable   while the Recipe Builder is 
substituting tagnames for symbol names. Select   Show Symbols from the Window 
menu and then add or delete the recipe items   and variables you want.

Error reading dis-
play format file, 
check version

The Recipe Builder attempted to load a display format   file that contains the wrong 
version number or has been corrupted. Recreate   the file by customizing the display 
format and saving it to a file.

Error number   set-
ting this item: 
Bad verify option 
(on or off)

You entered a value in the Verify column that the   Recipe Builder does not recognize. 
Type ON   or OFF   in any cell of this column.

Error number   set-
ting this item: 
Cannot add 
node.tag.field to 
recipe. Has max-
imum number   
been reached?

You attempted to add more than 850 recipe items. Only   850 recipe items can be 
added to one recipe.

The message also appears when you search a recipe   with 850 items because the 
Recipe Builder creates a temporary entry in   the spreadsheet during the search. 
Since all rows are filled, the search   generates the error. To avoid the message, 
remove one of the recipe items.

Error number   set-
ting this item: 
Cannot use a 
keyword for a vari-

You attempted to create a variable with a name that   is reserved for a keyword. Enter 
a different name and try again. For a   list of reserved keywords, refer to the Recipe   
Keywords table.
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able name

Error number   set-
ting this item: 
Identifier is 
already defined in 
the recipe

You attempted to create a variable or a recipe item   with a name that is already in 
use. Enter a different name and try creating   the item again.

Error number   set-
ting this item: 
Improperly 
formed formula

You entered a formula that does not conform to the   syntax that the Recipe Builder 
recognizes. Retype the formula using the   guidelines in the chapter Working   with For-
mulas.

Error number   set-
ting this item: 
Improperly 
formed override 
limit

You entered an override limit that does not conform   to the syntax the Recipe Builder 
recognizes. Refer to the section Entering   Override Limits and retype the override 
limit. 

Error number   set-
ting this item: 
Improperly 
formed override 
value

You entered an override value that does not conform   to the syntax the Recipe 
Builder recognizes. Make sure any string you   enter is enclosed in quotes and retype 
the override value.

NOTE: Formulas,   keyword, and variables cannot be entered into the Override Value 
column.   

Error number   set-
ting this item: No 
calculated value 
to base override 
limit on

You entered a relative percentage or a relative difference   override limit for a recipe 
item or variable. However, the Recipe Builder   cannot calculate the range of accept-
able values for this column because   the formula of the current recipe item or variable 
is empty or invalid.   Complete or correct the item's formula and then enter an over-
ride limit.

Error number   set-
ting this item: 
Override value 
cannot be mod-
ified

You attempted to enter an override value when both   override limits are set to 
RESTRICTED.   To change the value of the recipe item, either change an override 
limit   and then enter an override value or change the item's formula. 

Error number   set-
ting this item: 
Override value is 
above the over-
ride high limit

You entered an override value that is greater than   the override high limit allows. 
Enter a lower override value to try again.

Error number   set-
ting this item: 
Override value is 
below the over-
ride low limit

You entered an override value that is less than the   override low limit allows. Enter a 
higher override value to try again.

Error number   set-
ting this item: 
Variable name 
must start with # 
and contain only 
alphanumeric   and 
underscore char-

You entered a mark of punctuation for a variable name   that the Recipe Builder does 
not recognize. Retype the variable name starting   it with a number sign (#) followed 
by no more than 14 alphanumeric or   underscore (_) characters.
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acters

Error number   set-
ting this item: 
Variable name 
too long

You entered a variable name that is over 15 characters,   including the number sign 
(#). Shorten and retype the variable name.

Error while read-
ing tag group file

The tag group file assigned to the recipe is unreadable.   Select a different tag group 
or recreate the tag group you want to use.   To create a tag group, refer to the chapter 
Using   the Tag Group Editor.

Expression is too 
deeply nested

You have a set of formulas that reference variables   chained over 14 rows. Modify 
the formulas so that they reference few variables.

Invalid entry. 
Please enter the 
name of an item 
in   the list box.

You selected a control recipe from the Open Control   Recipe dialog box that does not 
exist or could not be found. Either copy   the control recipe into the Control Recipe 
path or select a recipe from   the list box.

Invalid item num-
ber

You entered a negative number or nonnumeric data in   the Go To dialog box. Retype 
the row number you want to jump to and try   again.

Keyword is not 
defined in recipe

The keyword in the formula does not have a value.   Refer to the section Under-
standing   Recipe Keywords to learn how to set the value of each keyword.

Mismatched data-
type

Either you entered a string constant into the formula   or override value column when 
the associated tagname references an F_   field or you attempted to set an absolute, 
percentage, or difference override   limit for a string constant. To correct this, enter a 
formula or override   value that evaluates to a numeric value and then enter the over-
ride limit.

No column selec-
ted

You selected a button on the Search and Replace dialog   box without first selecting a 
column. Select the column you want to search   and then click a button on the dialog 
box to search for or replace data   in the recipe.

No formula to 
evaluate

You have a formula that references a variable with   no value. Modify the formula of 
the appropriate variable so that the Recipe   Builder can calculate it.

No item selected 
in error list

You selected the Go To Item button from an error list   dialog box without first select-
ing an item in the list box. Select an   error in the dialog box and then click the Go To 
Item button.

No tag group 
assignment or tag 
group file does 
not   exist

You selected the Show Tagnames command before creating   or assigning a tag 
group to the recipe. To create the tag group, refer   to the chapter Using the   Tag 
Group Editor. To assign the tag group, select Assign Tag Group   from the Options 
menu and enter the name of the tag group in the dialog   box that appears.

No value entered 
for override limit

You selected an absolute, a percentage, or a difference   override limit from the Over-
ride dialog box without entering a value for   the type of limit you selected. Complete 
the field associated with the   type of limit you selected and try again.

Note file [file-
name]   not found. 
Create it?

The Recipe Builder could not locate the note file   for the current recipe. Select the 
Yes button to create the file and start   Notepad. Select the No button to return to the 
recipe.

Out of range You entered standard batch size that:

 l Is greater than   9,999,999.0,

 l Is less than   0.0000001,

 l Contains a negative   number, or
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 l Contains nonnumeric   data.

Retype the standard batch size you want and try again.

Paste error for 
`tagname':   text   
Keep this item, 
discard it or undo 
the paste?

You are pasting a recipe item or variable into the   recipe that may already exist, does 
not have a valid formula, or contains   text in the Verify column other than YES   or NO.   
Select the Keep Item button to retain the valid parts of the recipe item   being pasted 
or select the Discard Item button to prevent the entire recipe   item from being pasted 
into the recipe. To cancel the entire operation,   select the Undo Paste button.

Precheck did not 
complete 
(reason)

The Recipe Builder could not complete its examination   for errors during an upload or 
download. Restart your computer and try   again.

RCP.INI con-
tains a bad veri-
fication time-out 
value;   using 
default

The Recipe Builder's startup file, RCP.INI, contains   a verification time-out value 
that:

 l Is greater than   65535,

 l Is less than   1,

 l Contains a negative   number, or

 l Contains non-numeric   data.

Because the time-out value is invalid, the Recipe   Builder uses its default value of 30 
seconds. To change the time-out value,   edit RCP.INI using the instructions in the 
section Changing   the Verification Time-out Interval.

Recalculation 
failed at Item 
#row_number.   
Error number:   
text

The Recipe Builder cannot calculate the value of the   formula in row row_number.   
Examine this formula and make sure it conforms to formula syntax. For   more inform-
ation about formulas, refer to the chapter Working   with Formulas.

Recipe has no 
items

You attempted to upload or download while the spreadsheet   was empty. Either open 
a recipe or enter the tagnames you want to upload   from or download to.

Replace text? The Recipe Builder is about to replace the specified   search string with the specified 
replacement string. Select the Yes button   to replace each occurrence of the search 
string in the selected cell.   Select the All button to replace each occurrence of the 
search string   in the selected column. Select the No button to stop replacing data. 

Row is beyond 
end of recipe

You entered a row number in the Go To dialog box that   was greater than the last row 
in the spreadsheet. Retype the row number   you want to jump to and try again.

Search string 
was found x   
times. Replace 
each one?

The Recipe Builder is about to replace the specified   search string with the specified 
replacement string. However, it located   multiple occurrences of the search string. 
Select the Yes button to replace   each occurrence of the search string in the selec-
ted cell. Select the   All button to replace each occurrence of the search string in the 
selected   column. Select the No button to stop replacing data. 

Tag group file 
does not exist

The Recipe Builder cannot locate the specified tag   group file. Either the tag group 
does not exist or does not reside in   the Picture path. Try copying the file to this path 
or create it with   the Tag Group Editor.

Tagname does 
not exist. 
Continue?

The Recipe Builder cannot locate the tagname you want   to add to the recipe in the 
specified database. Select the No button to   abort the operation or select the Yes but-
ton to add the tagname. If you   add the tagname, make sure you add the block to the 
database or you will   be unable to download or upload the recipe.
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Text not found The Recipe Builder could not find the specified search   string in the selected column.

The column width 
must be between 
1 and 100.

You entered a report column width that:

 l Is greater than   100,

 l Is less than   1,

 l Contains a negative   number, or

 l Contains nonnumeric   data.

Retype the column width you want and try again.

The editor is 
already running

You selected the Notes command while the text editor   used to create and modify 
recipe note files was already in use. Select   the OK button on the message box; the 
Recipe Builder automatically switches   you back to the text editor. Modify your 
recipe note files as needed.   To quit the text editor and return to the Recipe Builder, 
select the Exit   command from the File menu.

There are recipe 
items with 
OVERRIDE 
VALUES.

You are attempting to scale the batch size while one   or more override values are in 
use. Select the Continue button to proceed   or select the Cancel button to abort the 
operation. To clear all overrides   and scale the batch size, select the Clear All button.

This change will 
destroy this 
recipe item. 
Continue?

You are deleting the current recipe identifier. This   results in the deletion of the entire 
recipe item or variable. Select   the Yes button to delete the recipe item or variable. 
Select the No button   to abort the operation.

This column can't 
be modified. 
Check the dis-
play format.

You attempted to enter data into a column that is   non-modifiable. To make the 
column modifiable, refer to the section Modifying a Column. After making   the 
column modifiable, try entering data into the column again.

Unauthorized 
access attemp-
ted

You attempted to start the Recipe Builder without   the security rights to the Recipe 
Development or the Recipe Operations   windows. Consult your system admin-
istrator before proceeding.

Using internal dis-
play format

The Recipe Builder is using the default display format   because it could not find the 
file DEFAULT.RFT. To load this file on startup,   make sure the file resides in the 
Local path and restart the Recipe Builder.

Variable is not 
defined in recipe

You entered a variable name in the formula column   that is not in the Identifier 
column. Create the variable by entering   its name in a blank cell of the Identifier 
column.

You can only 
switch to the 
Operations win-
dow with   a 
CONTROL 
recipe

You attempted to display the Recipe Operations window   with an untitled recipe, a 
master recipe, a master text recipe, or a backup   recipe open in the spreadsheet. 
Either open a control recipe or save the   current recipe as a control recipe before 
switching to the Recipe Operations   window.

You can open 
only Control 
Recipes in the 
Operations   win-
dow

You specified a command line parameter to open a master   recipe or a master text 
recipe when the Recipe Builder starts. However,   the Recipe Builder is set up to 
automatically display the Recipe Operations   window. To display the specified 
recipe, select the OK button to open   the Recipe Operations window and switch to 
the Recipe Development window   and open the recipe. To set up the Recipe Builder 
to automatically display   the Recipe Development window, switch to the Devel-
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opment window and select   the Start in DEV Window from the Window menu.

You do not have 
Security Priv-
ileges to run 
RECIPE   
DEVELOPMENT 
feature

The Recipe Builder attempted to display the Recipe   Development window. 
However, your user account does not contain the necessary   privileges to display 
this window. Consult your system administrator before   proceeding.

You do not have 
Security Priv-
ileges to run 
RECIPE   
DOWNLOAD fea-
ture

You attempted to download a recipe without the necessary   security rights to do so. 
Consult your system administrator before proceeding.

You do not have 
Security Priv-
ileges to run 
RECIPE   
OPERATIONS 
feature

The Recipe Builder attempted to display the Recipe   Operations window. However, 
your user account does not contain the necessary   privileges to display this window. 
Consult your system administrator before   proceeding.

You do not have 
Security Priv-
ileges to run 
RECIPE   SAVE 
feature

You attempted to save a recipe without the necessary   security rights to do so. Con-
sult your system administrator before proceeding.

You do not have 
Security Priv-
ileges to run 
RECIPE   TEXT 
OUTPUT feature

You attempted to create a report or save a master   text or control text recipe without 
the necessary security rights to do   so. Consult your system administrator before 
proceeding.

You do not have 
Security Priv-
ileges to run 
RECIPE   
UPLOAD feature

You attempted to upload a recipe without the necessary   security rights to do so. 
Consult your system administrator before proceeding.

You do not have 
Security Priv-
ileges to run this 
RECIPE   feature

The Recipe Builder cannot complete the operation you   selected because you do not 
have the necessary application feature in   your user account. Consult your system 
administrator before proceeding.

You must have at 
least one column 
displayed

You attempted to remove all the columns from the display   format or from a report. 
The Recipe Builder requires at least one column   for display formats and reports.

Your untitled 
recipe report will 
be saved to 
"untitled.rcr".   
Continue?

You are creating a report for an untitled recipe.   To save the report with the name 
UNTITLED, select the Yes button. To abort   the process select the No or Cancel but-
tons. 

NOTE: If you subsequently   name the recipe, the Recipe Builder will not be able to 
locate the report   you created. To enable the Recipe Builder to locate the report, cre-
ate   a new report or rename the existing one so that the recipe name and the   report 
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name match.

Understanding Audit Trail and Error File Messages

Whenever you upload or download a recipe from the Recipe Builder, the program examines the recipe to 
see if it is complete and can be uploaded or downloaded. If the recipe is complete, the Recipe Builder 
examines the recipe for errors, as described in the chapter Downloading and Uploading Recipes.

If the recipe is not complete, it displays an error message box with one of the following lines of text: 

Download of recipe recipe aborted text
Upload of recipe recipe aborted text

where text is the reason that the upload or download aborted. These messages also appear in the error 
file when uploading or downloading a recipe with a Program block or a VBA script.  

Text in the Audit Trail

The reason for aborting the upload or download also appears in each recipe message saved in the audit 
trail, if the audit trail is enabled for uploaded or downloaded recipe. For more information about the audit 
trail, refer to the section Using an Audit Trail.

The following table lists the reasons for the aborted upload or download and the response to the error.      

Message Action
bad completion status flag The analog block defined as the completion status indicator is 

undefined or cannot be read from or written to. Make sure the 
block exists in the database and that the block is in a mode that 
allows it to be read from and written to (for example, Analog Input 
blocks should be in Manual mode).  

bad error file name One of the following command line parameters was not spe-
cified:

 l Control Recipe parameter

 l Master Recipe parameter

 l Master Text Recipe parameter

 l Control Text Recipe parameter

Include the appropriate command line parameter and try again.
bad or active interlock The upload or download interlock specified for the recipe is active 

or does not exist. Make sure the interlock is inactive before you 
try again. If the specified tagname does not exist, create the 
necessary block in the database or specify a different tagname.

bad override parameter The Recipe Builder does not recognize the command line para-
meter specified in a script or a Program block. Refer to the 
chapter Command Line Parameters for a list of recognized com-
mand line parameters and modify the script or Program block as 
needed.

bad override parameter vari-The variable name specified in the command line does not exist 

Audit Trail and Error File Messages    
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able name in the recipe. Re-type the command line and try again.
cannot change batch size in 
control recipe

The Batch Size parameter was specified in the command line 
while downloading a control or control text recipe. This command 
line parameter can only be used with master and master text 
recipes. Either download a master recipe or omit the Batch Size 
parameter from the command line and try again.

cannot change tag group in 
control recipe

The Tag Group parameter was specified in the command line 
while uploading or downloading a control or control text recipe. 
This command line parameter can only be used with master and 
master text recipes. Either upload or download a master recipe or 
omit the Tag Group parameter from the command line and try 
again.

cannot open parameter file The parameter file specified in the command line does not exist 
or could be opened. By default, the Recipe Package assumes 
the file resides in the Local path. Either create a parameter file 
and save it in the Local path or copy the parameter file to this 
path.  

cannot open recipe file The Recipe Builder cannot open the specified recipe. Make sure 
you specified the name of the recipe in the command line and try 
again. Also make sure the recipe exists in the correct recipe 
path. If it does not, create it.

cannot read recipe file The Recipe Builder cannot read the specified recipe. Try spe-
cifying the backup version of the recipe.  

cannot recalculate recipe The Recipe Download or Recipe Upload system task cannot 
recalculate the formula of each recipe item. Make sure the syn-
tax of each formula is valid. Refer to the chapter Working with 
Formulas for information on formulas.

cannot set batch ID The Recipe Package attempted to set the Batch ID. However, it 
encountered a memory or internal error. Exit from any applic-
ations not in use and restart the Recipe Builder.

cannot set batch ID on 
upload

The Batch ID parameter was specified to the Recipe Upload sys-
tem task. This task does not recognize this command line para-
meter. Omit the parameter and try again.

cannot set batch size The Recipe Download system task cannot set the current 
recipe's batch size because the batch size: 

 l Is greater than 9,999,999.0,

 l Is less than 0.0000001,

 l Contains a negative number, or

 l Contains non-numeric data.

Retype the batch size you want and try again.
cannot set batch size on 
upload

The Batch Size parameter was specified to the Recipe Upload 
system task. This task does not recognize this command line 
parameter. Omit the parameter and try again.

cannot set batch size with 
overrides

The Recipe Download system task cannot scale the recipe with 
override values in effect. Click the Clear Overrides button to 
remove all overrides and try downloading the recipe again.

cannot set override value The Recipe Download system task cannot set one or more over-
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ride parameters. The values specified are out of range, do not 
conform to a syntax that the Recipe Download task recognizes, 
or are the wrong data type (for example, entering string data for a 
F_ field). Verify all the values specified and try to download the 
recipe again. 

cannot set overrides on 
upload

One or more override parameters were specified to the Recipe 
Upload system task. This task does not recognize these com-
mand line parameters. Omit the parameters and try again.  

cannot set remarks The Recipe Package attempted to set the download remarks for 
the specified recipe. However, it encountered a memory or 
internal error. Exit from any application not in use and restart the 
Recipe Builder.

cannot set remarks on 
upload

The Download Remarks parameter was specified to the Recipe 
Upload system task. This task does not recognize this command 
line parameter. Omit the parameter and try again. 

cannot set tag group The Recipe Download system task cannot locate the tag group 
assigned to the recipe or specified by the Tag Group parameter. 
Make sure the tag group exists in the directory defined by the Pic-
ture path.

cannot upload to a text file The Master Text Recipe or Control Text Recipe parameter was 
specified to the Recipe Upload system task. Master and Control 
Text recipes cannot be uploaded using this task. Upload the 
recipe from the Recipe Builder instead.  

cannot use parameter file 
with other parameters

The Command Line File parameter was included in the command 
line with other command line parameters. Delete the Command 
Line File parameter or remove the other command file parameters 
from the command line.

cannot write recipe file The specified recipe was uploaded but cannot be saved. Make 
sure there is enough space on the disk to save the recipe and try 
again.

missing batch ID The Batch ID parameter was specified without an identifier. 
Include a batch ID and try again.

missing batch size The Batch Size parameter was specified without including a 
batch size. Include the batch size and try again.

missing parameter file 
name

The Command Line File parameter was specified without an 
accompanying file name. Include the name of the parameter file 
and try again.

missing recipe file name One of the following command line parameters was specified 
without an accompanying recipe name:

 l Control Recipe parameter

 l Master Recipe parameter

 l Master Text Recipe parameter

 l Control Text Recipe parameter

Include the name of the recipe you want to upload or download 
and try again.

missing remarks The Download Remarks parameter was specified without any 
accompanying text. Include the appropriate text and try again.
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missing tag group file name The Tag Group parameter was specified without a tag group file. 
Include the name of the tag group file to use and try again.

No RECIPE user found. 
Run the Security Con-
figuration program and add 
a user called ̀ RECIPE' to 
this node and all referenced 
SCADA nodes

The Recipe user account does not exist on the node you are 
downloading from. Consult your system administrator before pro-
ceeding.

not a recipe file type The file specified is not a recipe. Re-enter the name of the recipe 
to upload or download and try again.

If you are using the Recipe Upload system task, make sure it is a 
master or control recipe. The Upload task cannot upload master 
text or control text recipes.

recipe path not found The Recipe Package cannot locate the recipe path specified in 
the SCU. Make sure the master and control recipe paths exist or 
change the recipe paths to point to the directories where your 
master and control recipes reside.

undefined recipe item The formula for one or more recipe items cannot be evaluated or 
the identifier has not been entered. Complete the identifier and 
formula of each item and try uploading or downloading the recipe 
again.

unknown parameter The Recipe Package does not recognize the command line para-
meter specified in a script or a Program block. Refer to the 
chapter Command Line Parameters for a list of recognized com-
mand line parameters and modify the script or Program block as 
needed.

Understanding Upload and Download Messages

When you upload or download a recipe from the Recipe Builder, the program   examines the recipe for 
errors. If the Recipe Builder encounters an error,   it displays an error dialog box. 

The following table lists the common messages that appear in this dialog   box. Along with the message, 
the response to the error or the message's   meaning is included. 

Message Action
Bad value You are downloading a value to a field that cannot   be written to or the value being 

written is invalid. Make sure the field   can be written to and that the field exists. 
Cannot write to this 
field

You are downloading a value to a field that cannot   be written to. Try downloading to 
a different field.

Current block 
mode does not 
allow writes

You are downloading to a database block that is in   Automatic mode. Put the block in 
Manual mode and download the recipe again.

Field name returns 
wrong data type

You are uploading or downloading a recipe with one   or more symbols defined and no 
tag group assignment. Assign the appropriate   tag group and try uploading or down-
loading the recipe again.

Field's value not The Recipe Builder cannot upload the recipe or verify   the specified recipe item 
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known because it cannot read a value from the specified   block. Make sure SAC and your 
I/O driver are running. Also make sure the   block is on scan.

Illegal option, 
Please re-enter

The data type of the formula does not match the specified   field. For example, you 
may have specified a string constant for a F_   field. Either change the formula or the 
field you are downloading to.

Tagname is not 
defined

Either the specified tagname cannot be written to   or it may not exist. Verify that the 
tagname exists and can be written   to.

Undefined recipe 
item

One or more recipe items have:

 l A calculated   or override value but no identifier, or

 l An identifier   but no formula or override value

Complete the identifier column and either formula   or the override value column for 
the specified recipe items. 

The field cannot   be 
written due to 
security or field 
access restric-
tions.

You are downloading to a field that cannot be written   to or the necessary security 
area rights are not assigned to the Recipe   user account on the target SCADA 
server. Consult with your system administrator   and add the security areas of the 
block you are downloading to the Recipe   user account. 

Value out of range You are downloading a value that is greater than the   block accepts. Change the for-
mula or override value of the specified recipe   item and try downloading the recipe 
again.

Recipes and the Tag Group Editor (TGE.exe)

This chapter provides instructions on creating, modifying, and deleting   tag group files for use with 
recipes. The chapter focuses on functions   that are specific to the Tag Group Editor (TGE.exe). It 
includes information   on:

 l Creating   a New Tag Group File

 l Understanding   Tag Group Editor Layout

 l Exiting   the Tag Group Editor

 l Opening   and Closing Existing Tag Group Files

 l Defining   a Tag Group

 l Editing   a Tag Group File

 l Deleting   a Row

 l Searching   and Replacing Substitutions

 l Saving   a Tag Group File

 l Deleting   a Tag Group File

 l Importing   and Exporting Tag Group Reports

NOTE: The Recipe   Builder requires the .TGE file format when using tag group files. As such,   the Recipe 
Builder uses the FIX32 Tag Group Editor (TGE.EXE).  Be   aware there is another Tag Group Editor 
(TagGroupEditor.exe) for creating   tag groups in iFIX pictures in .TGD file format. The Recipe Builder cannot   
use these newer .TGD files.  
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Creating a New Tag Group File

The Tag Group Editor provides two methods for creating new tag group files. You can start the Tag 
Group Editor by clicking the Start button, clicking Run, and entering the following text into the dialog box 
that appears:

fixpath\TGE.EXE

For example, if the Tag Group Editor resides in the default Base path, C:\Program Files (x86)\GE\iFIX, 
you could start the program by entering the following text in the Run dialog box:

C:\Program Files (x86)\GE\iFIX\TGE.EXE

When the program starts, the Tag Group Editor displays a blank, untitled spreadsheet.

Alternatively, when a tag group file is already open, you can create a new tag group file by selecting the 
New command. When you select this command, the Tag Group Editor closes the active tag group file, 
prompts you to save any unsaved changes, and then displays a blank spreadsheet.

Understanding Tag Group Editor Layout

The layout of the Tag Group Editor follows the standard iFIX spreadsheet format, and functions like 
most spreadsheets. The layout can be separated into the following items:

Menu Bar — contains menus that control the file input, output, and editing commands for the spread-
sheet. These menus include the File menu, the Edit menu, the Font! menu, and the Help menu. The 
Font! menu lets you set the font used to display text in the Tag Group Editor.

Menu Bar Commands — contains the commands necessary for creating, managing, and formatting 
your tag group files. The following table summarizes these commands. 

Menu Option Function

File

New Opens a new tag group file. 
Open... Opens an existing tag group file or report. 
Save Saves the active tag group file. 
Save as... Saves a tag group file to a new name or file type. 
Delete... Deletes a tag group file or report. 
Exit Exits the Tag Group Editor. 

Edit 
Delete Row Delete a selected row of the spreadsheet. 
Search and 
Replace

Searches substitution column for specific text and optionally replaces 
it with another. 

 

Spreadsheet — contains your tag group definitions.

Understanding the Tag Group Spreadsheet

The Tag Group Editor spreadsheet has the following columns: 
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Symbol   — specifies   the text that is replaced by a substitution string. Each symbol can be   alphanumeric 
text up to 31 characters long.

Substitution   — specifies   the text that replaces a symbol. This field can be up to 95 characters   long and 
is usually a tagname. It is recommended that you use the fully   qualified name of any tag for sub-
stitution in a spreadsheet.

Description   — describes   the function of the tag group. The description field is optional and can   contain 
up to 71 characters, including special characters, such as -(*)&+%   and spaces.

Exiting the Tag Group Editor

To exit the Tag Group Editor, select Exit from the File menu. If you made changes since your last save, 
the Tag Group Editor displays the Save Changes dialog box. If you want to save changes, select Yes. If 
you do not want to save changes, select No. If you want to continue working on your tag group file, 
select Cancel.

Opening and Closing Existing Tag Group Files

To open an existing tag group file in the Tag Group Editor, select Open from the File menu. All pre-
viously-saved tag group files have an extension of .TGE and are stored in the Picture path.  When you 
select this command, the Open dialog box appears.

To specify the tag group file to open, enter the name of the tag group file you want to open in the File 
Name field and click OK. The Tag Group Editor opens the specified tag group file.

If you prefer, you can double-click the tag group file you want to open from the File Name list box. The 
Tag Group Editor opens the specified tag group file. The File Open command can also be useful as a tool 
that lists all available tag group files.

NOTE: You can also import a tag group report (*.CSV file) into a tag group spreadsheet using the Open com-
mand. Refer to the section Importing and Exporting Tag Group Reports for more information on working with 
tag group reports.

Closing Tag Group Files

Once the Tag Group Editor opens a tag group file, it cannot open another until the active file is closed. To 
close a tag group file, simply select Open again. The Tag Group Editor closes the active tag group file 
and opens the file you select.

If you made changes to the old tag group file and have not saved them, the Tag Group Editor prompts 
you with the standard "Save Changes?" dialog box. Select Yes to save your changes to disk. If you do 
not want to save your changes, select No. To continue working with the tag group file, select Cancel.

NOTE: The Tag Group Editor does not automatically create back-up files. If you need back-up files, you must 
create them manually.

Defining a Tag Group
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The Tag Group Editor displays its data in a spreadsheet. All valid cell entries in the Symbol and Sub-
stitution columns must be alphanumeric and start with a letter. When you have finished entering data 
into the spreadsheet, select Save from the File menu to save your changes to disk.

NOTE: When you enter tagnames into the substitution column, iFIX does not check the format or validity of 
the tagnames. Be sure to double-check the format and spelling of all tagnames entered into the substitution 
column.

When creating a second tag group file, you do not have to list the symbols in the exact order as the first 
tag group file. However, they must have identical symbol names for the correct substitutions to take 
place. For example, if one file represents the digital limit switch for the fuel intake valve of furnace A as 
FIVLIMITSWITCH, then the symbol FIVLIMITSWITCH of furnace B's tag group file must represent the 
same type of digital limit switch.

The following sections describe how to enter data into the Symbol, Substitution, and Description 
columns of the spreadsheet.

Defining Symbols

Symbols are place holders for tagnames in recipes. When you enter a   symbol into any of these applic-
ations, you must type a question mark prior   to the symbol name. This allows iFIX to differentiate tag 
group symbols   from ordinary text. However, when defining symbols in the symbol column   of the Tag 
Group Editor, you only type the symbol name.

For example, to use a place holder called "TEMPERATURE" to   represent the tagnames of three similar 
temperature output blocks, type   the following into the symbol column:

TEMPERATURE

If you want to implement this symbol into a recipe, type the following   into the Identifier column of a 
recipe spreadsheet: 

?TEMPERATURE

When iFIX reads text in this format, it identifies the text as a tag   group symbol and replaces each occur-
rence of the symbol with the correct   substitution.

 To define a symbol in the Tag Group   Editor spreadsheet: 

 1. In the Symbol column,   select the desired cell by clicking it. 

 2. Type a symbol name.   The symbol name can be a maximum of 31 alphanumeric characters. As 
you   type, the text appears in the text editing box of the spreadsheet. 

 3. Press ENTER   to enter the data into the desired cell. 

 4. Repeat step 3 until   you have entered all of the symbol names that you need for this tag group   file. 

NOTE: You do not have   to define a symbol's substitution before entering another symbol, but   you cannot 
enter data into a substitution cell without first defining   its symbol. For example, you can enter all of your sym-
bols into the spreadsheet   as a first step, and then enter their substitutions as another step.

If you plan to import or export comma separated files, you should not use   the word SYMBOL as a tag group 
symbol name. Refer to the section Importing   and Exporting Tag Group Reports for more information on work-
ing with   tag group reports and comma separated files.
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Defining Substitutions

Substitutions are tagnames that replace symbols in recipes. When typing   a substitution, it is important 
to keep in mind that the Tag Group Editor   simply replaces the exact data it finds in the symbol column 
with the   exact data it finds in the substitution column. Double-check to be sure   that the data you enter in 
all cells is typed correctly and the tagname   is properly formatted.

 To define a substitution in the Tag   Group Editor spreadsheet: 

 1. In the Substitution   column, select the desired cell by clicking it. 

 2. Type the tagname   that you want to replace for the symbol on the left. The substitution   data can 
be a maximum of 95 alphanumeric characters. As you type, the   tagname appears in the text edit-
ing box of the spreadsheet. 

NOTE: It is   strongly recommended that you use the fully qualified names for substitutions   in a spread-
sheet.

 3. Press ENTER   to enter the data into the desired cell. If you have not defined   the adjacent Symbol 
cell, an error message appears and instructs you to   do so first. 

 

Defining Descriptions

The description cell offers a way to describe the function of a specific   tagname substitution. The descrip-
tion field is optional, and is not involved   in the functionality of the Tag Group Editor. However, it can be a 
powerful   tool to help you organize and keep a record of tag groups that you create.   It can also be a useful 
visual aid when printing a report. Each description   cell can contain up to 71 alphanumeric characters.

 To define a description in the Tag   Group Editor spreadsheet: 

 1. In the Description   column, select the desired cell by clicking it. 

 2. Type the description   into the desired cell. The data you enter can be a maximum of 71 alpha-
numeric   characters. As you type, the text appears in the text editing box of the   spreadsheet. 

 3. Press ENTER   to enter the data into the desired cell. If you have not defined   that row's Symbol 
cell, an error message appears and instructs you to   do so first. 

Editing a Tag Group File

While creating or customizing iFIX, you may find it necessary to modify the symbols, substitutions, or 
descriptions that you have previously entered into a tag group file.

 To edit a cell in the Tag Group Editor spreadsheet: 

 1. Double-click the cell you want to modify. The Edit Cell Data dialog box appears.   

 2. Type the correct text into the edit field of the dialog box.   

 3. Click OK to incorporate the new changes. If you make a mistake, click Cancel to revert to the ori-
ginal cell data.   

NOTE: You can also use the Edit Cell Data dialog box to delete an entire row from the spreadsheet by 
double-clicking any cell in the row you want to delete, deleting all text from the edit field, and clicking OK.
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Deleting a Row

You can delete an entire row from a tag group file by selecting the Delete Row command from the Edit 
menu. When you select Delete Row, the symbols, substitutions, and descriptions you delete are irre-
trievable.

 To delete an entire row of the Tag Group Editor spreadsheet: 

 1. Highlight any cell in the row you want to delete.   

 2. On the Edit menu, click Delete Row. The Tag Group Editor removes the selected cell's row from 
the spreadsheet.   

NOTE: You can also delete a row of the spreadsheet by highlighting any cell in the desired row and 
pressing <Delete>.

Searching and Replacing Substitutions

Sometimes it is necessary to change a particular symbol's tagname substitution. For example, if a tag-
name has changed within a database, you need to update all applicable substitution columns. You could 
locate specific tagname substitutions by simply scrolling through the spreadsheet using the scroll bars 
or arrow keys. However, as the spreadsheet becomes larger, this can become a very time-consuming 
task.  

For this reason, the Tag Group Editor provides a search and replace function that allows you to locate 
tagname substitutions quickly by searching the spreadsheet for a specified tagname and replacing it.

 To search for and replace a tagname substitution: 

 1. On the Edit menu, click Search and Replace Substitutions. The Search and Replace Tagnames 
dialog box appears.   

 2. In the Search For field, enter the tagname you want to search for. If you choose, you can use 
asterisk wildcard characters (*) to represent one or more characters in the node name or tag name 
you are searching for.   

 3. In the Replace With field, enter the tagname you want to use as a replacement for the tagname in 
the Search For field. If you choose, you can use asterisk wildcard characters (*) to represent one 
or more characters in the new node name or tag name you want to use.   

 4. Click Replace to begin the search and replace procedure. A message appears inside the Search 
and Replace Tagnames dialog box and reports the number of occurrences that changed. For 
example, the following text appears when occurrence is replaced.   
1 occurrence(s) changed

When you finish searching for and replacing a tagname substitution, you can return to the spreadsheet 
by selecting a cell. The Search and Replace Tagnames dialog box remains on the display until you 
deselect Search and Replace Substitutions from the Edit menu or until you close it. 

NOTE: The Search and Replace Substitutions command only functions with Node:Tag substitutions. If you 
enter text into either of the Search and Replace fields that is not in Node:Tag format, it prompts you to enter a 
valid tagname.
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IMPORTANT: iFIX includes two Tag Group Editors: one is for use with pictures and the other is for use with 
recipes. The Tag Group Editor discussed in this manual is intended for use with recipes. To use the Tag 
Group Editor with pictures, select the Tag Group Editor button from the WorkSpace. 

Saving a Tag Group File

When you finish making changes to a tag group file, you need to save the tag group file to disk in order to 
make your changes permanent.

To save an existing tag group file, select Save from the File menu. The updated file writes over any pre-
viously-saved tag group file.

If you are saving a new tag group file, the Tag Group Editor prompts you to enter a name for the tag group 
file by displaying the Save As dialog box. Enter a new file name into the File Name field and select Save. 
The Save As command can also be used to save a tag group file under a different name or to create a 
backup tag group file.

NOTE: You can also report a tag group file using the Save and Save As commands. Refer to the section 
Importing and Exporting Tag Group Reports  for more information on working with tag group reports.

Deleting a Tag Group File

As you customize iFIX, you may find that certain tag group files have become obsolete. You can delete 
them by using the Delete command from the File menu.

 To delete a tag group file: 

 1. On the File menu, click Delete. The File Delete dialog box appears.   

 2. In the File Name field, type the name of the tag group file you want to delete, and click OK. If you 
prefer, in the Tag Group list box, you double-click the tag group file to select it. A confirm deletion 
message box appears.   

 3. Click Delete. The Tag Group Editor deletes the specified tag group file.   

NOTE: You can also delete tag group reports (*.CSV files) using the Delete command. Refer to the section 
Importing and Exporting Tag Group Reports  for more information on working with tag group reports.

Importing and Exporting Tag Group Reports

The Tag Group Editor can import and export tag group information that is formatted as a comma sep-
arated variable (CSV) file. Comma separated files are useful if you want to exchange tag group inform-
ation between a third-party text editor, spreadsheet, or word processor and the Tag Group Editor. The 
Tag Group Editor recognizes files with a .CSV file extension as tag group reports.

Tag group reports have several benefits. A large tag group file can be saved as a tag group report, 
opened in a text editor or word processor, and printed as a text file. The printout provides an on-paper list 
of all symbols, substitutions, and descriptions defined in the Tag Group Editor spreadsheet. This list can 
help you verify your tag groups before you implement them into your SCADA strategy. Tag group reports 
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also allow you to enter tag group information into an application you are more familiar with, such as 
Microsoft Excel or a text editor, and then import this information into the Tag Group Editor.

Understanding the Tag Group Report Format

The Tag Group Editor provides an easy-to-use spreadsheet interface. However, you may feel more com-
fortable entering tag group information in your favorite spreadsheet application or text editor rather than 
the Tag Group Editor spreadsheet. Some spreadsheet applications, such as Microsoft Excel, provide a 
CSV format option within their Save As dialog box. If you use this method, the application does all the 
required formatting for the file you want to import.

If you prefer to use a text editor, you must follow some simple formatting rules to make sure that the text 
file is successfully imported into the Tag Group Editor. In general, each line of the text file should be 
typed similarly to the following:

OVENTEMP,OVEN1:TOV01.F_CV,OVEN1 CURRENT TEMPERATURE

In this example, OVENTEMP is the name of a tag group symbol, OVEN1:TOV01.F_CV is the sub-
stitution, and OVEN1 CURRENT TEMPERATURE is the description.

If you are using a text editor, and the name of a symbol, substitution, or description contains a quotation 
mark ( " ) or the same list separator defined in the Regional Settings control panel, you must enclose that 
item in quotation marks. Also, you must type an extra quotation mark before each quotation mark within 
that item. For example, if you are entering a symbol named OVEN"TEMP into your text editor, you must 
type "OVEN""TEMP" as your symbol name.

Each line in your text file represents one row when imported into the Tag Group Editor. The information 
should always be typed in the same order as it appears in the Tag Group Editor spreadsheet (symbol, 
substitution, description). A list separator must be used to separate each component of the tag group. 
You must use the same list separator defined in the Number tab of the Regional Settings control panel. 
In most cases, this will be a comma ( , ). If you do not want to include a description, type a list separator 
after the substitution and leave the rest of the line blank.

The symbols, substitutions, and descriptions that you type into your text file have the same length lim-
itations as the corresponding component in the Tag Group Editor spreadsheet. Be careful not to exceed 
this length; otherwise, when you import a component into the Tag Group Editor that exceeds its max-
imum length, a blank space is displayed in the corresponding cell and an error message is generated.

The Tag Group provides a text file in the Picture path, TGEIMP.ERR, that contains a list of errors that 
occurred during the import of a comma separated file. After you import a comma separated file, be sure 
to open this file and verify any errors. Note that if that no errors occurred during the import, this file will 
not exist.

NOTE: If a row in a comma separated file does not contain at least a symbol, The Tag Group Editor does not 
import the entire row of the file.

If you want to include comment statements in your text file, you must enclose each line of the comment 
in brackets ( [ ] ). Information in brackets is not imported into the Tag Group Editor, but remains in the file 
to be displayed or printed by a text editor. For example, you may want to include comments in the text 
file that display the name of the tag group file, the date the file was created, and each date that the file is 
modified.
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NOTE: Including comments in your CSV file is optional. Comments and blank lines can be embedded any-
where within the file. If you save the CSV file from a spreadsheet, such as Microsoft Excel, comments must 
start in the first column.

As long as these simple formatting rules are followed, any text file saved with a .CSV extension can be 
read into the Tag Group Editor.

Importing Tag Group Reports

The steps that follow explain how to import a tag group report.

 To import a tag group report: 

 1. On the File menu, click Open. Select the directory that contains the tag group report you want to 
import from the Directories list box.     

 2. Select the List Files of Type drop-down box and click the Tag Group Reports (*.CSV) option.   

 3. From the File Name list box, double-click the name of the report that you want to read in. The Tag 
Group Editor imports the specified tag group report into the active spreadsheet.   

If you import a tag group report into an existing tag group file, the new information is inserted after the 
last row of data in the spreadsheet.  

If you open a file and no entries appear in the spreadsheet, the list separator used by the file may be dif-
ferent from the list separator defined by the computer's Regional Settings control panel. To resolve this 
conflict, change the separator in the control panel and open the .CSV file again.

Exporting a Tag Group File

When you export a tag group file, the Tag Group Editor applies all formatting   rules described in previous 
sections. Each line in the resulting report   file represents a row in the Tag Group Editor spreadsheet, with 
the exception   of bracketed information. The information in brackets are comments; they   are ignored 
when the Tag Group Editor imports the report file. A tag group   report automatically provides three com-
ments at the top of the report.   These comments include a title, the path of the reported tag group file,   and 
the report date. A sample tag group report is shown in the following   figure.

Sample Tag Group Report
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As the previous figure shows, all data is separated with a list separator   and enclosed in quotation marks. 
The Tag Group Editor does this as a safeguard   even though the only items that require quotation marks 
are list separators   and other quotation marks. In fact, you can delete the quotations around   any com-
ponent that does not contain a defined list separator or quotation   mark if you want.

NOTE: The tag group report also provides a line   with the text SYMBOL, SUBSTITUTION, and DESCRIPTION. 
This line is provided   for readability only. When importing a report, the Tag Group Editor ignores   any line that 
begins with the word SYMBOL. If you plan to use reports,   do not name any of your symbols with the word 
SYMBOL.

Creating a Tag Group Report

The steps that follow explain how to create a tag group report.

 To create a tag group report: 

 1. Open the tag group file (*.TGE) that you want to export.   

 2. On the File menu, click Save As.   

 3. Select the Save File as Type drop-down box and click the Tag Group Reports (*.CSV) option.   

 4. In the File Name field, type a report name and click OK.   

Recipe Dialog Boxes

The Recipe application includes the following dialog boxes:

 l Advanced   Options Dialog Box

 l Assign   Tag Group Dialog Box

 l Column   Details Dialog Box

 l Download   Dialog Box

 l Download/Upload   Error List Dialog Box

 l Field   Select Dialog Box

 l Go   To Dialog Box

 l Open   Control Recipe Dialog Box

 l Override   Low/High Limit Dialog Box

 l Precheck   Error List Dialog Box

 l Recipe   Mod Log Dialog Box

 l Report   Column Details Dialog Box

 l Report   Format Dialog Box

 l Set   Batch Size Dialog Box

 l Window   Display Format Dialog Box
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Advanced Options Dialog Box

The Advanced Options dialog box lets you:

 l Define the upload   and download interlocks for the recipe.

 l Define the tagname   of an upload/download completion status indicator.

 l Assign the recipe   to a security area.

 l Keep an audit trail   of recipe activity.

The Advanced Options dialog box displays the following items:

Download

The Download field lets you define the tagname or symbol that acts as   a download interlock for the cur-
rent recipe.  When   you download a recipe, the Recipe Builder verifies that the interlock   is inactive.  If   the 
interlock is active, the download process aborts.

Upload

The Upload field lets you define the tagname or symbol that acts as   an upload interlock for the current 
recipe.  When   you upload a recipe, the Recipe Builder verifies that the interlock is   inactive.  If   the inter-
lock is active, the upload process aborts.

Completion Status

The Completion Status field lets you enter the tagname of an analog   block.  This   block acts as a com-
pletion status indicator. During an upload or download,   the Recipe Builder stores a number (from zero to 
four) in the block.  The   meaning of these values is as follows:

When the value is... The download or upload...

0 Is in progress.

1 Aborted.

2 Completed with errors.

3 Completed with no errors.

4 Completed with verification errors (download only).

Audit Trail Support

Item Description

Summary Audit Trail The Summary Audit Trail button tracks when:

 l Changes to   master recipes and control recipes 
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are saved and the name of the logged   in user that 
saved the recipe.

 l A recipe   is uploaded or downloaded and the 
name of the logged in user that uploaded   or down-
loaded the recipe.

 l An upload   or download fails and why.

The Summary Audit Trail button also tracks the text   entered 
into the Mod Log field on the Recipe Mod Log dialog box.

The Recipe Builder records this information whenever   a recipe 
is saved, uploaded, or downloaded.

Detail Audit Trail The Detail Audit Trail button tracks the same summary   inform-
ation that the Summary Audit Trail button does.  The   Detail 
Audit Trail button also tracks the following additional inform-
ation:

 l The recipe   item values that were downloaded.

 l The variables   that were present in the recipe.

 l The recipe   items that failed to download and 
why.

No Audit Trail The No Audit Trail button disables the audit trail   for the current 
recipe.

Security Area

The Security Area field lets you assign a security area to a recipe.    You can   enter up to 20 alphanumeric 
characters into this field. Once you assign   a security area to a recipe, it can be opened only if the logged 
in user   has rights to that security area.

 

Assign Tag Group Dialog Box

The Assign Tag Group dialog box displays the following item:

Tag Group Filename

The Assign Tag Group dialog box lets you define the specific tag group   you want to assign to the current 
recipe. You can enter the name of the   tag group file in the Tag Group Filename field or select the tag 
group   file from a list by clicking the browse (...) button. 

Column Details Dialog Box
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The Column Details dialog box lets you modify a column in the spreadsheet.   The Column Details dialog 
box displays the following items:

Column Heading

The Column Heading   field lets you change the column heading of any column in the spreadsheet   or in a 
recipe report.  You   can enter up to 39 characters into this field.

Modifiable

The Modifiable check box controls whether the text in the selected column   is modifiable.  When   you 
select the check box, the text is modifiable.  When   you clear the check box, the text is not modifiable.

Download Dialog Box

The Download dialog box lets you enter text (or remarks) about the download   of the current recipe. This 
dialog box only appears if the audit trail   is enabled. 

The Download dialog box displays the following items:

Batch ID

The Batch ID field lets you enter an identifier for the download of   the current recipe.  This   identifier can 
be up to 10 characters.  The   text you enter is added to the audit trail, uniquely identifies the download,   
and is added to the keyword #BATCH_ID.  Entering   data into the field is optional.

Download Remarks

The Download Remarks field lets you enter up to 20 characters explaining   why the current recipe is 
being downloaded.  The   text you enter is added to the audit trail and is assigned to the keyword   
#REMARKS.  Entering   data into the field is optional.

 

Download/Upload Error List Dialog Box

The Download/Upload Error List dialog box lets you list the errors that   the Recipe Builder encountered 
during the last upload or download. The   dialog box also includes the:

 l Recipe that was uploaded   or download

 l Number of errors   encountered

 l Date and time of   the last upload or download

The Download/Upload Error List dialog box displays the following items:
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Error List

The Error list box displays the upload, download, or verification errors   that the Recipe Builder 
encountered during an upload or download.  Each   error is identified by tagname and row number.

To correct an error, use the buttons directly beneath the Error list   box.

Go To Item Button

Use this button to move the cell selector to the highlighted   tagname in the recipe.

Save Errors Button

Use this button to store contents of the list box to the file recipe.RCE.  This   file resides in either the mas-
ter recipe path or control recipe path,   depending on the type of recipe you are working with.  

 

Field Select Dialog Box

The Field Select dialog box lets you to select a node, tag, and field   combination. To select a node and 
tag, you can use one of three methods:

 l Select a node from   the Node Selection list box, a tag from the Tag Selection list box, a   field from 
the Field Selection list box, and click OK.

 l Type a node, tag,   and field combination in the Selection field using the node:tag.field   format.

 l Use the asterisk   wildcard character to filter through the network for a specific node,   tag, and field 
combination.

NOTE: Only nodes   configured in the System Configuration Utility (SCU) appear in the Node   Selection list 
box.

The Field Select dialog box displays the following items:

Filter Fields

The Filter field lets you search for a specific selection in the Node   Select, Tag Select, and Field Select 
dialog boxes.

Use the asterisk wildcard character in combination with the Filter button   to search for a specific selec-
tion quickly and easily.  To   search for a tagname, type the search specification in the Filter field   and 
select the Filter button.

Node Selection List

The Node Selection list box displays the names of all nodes configured   in the System Configuration Util-
ity (SCU).  If   you filter the list, the list box displays all the nodes that match the   specified filter.

112 © 2020 General Electric Company. All rights reserved.



Tag Selection List

The Tag Selection list box displays the names of all tags configured   on the selected node.  If   you filter 
the list, the list box displays all the tags that match the   specified filter.

Field Selection List

The Field Selection list box displays the names of all valid fields   for the selected node and tag.  If   you fil-
ter the list, the list box displays all the fields that match the   specified filter.

Selection Edit Box

The Selection field displays the name of the selected tagname in the   Node Select, Tag Select, and Field 
Select dialog boxes.  To   select a specific tagname without using the Filter field or Filter button,   type the 
tagname in the Selection field and click OK.

Filter Button

The Filter button lets you search for a specific tagname in the Node   Select, Tag Select, and Field Select 
dialog boxes.

Use the asterisk wildcard character in combination with the Filter field   to search for a specific tagname 
quickly and easily.  To   search for a tagname, type the search specification in the Filter field   and select 
the Filter button.

Go To Dialog Box

The Go To dialog box lets you jump to a specific row. The Go To dialog   box displays the following item:

Item Number

The row number that you want to jump to. After entering a row number,   select the Go button to jump to 
the specified row.  

Open Recipe Dialog Box

The Open Recipe dialog box only opens control recipes located in the   control recipe path. The Open 
Recipe dialog box displays the following   items:

Recipe Name Field

The Recipe Name field lets you to enter the name of the recipe you want   to open.

Recipe List Box

The Recipe list box displays the recipes you can open. 
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List Files of Type

The List Files of Type list box displays the types of files you can   enter in the File Name field.

Drives

The Drives list box shows the name of the drive you have selected.

Network

The Network button allows you to connect to a shared network folder.

Override Low/High Limit Dialog Box

The Override Low/High Limit dialog box lets you define the high and   low override limit for a recipe item or 
variable. The Override Low/High   Limit dialog box displays the following items:

Unrestricted Limit

When either override limit is unrestricted, the operator can enter any   override value that is less than or 
equal to the high limit and greater   than or equal to the low limit.  If   both override limits are unrestricted, 
any override value can be entered.    

Restricted Limit

When the high override limit is restricted, the operator can enter an   override value that is less than or 
equal to the recipe item's calculated   value.  When   the low override limit is restricted, the operator can 
enter an override   value for the high limit that is greater or equal to the calculated value.    If both   override 
limits are restricted, no override value can be entered.

Absolute Limit

The Absolute Limit field lets you enter a numeric constant as the high   or low override limit.  When   an 
absolute limit is used, the operator can enter an override value less   than or equal to the high limit and 
greater than or equal to the low limit.   

Percentage Limit

The Percentage Limit field lets you enter a percentage as the high or   low override limit.  When   a per-
centage limit is used, the operator can enter an override value equal   to the recipe item's calculated value 
plus or minus the specified percentage.    

Difference Limit

The Difference Limit field lets you enter a relative difference as the   high or low override limit.  When   a dif-
ference limit is used, the operator can enter an override value equal   to the recipe item's calculated value 
plus or minus the specified difference.

Precheck Error List Dialog Box
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The Precheck Error List dialog box lists the errors the Recipe Builder   encountered prior to uploading or 
downloading a recipe. Common precheck   errors include an active interlock or uploading from or down-
loading to   a tagname that does not exist. 

The Precheck Error List dialog box displays the following items:

Precheck Error List

The Precheck Error list box displays the errors that the Recipe Builder   encountered prior to uploading or 
downloading a recipe.  Each   error is identified by tagname and row number.

Available Buttons

Use the buttons directly beneath the Error list box to proceed with   or cancel the upload or download:

Use the... To...

Continue Down-
load button

Proceed with the download despite the errors.

Continue 
Upload button

Proceed with the upload despite the errors.

Cancel Down-
load button

Abort the download.

Cancel Upload 
button

Abort the upload.

Save Errors but-
ton

Store the contents of the list box to the file recipe.RCE.  This   file 
resides in either the master recipe path or control recipe path,   depend-
ing on the type of recipe you are working with.  

 

Recipe Mod Log Dialog Box

The Recipe Mod Log dialog box lets you enter a description of why the   current recipe is being saved. The 
Recipe Mod Log dialog box only appears   if the audit trail is enabled. 

The Recipe Mod Log dialog box displays the following items:

Mod Log Field

The Mod Log field lets you enter up to 30 characters of text explaining   any changes made to the current 
recipe.  Entering   data into the field is optional.  The   text you enter is incorporated into the audit trail.  
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Save As

The Save As button provides you with access to the Save Recipe As dialog   box. Enter the name you 
want to save the recipe as.

Report Column Details Dialog Box

The Report Column Details dialog box lets you modify a column in a recipe   report. The Report Column 
Details dialog box displays the following items:

Column Heading

The Column Heading field lets you change the column heading of any column   in the spreadsheet or in a 
recipe report.  You   can enter up to 39 characters into this field.

Column Width

The Column Width field lets you define the length of a column in a recipe   report.  You   can enter any value 
between 1 and 100 into this field.

 

Report Format Dialog Box

The Report Format dialog box lets you:

 l Add a column to a   recipe report.

 l Remove a column to   a recipe report.

 l Arrange the columns   in a report.

 l Modify a report column   heading.

 l Change the column   width in a report.

The Report Format dialog box displays the following items:

Available Columns List Box

The Available Columns list box displays the columns you can add to the   spreadsheet or a recipe report. 
If the list box is empty, all columns   are in use.

Column Layout List Box

The Columns Layout list box displays all the columns that appear in   the spreadsheet or that will appear 
in the recipe report.  The   list box also shows the order in which the columns appear, each column   head-
ing, and one of the following items:

 l If the column can   be modifiable (when editing a display format)

 l The column width   (when editing a report layout)
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Column Layout List Buttons

The Column Layout List Box buttons let you modify the display format   as follows:

Use the... To...

Up Arrow 
and Down 
Arrow but-
tons

Move the selected column up or down in the Column   Layout list box.

Add button Move the selected column from the Available Columns   list box to the 
Column Layout list box.

Modify but-
ton

Change the column heading and either the column width   (when modifying 
the format of a report) or whether the column is modifiable   (when modi-
fying the format of the spreadsheet).

Delete but-
ton

Remove a column from the Column Layout list box.

Switch To 
button

Toggle between the display format of the Recipe Development   window 
and Recipe Operations window.

 

Search and Replace Dialog Box

The Search and Replace dialog box lets you search and replace data in   a recipe. The dialog box provides 
the following options:

 l Performing a case-sensitive   search.

 l Searching forward   or backward in the recipe.

 l Starting a search   in the middle of a column and wrapping to the column's beginning or end.

The Search and Replace dialog box displays the following items:

Search for

The Search for field lets you enter a search string of up to 100 characters.    Wildcard   characters (such as 
* and ?) are treated as text.

After entering a search string, select the Search Next button to search   forward for the next occurrence of 
the search string in the selected column.    Select   the Search Previous button to search backward for the 
next occurrence   of the search string.
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Replace with

The Replace with field lets you enter a replacement string of up to   100 characters.  Wildcard   characters 
(such as * or ?) are treated as text.

After entering a replacement string, select the Replace Next button   to search forward for the next occur-
rence of the search string and replace   it.  Select   the Replace Previous button to search backward for the 
next occurrence   of the search string and replace it.

Case Sensitive

The Case Sensitive check box lets you control whether the search for   the search string is case sens-
itive.  Select   the check box for a case sensitive search.  Clear   the check box for a non-case sensitive 
search.

Wrap Around

The Wrap Around check box lets you search an entire column, either forward   or backward, no matter 
where you start in the column.  When   you select this check box, the Recipe Builder automatically wraps 
and   continues searching the selected column when it reaches the spreadsheet's   beginning or end.

When the check box is cleared, the Recipe Builder searches the selected   column until it reaches the 
spreadsheet's end or the beginning.

Set Batch Size Dialog Box

The Set Batch Size dialog box lets you specify the current batch size.   The Set Batch Size dialog box dis-
plays the following item:

Batch Size

Enter any batch size from 0.000001 to 9,999,999.0 into the Batch Size   field.  

Window Display Format Dialog Box

The Window Display Format dialog box lets you:

 l Add a column to the   spreadsheet

 l Remove a column to   the spreadsheet

 l Arrange the columns   in the spreadsheet

 l Modify a spreadsheet   column heading

 l Make a column modifiable

 l Display the current   display format of the Recipe Development window or the Recipe Operations   
window

The Window Display Format dialog box displays the following items:
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Available Columns List Box

The Available Columns list box displays the columns you can add to the   spreadsheet or a recipe report.  
If   the list box is empty, all columns are in use.

Column Layout List Box

The Columns Layout list box displays all the columns that appear in   the spreadsheet or that will appear 
in the recipe report.  The   list box also shows the order in which the columns appear, each column   head-
ing, and one of the following items:

 l If the column can   be modifiable (when editing a display format)

 l The column width   (when editing a report layout)

Column Layout List Buttons

The Column Layout List Box buttons let you modify the display format   as follows:

Use the... To...

Up Arrow 
and Down 
Arrow but-
tons

Move the selected column up or down in the Column   Layout list box.

Add button Move the selected column from the Available Columns   list box to the 
Column Layout list box.

Modify but-
ton

Change the column heading and either the column width   (when modifying 
the format of a report) or whether the column is modifiable   (when modi-
fying the format of the spreadsheet).

Delete but-
ton

Remove a column from the Column Layout list box.

Switch To 
button

Toggle between the display format of the Recipe Development   window 
and Recipe Operations window.

 

How Do I...

Click any of the following links for more information about Recipe's   step-by-step procedures:

 l Using   Basic Functions

 l Working   with Recipes

 l Locating   and Displaying Data

 l Working   with Formulas
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 l Using   Advanced Features

 l Using   Keyboard Accelerators

 

Using Basic Functions

You can perform the following basic functions in the Recipe Builder:

 l Downloading   Recipes

 l Uploading   Recipes

 l Scheduling   Recipes for Automatic Upload and Download

 l Uploading   and Downloading from an Operator Display

 

Downloading Recipes

 To download a   recipe from the Recipe Builder:

 1. In the iFIX WorkSpace   system tree, in the FIX Recipes folder, double-click New Recipe. The 
Recipe   Operations or Recipe Development window appears.

 2. On the File menu,   click Open. If you are in the Recipe Operations window, the Open Control   
Recipe dialog box appears. If you are in the Recipe Development window,   the Open Recipe dia-
log box appears. 

TIP:   To change the type of recipes that appear in the Open Recipe dialog box   from the Recipe Devel-
opment window, in the List Files of Type drop-down   list, select Master Recipe (*.rcm) or Control 
Recipe (*.rcc). Be aware   that the Open Control Recipe dialog box from the Recipe Operations dialog   
box only displays control recipes.

 3. Select the recipe   you want to download. The recipe displays in the spreadsheet.

 4. Click the Download   button from the recipe header. The Download dialog box appears.

 5. Enter the necessary   information in the Download dialog box.

 6. Click OK.

NOTE:   Prior to downloading a recipe, the Recipe Builder performs error checking.   If the Recipe 
Builder detects an error, the download aborts and the Precheck   Error List dialog box appears. If the 
Recipe Builder detects no errors,   the download begins. When the Recipe Builder completes the down-
load, it   displays the results in a message or the Download Error List dialog box.

 

Uploading Recipes

 To upload a recipe   from the Recipe Builder:

 1. In the iFIX WorkSpace   system tree, in the FIX Recipes folder, double-click New Recipe. The 
Recipe   Operations or Recipe Development window appears.
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 2. On the File menu,   click Open. If you are in the Recipe Operations window, the Open Control   
Recipe dialog box appears. If you are in the Recipe Development window,   the Open Recipe dia-
log box appears. 

TIP:   To change the type of recipes that appear in the Open Recipe dialog box   from the Recipe Devel-
opment window, in the List Files of Type drop-down   list, select Master Recipe (*.rcm) or Control 
Recipe (*.rcc). Be aware   that the Open Control Recipe dialog box from the Recipe Operations dialog   
box only displays control recipes.

 3. Select the recipe   you want to upload. The recipe displays in the spreadsheet.

 4. Select the Upload   button from the recipe header. The Recipe Builder starts the uploading   pro-
cess.

NOTE:   Prior to uploading a recipe, the Recipe Builder performs error checking.   If the Recipe Builder 
detects an error, the upload aborts and the Precheck   Error List dialog box appears. If the Recipe 
Builder detects no errors,   the upload begins. When the Recipe Builder completes the upload, it dis-
plays   the results in a message or the Upload Error List dialog box.

 

Scheduling Recipes for Automatic Upload and Download

 To schedule a   recipe for automatic uploading or downloading:

 1. In Classic view,   on the iFIX WorkSpace application toolbar, click the Database Manager   button. 

-Or-

In Ribbon view, on the Application tab,   in the Process Database group, click Database Manager.

 2. Select the SCADA   server you want to connect to.

 3. Click OK. Once Database   Manager connects to the selected SCADA server, the program opens 
the server's   current database and the Database Manager window appears.

 4. In Classic view,   in Database Manager, on the Blocks menu, click Add. 

-Or-

In Ribbon view, in Database Manager, on   the Home tab, in the Blocks group, click Add.  

 5. Select the PG Program   Block and click OK. The Program dialog box appears.

 6. Enter a Tag Name   and Description, and add a RUNTASK command in the Programming State-
ments   area. The syntax for this command is:
RUNTASK task_parameters

For example, this command would perform   a recipe download for the control recipe named 
BEER, and include an error   file:
RUNTASK RCPDOWN /cBEER /e

 7. You can also combine   the RUNTASK statement with other Program block statements (such as 
WAITFOR)   to schedule an upload or download automatically. 

For example, if you add the first line to   the Programming Statements area, the recipe would also 
wait for the TIME   variable to equal 12 hours, before recipe download occurs:
WAITFOR TIME = 12:00:00
RUNTASK RCPDOWN /cBEER /e
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Uploading and Downloading from an Operator Display

To upload or download   a recipe from an operator display:

 1. In the iFIX WorkSpace,   create a picture with the necessary objects (such as a Push Button link)   
or modify an existing picture by adding objects. 

 2. Include a command   script with the RUNTASK command for each object that will trigger an 
upload   or download. The syntax for this command is:
RUNTASK task parameters.

For example, this command would perform   a recipe download for the control recipe named 
BEER, and include an error   file:
RUNTASK RCPDOWN /cBEER /e

This command would perform a recipe upload   for the control recipe named BEER, and include an 
error file:
RUNTASK RCPUP /cBEER /e

 3. When in run mode,   select the appropriate object to start the upload or download process.   When 
selected, the associated command script executes and uploads or downloads   the specified 
recipe.

 

Working with Recipes

In the Recipe Builder, you can perform the following tasks when working   with recipes:

 l Creating   a Recipe Item or Variable

 l Inserting   a Recipe Item or Variable

 l Deleting   a Recipe Item or Variable

 l Creating   a Recipe Report

 l Creating   and Modifying a Recipe Note File

 l Enabling   and Disabling Recipe Verification

 l Importing   and Exporting Data to a Third-Party Application

 l Modifying   a Report Column

 

Creating a Recipe Item or Variable
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 To create a new   recipe item or variable for the current recipe:

 1. Select a cell in   the Recipe window's Identifier column and type a tagname, variable name,   or a 
symbol name. 

NOTE:   If you prefer, you can double-click a cell in the Identifier column to   display the Field Select dia-
log box. 

 2. Select the corresponding   cell in the Formula column and enter a formula for the recipe item. When   
you complete your entry, the text in the Calc Val column changes to reflect   the formula's value.

 3. Modify the text in   the Description and UOM columns as needed. Notice that if you enter a   tag-
name the text from the specified block's Description and EGU Tag fields   are automatically inser-
ted for you.

 4. Modify the override   limits as needed. By default, the override limits are sent to 
UNRESTRICTED.   

 5. Modify the Verify   column as needed. By default, recipe verification is disabled for each   recipe 
item you add to the recipe. To enable it, select a cell in the   Verify column and type ON in the text 
editing box. It is recommended   that you only verify Analog Register, Digital Register, and Text 
blocks.   

 

Inserting a Recipe Item or Variable

 To insert a recipe   item or variable to a recipe: 

 1. In the Recipe window's   spreadsheet, select a cell from the row where you want to insert a recipe   
item or variable. 

 2. On the Edit menu,   click Insert Item. The Recipe Builder inserts a blank row above the row   you 
selected and renumbers the spreadsheet.

NOTE:   You can add up to 3500 recipe items to a recipe.

 

Deleting a Recipe Item or Variable

 To delete a recipe   item or variable from a recipe:

 1. In the Recipe window's   spreadsheet, select a cell from a row that you want to delete.

 2. On the Edit menu,   click Delete Item. The Recipe Builder removes the selected item from the   
recipe and renumbers each row in the spreadsheet.

You can also delete a recipe item or variable   by selecting Cut from the Edit menu. The main dif-
ference between these   commands is that when you delete a recipe item or variable with Cut, you   
can paste it back into the recipe if you accidentally remove the wrong   item or if you change your 
mind. When you select Delete Item, the recipe   item or variable is irretrievable.

 

Creating a Recipe Report
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 To create a report   from the current recipe:

 1. With a recipe loaded   in the Recipe window's spreadsheet, on the File menu, select Report. The   
Report Format dialog box appears.

 2. Use the Column Layout   List Box buttons to add or delete report columns. Also use these buttons   
to arrange the columns in the report and modify the column widths and   headings. 

 3. Click OK. The Recipe   Builder creates a report from the current recipe and stores it in the   appro-
priate recipe path.

 

Creating and Modifying a Recipe Note File

 To create or   modify a recipe note file:

 1. In the Recipe window,   on the File menu, select Notes. The Recipe Builder starts Notepad. 

If a note file does not already exist for   the current recipe or if the Recipe Builder cannot locate the 
note file   in the control recipe path, the Recipe Builder prompts you to create a   new one. Select the 
No button to create an untitled note file. To create   a note file with a name that matches the current 
recipe, select the Yes   button. 

 2. Enter the information   you want after the program starts. 

 3. When you are ready   to save the note file, on the File menu, click Save. If you are working   with a 
new, untitled recipe, save the file in the control recipe path   with the extension .RCN. The name of 
the note file should also match the   name of the recipe; otherwise, the Recipe Builder will not be 
able to   locate the note file subsequently. 

 

Enabling and Disabling Recipe Verification

 To enable recipe   verification for each recipe item:

In the Recipe window's spreadsheet, enter   ON in the Verify column. 

 To disable recipe   verification:

In the Recipe window's spreadsheet, enter   OFF in the Verify column. By default, recipe veri-
fication is disabled.

 

Importing from and Exporting Data to a Third-Party Application

 To import data   from a third-party application:

 1. Save the data you   want to import in a text file and copy it into the master recipe path   or control 
recipe path. 
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 2. If you are not already   in development mode in the Recipe window, on the Window menu, select 
Switch   to DEV.  The   Recipe Development window appears.

 3. In the Recipe Development   window, on the File menu, click Open. The standard Open dialog box 
appears.

 4. From the List Files   of Type drop-down list, select either master text recipes or control text   
recipes.

 5. Select the text file   you want to open. The Recipe Builder imports the data.

 To export data   to a third-party application:

 1. If you are not already   in development mode in the Recipe window, on the Window menu, select 
Switch   to DEV.  The   Recipe Development window appears.

 2. From the File menu,   click Save As. If the audit trail is enabled, the Recipe Mod Log dialog   box 
appears. 

If the audit trail is disabled, the standard   Save As dialog box appears. Go to step 4.

 3. Enter the reason   for exporting the recipe, and click Save As. The standard Save As dialog   box 
appears.

 4. Select either master   text recipes or control text recipes from the List Files of Type drop-down   
box.

 5. Type the name for   the exported recipe in the File Name field, and select the OK button.   The 
Recipe Builder exports the recipe to a text file.

 6. Start your third-party   application and open the text file with it.
 

Modifying a Report Column

 To modify a report   column:

 1. In the Recipe window,   on the File menu, click Report. The Report Format dialog box appears.

 2. Select the column   you want to modify from the Column Format list box.

 3. Click Modify. The   Report Column Details dialog box appears.

 4. In the Column Heading   field, edit the text as needed. 

 5. In the Column Width   field, edit the text as needed. 

 6. From the Report Column   Details dialog box, click OK. The Recipe Builder updates the Column 
Layout   list box to reflect the changes you made.

 7. Repeat steps 4 through   6 until you have modified each report column.

 8. From the Report Format   dialog box, click OK. The Recipe Builder updates the report format.

 

Locating and Displaying Data

In the Recipe Builder, you can perform the following tasks when locating   and displaying data:
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 l Changing   a Display Format

 l Modifying   a Column

 l Searching   and Replacing Data

 

Changing a Display Format

 To change the   current display format:

 1. In the Recipe window,   on the Window menu, click Edit Display Format. The Window Display 
Format   dialog box appears.

 2. Use the Column Layout   List Box buttons to add or delete spreadsheet columns. Also use these   
buttons to modify the column heading, make a column modifiable, arrange   the columns in the 
spreadsheet, and toggle between the display format   of the Recipe Development window and the 
Recipe Operations window 

 3. Select the OK button.   The Recipe Builder saves the display format in memory.

 

Modifying a Column

 To modify a column   for a display format:

 1. In the Recipe window,   on the Window menu, click Edit Display Format. The Window Display 
Format   dialog box appears.

 2. From the Column Format   list box, select the column you want to modify.

 3. Click Modify, or   double-click the column name in the Column Layout list box. The Column   Details 
dialog box appears.

 4. In the Column Heading   field, edit the text as needed. 

 5. Select the Modifiable   check box to make the column modifiable. To make the column non-modi-
fiable,   clear the check box.

 6. Select the OK button   from the Column Details dialog box. The Recipe Builder updates the 
Column   Layout list box to reflect the changes you made.

 7. From the Window Display   Format dialog box, click OK. The Recipe Builder updates the spread-
sheet.

 

Searching and Replacing Data

 To search for   data in a column (or search and replace data):

 1. In the Recipe window's   spreadsheet, select the column you want searched.

 2. Select the Search   button. The Search and Replace dialog box appears. 
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 3. In the Search for   field, enter the text you want to locate. If you want to search and replace   data, 
enter the replacement data in the Replace with field. 

 4. Use the Search Next   and Search Previous buttons to search forward and backward in the 
column.   Use the Replace Next and Replace Previous buttons to search and replace   data in the 
column. 

 5. When you finish searching   the selected column, you can return to the spreadsheet by selecting a   
cell. The Search and Replace dialog box remains on the screen. To close   the dialog box, select 
the Exit button.

 

Working with Formulas

In the Recipe Builder, you can perform the following tasks when working   with formulas:

 l Entering   an Override Limit

 l Entering   and Clearing Overrides

 l Entering   and Modifying a Formula

 

Entering an Override Limit

When you add or insert a recipe item or variable, the Recipe Builder   automatically sets the high and low 
override limits to Unrestricted. This   allows anyone to enter any override value needed. If you want to 
restrict   the possible value of the override value, change the override limits.

 To change the   override limits:

 1. In the Recipe window's   spreadsheet, double-click a cell in the Override Lo Lim column or the   
Override Hi Lim column that is in the row you want to update. The Override   Low Limit or Override 
High Limit dialog box appears.

TIP:   For Restricted and Unrestricted Limits, you can also select the cell,   type R for Restricted or U for 
Unrestricted, and press Enter. This assigns   the Restricted or Unrestricted Limit without opening the 
Override Low   Limit or Override High Limit dialog box.

 2. Select the override   limit that you want to use.  

 3. For the Absolute,   Percentage, and Difference Limit, enter a value. The following table provides   a 
guidelines for entering values.

To set an override limit to... Type...
An absolute value The value you want to use. 
A relative percentage of the cal-
culated value

The percentage of the calculated value you want to   
use. Be sure to include the percent sign (%).

A relative difference from the cal-
culated value

The difference from the calculated value you want   to 
use followed by a minus sign (-). 

 4. Click OK.
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Entering and Clearing Overrides

 To enter an override   value:

 1. In the Recipe window's   spreadsheet, select the appropriate cell in the Override Val column.

 2. Type a value in the   text editing box. The range of values you can enter into the Override   Val 
column depends on the high and low override limits defined for a specific   recipe item or variable. 

 To clear an override   value:

In the Recipe window's spreadsheet, select   the appropriate cell and press <Delete>.

NOTE:   To delete all the override values in use, select the Clear Overrides button.   

 

Entering and Modifying a Formula

 To enter a formula   for a recipe item or variable:

 1. In the Recipe window's   spreadsheet, select the appropriate cell in the Formula column.

 2. Type the formula   you want into the text editing box. When typing the formula, you can combine   
one or more of the following items:

Formula Type Examples
Numeric or string constant 5 or “John”
Mathematical operators +, -, *, /,= =, >, <, <=, !=, ̂ ,
Function Log(234) or 

Lookup (#COLOR;1;2;3;4;5)
Variable #COLOR
Keyword #BATCH or #NAME

 To modify a formula:

 1. In the Recipe window's   Formula column, select the appropriate cell, and press INSERT.   The 
Recipe Builder highlights the text in the text editing box. 

 2. Type the new text   you want. The Recipe Builder replaces the original text with the text   you enter.

 

Using Advanced Features

In the Recipe Builder, you can perform the following tasks when using   advanced features:

 l Assigning   a Tag Group

 l Changing   the Verification Timeout Interval

 l Defining   the Completion Status Indicator

 l Defining   the Upload and Download Interlocks

 l Enabling   and Disabling the Audit Trail
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 l Selecting   a Security Area

 l Setting   and Scaling the Batch Size

 l Setting   the Standard Batch Size

 

Assigning a Tag Group

 To assign a tag   group to the current recipe:

 1. In the Recipe window,   on the Options menu, click Assign Tag Group. The Assign Tag Group dia-
log   box appears.

 2. In the Tag Group   Filename field, enter the tag group file that you want to assign to the   recipe.

- Or -

To the right of the Tag Group Filename field,   select the browse (...) button and double-click the 
tag group file you want to assign   to the recipe from the list that appears. 

After you assign a tag group to a recipe,   you can display the tagnames by selecting Show Tag-
names from the Window   menu. To display the symbol names again, select Show Symbols from 
the   Window menu. 

NOTE: The Recipe Builder requires the .TGE file format when using tag group files. As such, the Recipe 
Builder uses the FIX32 Tag Group Editor (TGE.EXE).  Be aware there is another Tag Group Editor 
(TagGroupEditor.exe) for creating tag groups in iFIX pictures in .TGD file format. The Recipe Builder cannot 
use these newer .TGD files.

 

Changing the Verification Timeout Interval

To modify the   timeout interval:

 1. In the Recipe window,   on the File menu, click Exit. If necessary, save any changes you have   
made to the current recipe.

 2. With a text editor   such as Notepad, open the RCP.INI file. This file resides in the directory   poin-
ted to by the local path. 

When you open the file, you should see the   following text:
[startup]
startup.mode=2
verification.timeout=30

 3. Modify the timeout   interval by changing it from 30 to some other value. Possible values for   the 
timeout interval are from 1 to 65535 seconds.

 4. After modifying the   timeout interval, save the RCP.INI file and restart the Recipe Builder.

 

Defining the Completion Status Indicator
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 To define the   completion status indicator:

 1. In the Recipe window,   on the Options menu, click Advanced Options. The Advanced Options dia-
log   box appears.

 2. In the Completion   Status field, enter the tagname of the block that acts as the completion   status 
indicator for the recipe, or click the browse (...) button and select the   tagname from the dialog box 
that appears. 

By default, the F_CV field of the block   is assigned to the tagname if you do not specify a field 
name. However,   you can specify any F_ field for the tagname (such as F_02 for an Analog   
Register block).

 

Defining the Upload and Download Interlocks

 To define the   upload and download interlocks for the current recipe:

 1. In the Recipe window,   on the Options menu, click Advanced Options. The Advanced Options dia-
log   box appears.

 2. In the Download field,   enter the tagname or symbol of the block that acts as a download interlock   
for the recipe. In the Upload field enter the tagname or symbol of the   block that acts as an upload 
interlock. If you prefer, you can select   the browse (...) button to the right of either field and select 
the tagname from   the dialog box that appears. 

By default, the F_CV field is assigned to   the tagname when no field name is specified. However, 
you can enter any   F_ field for the tagname (such as F_04 for a Digital Register block).

 

Enabling and Disabling the Audit Trail

 To enable the   audit trail for the current recipe:

 1. In the Recipe window,   on the Options menu, click Advanced Options. The Advanced Options dia-
log   box appears.

 2. Select either the   Summary Audit Trail button or the Detail Audit Trail button to select   the type of 
audit trail you want. 

 To disable the   audit trail:

 1. In the Recipe window,   on the Options menu, click Advanced Options. The Advanced Options dia-
log   box appears.

 2. Select the   No Audit Trail button.
 

Selecing a Security Area
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 To select a security   area for the current recipe:

 1. In the Recipe window,   on the Options menu, click Advanced Options. The Advanced Options dia-
log   box appears.

 2. In the Security Area   field, enter the appropriate text. To assign the recipe to:

 l Every security   area, type ALL.

 l No security area,   type NONE. 

 l A specific security   area, type the security area name in the Security Area field. 

If you prefer, click the browse (...) button and select   a security area from the dialog box that 
appears. Use the scroll bar or   arrow keys to locate the security area you want. Press the OK but-
ton to   complete the selection. 

 

Setting and Scaling the Batch Size

 To set the batch   size for the current recipe:

 1. In the Recipe window,   on the Options menu, click Set Batch Size. The Set Batch Size dialog box   
appears.

 2. In the Batch Size   field, enter the amount of the product you want to make.

 3. From the Set Batch   Size dialog box, click OK. The Recipe Builder assigns the value you enter   to 
the #BATCH keyword. The Recipe Builder also divides #BATCH by #STD_BATCH   to compute 
the scaling factor. The result of this calculation is stored   in the #SCALE keyword.

 To scale a batch   size for the current recipe:

Multiply the formula of each recipe item   you want to scale by #SCALE. Once this is done, you 
can scale a batch   by changing the current batch size.

 

Setting the Standard Batch Size

 To set the standard batch size for   the current recipe:

In the Recipe window, in the Standard Batch   Size field, type the standard amount of the product 
that this recipe produces.   The Recipe Builder assigns the value you enter to the #STD_BATCH 
keyword.

 

Using Keyboard Accelerators

The following keys and keyboard accelerators are available in the Recipe   Operations or Recipe Devel-
opment window to help you move through the menu   bar and dialog boxes.
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Movement Keys

 l The ALT   key activates the menu bar.

 l The left and right   arrow keys move between menus.

 l The up and down arrow   keys move through menu commands.

 l The   ENTER key selects a command   or dialog box button and records field entries.

 l The TAB   key moves the selection box or cursor through all dialog box fields, list   boxes, check 
boxes, and buttons.

 l The PAGE   UP and PAGE DOWN   keys shift the spreadsheet up or down to display additional rows.

Keyboard Accelerators

Task Accelerator
Access help for dialog boxes and 
commands

F1

Access help for fields and con-
trols

ALT+F1

Apply a font CTRL+F
Assign a tag group to a recipe CTRL+G
Copy a recipe item or variable CTRL+C
Copy all recipe items and vari-
ables

CTRL+A

Create a new recipe CTRL+N
Create a recipe report CTRL+R
Cut a recipe item or variable CTRL+X
Delete a recipe item CTRL+D
Display symbols in a recipe CTRL+Y
Exit the Recipe Builder ALT+F4
Insert a recipe item CTRL+E
Open a recipe CTRL+O
Paste a recipe item or variable CTRL+V
Save a recipe CTRL+S
Set the current batch size CTRL+B
Substitute tagnames for symbols CTRL+T
Switch to the Recipe Devel-
opment
or Recipe Operations window

CTRL+W
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overview  69
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J
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master recipe path  36

master recipes

described  3

opening  22

saving  24

using  13

modifying a column  40
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naming conventions  14

O
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overview  23
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overview  19
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P
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R

recalculating formulas  60

Recipe Builder

command line parameters  74

downloading recipes  42

error messages  86

recipe buttons  17
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recipe header  17

recipe paths  36

security  73

spreadsheet  17

spreadsheet columns  19

starting  15

starting the upload  49

text editing box  17
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window elements  17

recipe buttons  18
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in Recipe Development window  18

in Recipe Operations window  18

working with  18

Recipe Development window  17

available menus  18

comparison with Recipe Operations 
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displaying  15
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elements  17
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using with Program block  53
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recipe files  86
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enabling  19

overview  47

timeout interval  47

recipes
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removing a column from a report  29

renaming recipes  25

reports  29

adding a column to  29

changing a column heading  30

changing a column width  30

removing a column from  29

S
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